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Preface
Welcome to the JD Edwards EnterpriseOne documentation.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at  http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc .

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit  http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info  or visit  http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=trs  if you are hearing impaired.

Related Information
For additional information about JD Edwards EnterpriseOne applications, features, content, and training, visit the JD
Edwards EnterpriseOne pages on the JD Edwards Resource Library located at:

http://learnjde.com

Conventions
The following text conventions are used in this document:

Convention Meaning

Bold
 

Boldface type indicates graphical user interface elements associated with an action or terms defined in
text or the glossary.
 

Italics
 

Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular
values.
 

Monospace
 

Monospace type indicates commands within a paragraph, URLs, code examples, text that appears on a
screen, or text that you enter.
 

> Oracle by Example
 

Indicates a link to an Oracle by Example (OBE). OBEs provide hands-on, step- by-step instructions,
including screen captures that guide you through a process using your own environment. Access to
OBEs requires a valid Oracle account.
 

i

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://learnjde.com
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1  Understanding JD Edwards EnterpriseOne
Software

JD Edwards EnterpriseOne Foundation Overview  
JD Edwards EnterpriseOne software provides a flexible, configurable solution in the face of constantly changing
technology and enterprise practices. JD Edwards EnterpriseOne software is the first network-centric software that
separates business rules from the underlying technology. As new technologies emerge, JD Edwards EnterpriseOne
software enables you to easily add them to the framework of your enterprise.

JD Edwards EnterpriseOne Access  
Users access EnterpriseOne applications through the JD Edwards EnterpriseOne web client. It provides the ability to
navigate EnterpriseOne menus. The EnterpriseOne menus are used primarily by end users to conduct end user tasks.

Oracle supports JD Edwards EnterpriseOne web client on the following tablets, enabling users in the field to react
quickly and efficiently to time-sensitive business tasks:

• Apple iPad. You can access EnterpriseOne through the Safari Web browser. See the  JD Edwards EnterpriseOne
for iPad Quick Start Guide  for more information.

• Android-based tablets. Starting with EnterpriseOne Tools release 9.1.4, you can access EnterpriseOne through
the Google Chrome Web browser. See the  JD Edwards EnterpriseOne for Android Tablets Quick Start Guide  for
more information.

For a list of supported browsers for the JD Edwards EnterpriseOne web client, see Certifications on My Oracle Support:

https://support.oracle.com/epmos/faces/CertifyHome

JD Edwards EnterpriseOne Software Features  
JD Edwards EnterpriseOne software offers the following features:

• Multiplatform computing: JD Edwards EnterpriseOne software has the ability to run on different platforms.
This versatility allows for easy maintenance of information across a network.

• Integrated supply chain: JD Edwards EnterpriseOne software provides the ability to use the internet and an
intranet to enable you to communicate and share information with your employees, customers, and suppliers.

• Interoperability: JD Edwards EnterpriseOne software lets you leverage your existing investments in hardware,
databases, and software, and integrate them with legacy and third-party products.

• Adaptability: JD Edwards EnterpriseOne software adapts easily to different languages, currencies, reporting
provisions, and technology standards.

1
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• Usability: JD Edwards EnterpriseOne software lets you point and click, drag and drop, and use fill-in-the-blank
forms to easily complete your tasks.

Through the Oracle WebCenter and JD Edwards Collaborative Portal, users access JD Edwards EnterpriseOne
applications using links in the Portal's menus.

JD Edwards EnterpriseOne System Integration  
JD Edwards EnterpriseOne software combines enterprise applications with an integrated toolset to tailor those
applications to the needs of your business.

JD Edwards EnterpriseOne refers to each group of its software products as an application suite. The application
suites support manufacturing, financials, distribution or logistics, and human resource operations for multisite and
multinational organizations. Your business needs determine what application suites are installed for your enterprise
system. For complex business situations, you might use several application suites to achieve a comprehensive solution.

Each application suite is made up of systems. For example, the Financial Suite contains systems such as Enhanced
Accounts Receivable (system 03B), Accounts Payable (system 04), General Accounting (system 09), Fixed Assets
(system 12), and others. Each system consists of applications, forms, reports, and database tables that are designed to
handle specific business needs.

Because the functions and features of all the systems are similar and integrated, you are not necessarily aware of
moving from one system to another when working with various applications.

This guide often refers to Address Book, system 01, to illustrate the foundational concepts of JD Edwards software.
Address Book, an online version of a traditional card file, is a database of names, addresses, and phone numbers that:

• Provides easy access to all addresses for searching and reporting purposes.

• Reduces the need for duplication of records.

• Provides security through Business Unit assignment or Search Type authorization.

• Interfaces with other JD Edwards software systems.

Because it is fundamental to business solutions, Address Book provides a realistic subject for learning the foundational
concepts of JD Edwards EnterpriseOne software.

JD Edwards EnterpriseOne Foundation  
This guide introduces you to the integrated environment of JD Edwards EnterpriseOne. Through overviews, procedures,
and examples, this guide describes the operations and functions that are common to all applications. This guide
comprises the following topics:

Topic Description

JD Edwards EnterpriseOne Software
 

Learn about the different applications that can be used as an entry point for accessing JD Edwards
EnterpriseOne tools and applications.
 

Application User Interface Learn about the operating environment, including menus, forms, and the grid.

2
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Topic Description

  

Records
 

Learn how to locate, add, and work with database records, add objects, and format and move around
on a record-entry form.
 

Composed EnterpriseOne Pages
 

Learn how to create EnterpriseOne pages with user defined layouts to access Designer Panes,
 Watchlist Panes, Classic Pages, EnterpriseOne applications, One View reports, web pages, OBIEE
objects, and ADF applications.
 

Send Email and Meeting Invite Options
 

Learn how to collaborate with other users by using the Send Email and Send Meeting Invite options.
 

User Defined Objects
 

Learn how to create web objects using the EnterpriseOne web interface.
 

JD Edwards EnterpriseOne Accessibility
 

Learn how to enable the Accessibility mode and how to work with the JD Edwards EnterprieOne using
the screen reader software.
 

Interactive Versions for Applications
 

Learn to modify the behavior of applications through changes to processing options and interactive
version detail.
 

Batch Versions for Reports
 

Learn how to create, modify, and print your own report versions.
 

Messages and Queues
 

Learn how to use Work Center to send and work with messages from JD Edwards EnterpriseOne users
and recipients outside of the JD Edwards EnterpriseOne software environment.
 

Media Object Attachments
 

Learn how to attach objects (text, images, OLE objects, and JD Edwards EnterpriseOne shortcuts) to
rows and forms.
 

MailMerge Workbench
 

Learn about merging JD Edwards EnterpriseOne system records with third-party word processing
documents for automatic creation of form letters by using certain application workflows.
 

Processing Options
 

Learn key functionality, types, and how to access and use processing options.
 

3
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2  Getting Started with the JD Edwards
EnterpriseOne Web Application User Interface

Understanding Web Application Form Types  
EnterpriseOne applications use a variety of form types. The characteristics of each form type remain the same,
regardless of the application in which you access the form.

Find/Browse Form  
The Find/Browse form provides the entry point to most applications. It contains an optional query-by-example (QBE)
line enabling you to search using any field in the grid. Most Find/Browse forms include the Query control, which enables
you to define additional search criteria when searching for records. The standard title for a Find/Browse form begins
with "Work With" followed by information that is specific to the business task. You cannot add or change existing
records on a Find/Browse form.

Find/Browse forms enable you to:

• Search, view, and select multiple records in a grid

• Exit to another form to add, change, or view a record

Search/Select Form  
Use the Search/Select form to locate a value for a field. The grid displays values that are stored in a database table.
When you select a value from the grid and click the Select button, that value is automatically placed in the field.
For example, when you need to enter a user defined code (UDC) into a field, the search button appears, enabling
you to access a Search/Select form that displays a list of UDCs. You can select an item from the list and place it in
the appropriate field. Search/Select forms include the Query control unless the form appears in a pop-up window.
The Query control enables you to define additional search criteria when searching for records. You cannot edit the
information that appears on this form.

Header Detail and Headerless Detail Forms  
The Header Detail and Headerless Detail forms include a detail area, the OK button, and the Cancel button. You can
change multiple records using these forms. The Header Detail form includes information from two different business
views to provide more depth on the information that appears on the form. The Headerless Detail form provides
information from only one table. Data that is common to all the records in the grid appears at the top of the form.

Header Detail and Headerless Detail forms enable you to:

• Display multiple records

• View records

• Add records

5
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• Change records

• Delete records

Fix/Inspect Form  
The Fix/Inspect form does not include a detail area. If you selected a record on the previous form, the Fix/Inspect form
displays data for that record. If you are adding a record, the Fix/Inspect form is empty, except for any default values.

Fix/Inspect forms enable you to:

• View a single record

• Add a record

• Change a record

Parent/Child Form  
The Parent/Child form presents parent/child relationships in an application on one form. The left portion of the form
presents a list of items. The right portion of the form displays information that relates to the selected item in the left
portion of the form. The Parent/Child form supports the ability to drag and drop items from one area to another. This
form includes Select and Close buttons.

You can resize the display areas according to your personal preferences.

Message Form  
The message form contains information about processing that occurs when you work with JD Edwards EnterpriseOne
software. For example, when you delete a record, a Confirm Delete message appears to ask if you are sure that you want
to delete the object. The message might also include information about an event that occurs while you work with the
system.

Message Form as Hover Form  
The message form may also contain the context-based information, which is displayed when you click the hover
indicator in the hover supported JD Edwards EnterpriseOne controls.

With Release 9.2.1, power browse forms can be used as hover forms instead of message forms. See "Understanding
Power Browse Forms" in the JD Edwards EnterpriseOne Tools Form Design Aid Guide.

This hover form appears around the control.

The hover form may contain context-based information about the Address Book Number, Item Number and so on. Also,
the hover from may contain card information about the Address Book Number.

The hover form closes when you move the mouse cursor away from the control or grid cell. You can also use the Close
button on the hover form.

Note:  The hover form does not appear on the empty control or space and error form controls and grid cells.

6
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You see an orange "dot" indicator at the top left corner of the control, if the hover form is associated with the control.
Hovering on the orange "dot" will change it into a checkable indicator. Click on the indicator to display the hover form.

Note:    Click here to view a recording of this feature.

The hover form may contain a tab called Collaborate. See Accessing Send Email and Meeting Invite options from Data
Dictionary items in this guide.

You can enable or disable the hover form using the Preferences window from the Personalization drop-down menu at
the user level. Select or deselect the Enable Hover Forms option in the Preferences window.

Also, your system administrator can enable or disable the hover form at the system level in the JAS.ini file or in Server
Manager.

See "Understanding Hover Forms" in the JD Edwards EnterpriseOne Tools Runtime Administration Guide.

The hover form association is supported on form level controls and also on the grid. For example, Edit Control, Check
Box, Combo Box, Associated Text Images, Radio Buttons, Text Block, and Grid Cell all support the hover form.

Power Forms  
Power forms are web-only application forms that enable you to view multiple, interrelated views of data, grids, and tab
pages on one form and to pass logic between them. The tab pages can have their own business views (BVs), and these
BVs can communicate with each other and can update based on data selection and changes that occur in other BVs on
the form. Most Power Browse forms include the Query control, which enables you to define additional search criteria
when searching for records.

Visual Assist Form  
When you click on the Visual Assist icon, the Visual Assist form is displayed as a modal window along with the parent
form. The parent form is displayed in read-only mode.

Note:  You can drag the Visual Assist form and place it anywhere on the parent form.

Accessing JD Edwards EnterpriseOne Web Client  
This section provides an overview of accessing the JD Edwards EnterpriseOne web client and discusses how to:

• Access the JD Edwards EnterpriseOne Web Client through the JD Edwards Collaborative Portal.

• Accessing the JD Edwards EnterpriseOne Web Client through the Oracle Web Center Portal.

• Access the JD Edwards EnterpriseOne Web Client Directly.

7
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Understanding JD Edwards EnterpriseOne Web Client Access  
Accessing JD Edwards EnterpriseOne applications on the web is similar to accessing files and applications on a
company network. Typically, either when you start your computer or when you want to access company network
directories, you must sign in to identify yourself to the system as an employee who has the right to access company
resources. After you sign in, you can access files and applications on the network. Similarly, you must sign into the
web client, the gateway through which you access JD Edwards EnterpriseOne, before you can launch JD Edwards
EnterpriseOne applications.

To sign in to the JD Edwards EnterpriseOne web client, your computer must have access to your company's intranet,
you must have a web browser installed on your computer, and your system administrator must create an account for
you. When your system administrator sets up your account, he or she creates a user ID and assigns you a password.

Usually, you must enter your ID and password when you launch the JD Edwards EnterpriseOne web client. However,
your system administrator can configure your computer in such a way so that you appear to bypass the sign-in process.
For security reasons, however, most system administrators want you to sign in manually. When you sign in to the
JD Edwards EnterpriseOne web client, EnterpriseOne Menu appears. EnterpriseOne Menu enables you to access JD
Edwards EnterpriseOne applications, reports, and other features.

Accessing the JD Edwards EnterpriseOne Web Client through the
JD Edwards Collaborative Portal  
When you sign in to the Collaborative Portal, the portal can pass your sign-in information to JD Edwards EnterpriseOne.
Therefore, all you must do is bring up a workspace containing the EnterpriseOne Menu portlet. The EnterpriseOne
Menu portlet enables you to access JD Edwards EnterpriseOne applications, reports, and other features.

Accessing the JD Edwards EnterpriseOne Web Client through the
Oracle WebCenter Portal  
When you sign in to the Oracle WebCenter Portal, the portal can pass your sign-in information to JD Edwards
EnterpriseOne. To access specific JD Edwards EnterpriseOne applications, reports, or features, your system
administrator must provide you with specific menu options. Choose a menu option to launch a specific JD Edwards
EnterpriseOne object.

Accessing the JD Edwards EnterpriseOne Web Client Directly  
Use these steps to sign into the JD Edwards EnterpriseOne web client if you do not use a portal.

To sign in to the JD Edwards EnterpriseOne web client directly:

1. Launch your web browser and navigate to your company's JD Edwards EnterpriseOne Web sign-in.

Depending on how your system administrator has configured your system, the web sign-in might appear
when you launch your browser, you might need to click a button or a link, or you might need to navigate to
a particular page. Your ability to access the JD Edwards EnterpriseOne web client directly might have been

8
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disabled. If you do not know how to find the JD Edwards EnterpriseOne web sign-in, contact your system
administrator.

2. Complete the following fields:

◦ User ID

◦ Password

3. If your system administrator indicates that you must sign in to a particular environment, click Details and
complete the Environment field.

4. If you have multiple roles and wish to sign in as one of them, click the Details button and complete the Role
field.

Note:  The default value is *ALL, which signs you in as a member of all of your roles. Select the *ALL role if
you are not sure which role to use.

5. If you want your computer to remember your settings for the future, select Remember my sign in information.

Note:  Do not use this option if other people have access to your computer.

6. Click Sign In.

The EnterpriseOne Menu appears.

JD Edwards EnterpriseOne Home Page  
When you log into the JD Edwards EnterpriseOne application, you see the EnterpriseOne home page.

EnterpriseOne Page displays the Navigator drop-down menu in the top menu bar.

See JD Edwards EnterpriseOne Navigator Menu in this guide.

The EnterpriseOne Home Page may also contain EnterpriseOne Pages that have been assigned to your user ID or
your user role. EnterpriseOne Pages display as tabs located across the top of the interface. If you are not assigned any
EnterpriseOne Pages, a default page is displayed when you log into JD Edwards EnterpriseOne.

Some EnterpriseOne Pages might contain interactive content, links to external URLs, links to EnterpriseOne
applications, and so forth.

For example, some EnterpriseOne Pages might display interactive information about Financial Budgeting and Planning,
Capital Asset Management, HCM Recruitment Management, Manufacturing Work Orders, Order to Cash, Procure to Pay,
Projects, Work Orders based on the role of the user.

Other EnterpriseOne Pages, called Embedded Pages, automatically launch an application when you click the tab.
Applications launched from these EnterpriseOne Pages do not contain a Close button. Instead, you navigate away from
the application by clicking other EnterpriseOne Pages located at the top of the screen. When you navigate away from
an Embedded EnterpriseOne Page, EnterpriseOne saves any information you have already entered, so when you return,
your information remains as you left it.

The following example shows the EnterpriseOne Page with tabs and overflow arrows. Click the arrow on the tabs, at the
right-hand corner of the page to maximize or minimize the tabs.
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You cannot change the existing EnterpriseOne page or create a new one. When more than one EnterpriseOne page is
published to a user/role, then you can access the pages using the tabs on the home page.

The system administrator can create new pages.

Drag and drop the tabs if you want to rearrange the published pages as shown in the following example.

JD Edwards EnterpriseOne saves the tab position of the EnterpriseOne pages. Next time you log into the JD Edwards
EnterpriseOne application, the tabs appear depending on the setting during your last session.

The system administrator can change the existing EnterpriseOne page through the User Generated Content
administration application.
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JD Edwards EnterpriseOne Navigator Menu  
The Navigator menu is the web-based application you run to access JD Edwards EnterpriseOne applications.

Menu  
The top portion of the JD Edwards EnterpriseOne Menu bar displays a drop-down menu that you can use to navigate
to the specific application or report that you want to launch. The drop-down menu can contain objects other than
applications; for this reason, all objects in the drop-down menu are called tasks. Applications, reports, and shortcuts in
the drop-down menu are all tasks.

Principal sets of tasks are called task views. Your system administrator configures your task view list. This contains the
initial contents of the drop-down menu.

System administrators use JD Edwards Solution Explorer and JD Edwards EnterpriseOne ERP security applications to
manage user accounts and to configure EnterpriseOne Menu.

The following example shows the JD Edwards EnterpriseOne drop-down menu.

When you click on the menu, the sub-menu appears.
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The Navigator menu displays visual cues to help you identify the type of task.

Each task will have a context menu. Right-click the task to view the context menu.

Breadcrumbs  
Breadcrumbs enable you to keep track of the menus you have used to navigate to your current application. When
clicked, each breadcrumb displays the associated menu and its submenus at the location of the breadcrumb. If you use
breadcrumbs to navigate in EnterpriseOne, the breadcrumb string changes to reflect the new navigational path you
have chosen. Breadcrumbs do not appear if you use Fast Path or EnterpriseOne Pages to launch an application.

The breadcrumb history is saved by default whenever you open any application using the Navigator drop-down menu.

To view or hide the breadcrumbs, click the Personalization menu, then the Preferences menu, and then select or
deselect the Show Menu Breadcrumbs check box. Click Save and Close button to save your changes.

Click the drop-down menu icon located near the breadcrumbs to view the history and to access the application as
required.

The breadcrumbs history is arranged in a chronological order. The path that you last accessed is listed first.

You can view and access the breadcrumbs history even after you log out and log in to the JD Edwards EnterpriseOne
application.

The breadcrumbs history can be deleted by clicking the Personalization menu, then the preferences menu. Click on the
Clear button in front of the Clear Breadcrumbs history option to delete the history of bread crumbs. Click Save and Close
to save your changes.

If you clicked the Clear button but do not want to delete the breadcrumbs history, click the Undo button before you click
the Save and Close button.

If you are a system administrator, the Server Manager interface for runtime and metric parameters provides details
on the usage of each setting applicable to that parameter. Access this setting by clicking the "i" (Information) icon for
a desired parameter. Breadcrumbs are enabled if both the Show Menu Breadcrumbs option on the Preferences menu
(located on the Personalization menu), and the Enable Menu Breadcrumbs in the JAS.ini file are enabled.

The JAS.ini settings are in the Web Runtime section OWWEB.

Setting name = Enable Menu Breadcrumbs

The number of breadcrumbs that can be stored in the history can be defined in the JAS.ini file under the section
OWWEB. The range for maxRecentBreadcumbs value should be set between 1 and 10.

If maxRecentBreadcrumbs property is not defined in JAS.ini, the system sets the maximum number of breadcrumbs
history as 10.

If you are a system administrator, log in to the SM console and select the appropriate JAS server from the management
dashboard. Navigate to the Configuration section of the selected JAS server and select Advanced option from the View
drop-down menu. Click on the Web Runtime link in the configuration section. In the Web Runtime section, you can see a
parameter called 'Maximum number of Recent Breadcrumbs'. The default value of this parameter is 10. You can change
the value of this parameter from 1 to 10.
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Open Application List  
The Navigator menu enables you to choose whether the system launches applications in a new window, or launches
them in the same window, replacing the current application located there. Click the task in order to launch the task in
the current window.

To launch a task in a new window, right-click the task and click "Open in New Window" from the context menu.

Each open application is listed in the Open Application drop-down menu. This enables you to navigate between open
applications.

Also, the open applications appear as carousel tiles in the Open Applications tab of the carousel container.

See Using the Carousel Container

Recent Reports  
The Recent Reports drop-down menu displays the recently opened reports.

The Navigator menu displays visual cues to help you identify the status of the reports. For example, as shown in the
following table, reports with the Done status have a green color check icon beside them and reports with the Error
status have a red color error icon beside them.

Tile Status

Waiting (W)
 

In Queue (S)
 

Processing (P)
 

Done (D)
 

Error (E)
 

Fast Path  
Fast Path is a field that enables you to access a specific task (that is, a folder, application, or report) directly. You use
commands in Fast Path to move quickly among menus and applications.

To access the Fast Path field, click the Navigator drop-down menu.
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To use the Fast Path field, enter a Fast Path code and click the button to the right of the field. Depending on how your
system administrator configured your account, you might not be able to see Fast Path.

You can also use the Fast Path field to access menus. Task views are composed of menus and individual tasks. Menus
have no special format in EnterpriseOne Menu; they simply provide application developers with a convenient method of
grouping applications. When you access a menu, you actually access a specific place in a task view.

To access a menu, enter its menu ID. For example, enter G0 to access the Foundation Systems menu.

When you enter a menu ID in the Fast Path field, the corresponding menu appears in the Navigator drop-down menu.
Also, the label Back to Navigation by Role is displayed in the top menu bar. Click Back to Navigation by Role label to
display the default JD Edwards EnterpriseOne menu in the Navigator drop-down menu.

You can find a Navigating in EnterpriseOne menu's ID by hovering over it. To launch an application, enter the
application's program number. To specify a form in the application, enter the application's program number followed
by a |, and then enter the form ID. For example, when you enter P01012|W01012B, the system displays the Work with
Addresses form in the Address Book application. You can specify a version of a form by adding a | and the version
number after the form name; for example, P01012|W01012B|ZJDE0003.

Contact your system administrator for specific internal task, menu, and application IDs. Not all objects have Fast Path
commands.

Task Search (Release 9.2.1.4)  
The JD Edwards EnterpriseOne Task Search feature enables you to search for tasks within the menus for which you have
access. If you cannot remember where a task is located, you can use Fast Path to search for a specific task that you need
to use.

Before you can perform a Task Search, ensure that the Task Search Feature Security is enabled. See, Feature Security for
Task Search (Release 9.2.2.1).

Task Search is performed for the tasks accessed by a role and according to the user language preferences. Task Search
is based on Menu Indexing, which identifies the tasks accessed by a role. If you change an existing task or menu, then
you have to build the task index by using the Work with Task Index Builds (P90013) application for the changes to be
reflected in the Task Search result. See "Working with Task Index Builds (Release 9.2.1)" in the JD Edwards EnterpriseOne
Tools Using and Approving User Defined Objects Guide .

Note:
• The Work with Task Index Builds (P90013) application must exist in your environment to perform Task Search.

• Task Search feature requires an EnterpriseOne Application Interface Services (AIS) Server to run. Contact your
system administrator if you cannot access or use this feature.

To search for a specific task, enter information about the task in the Fast Path field, and then either click the Fast Path
icon or press the Enter key to start the task search execution. EnterpriseOne filters all the tasks for the search request in
the task names, task IDs, application IDs, and form IDs and displays results in the Task Search results window.

As Task Search leverages the Fast Path field, the following hierarchy is used to perform the Task Search:

• When you have access to Fast Path and enter your input in the Fast Path field, the system first launches the
fast path task that you entered. However, if the requested entry is not found, then the system triggers the task
search. For example, P0101 is not a valid entry in Fast Path, and therefore a task search is initiated.
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• When you have restricted view set up for Fast Path and you enter your code in the Fast Path field, the system

first launches the application or menu associated with the defined User Defined Codes. However, if the
requested entry is not defined in the User Defined Codes application, then the system triggers the task
search. For example, AB is a valid UDC entry in the restricted view of the Fast Path, so the system launches the
associated Address Book application. P01012 is not a valid entry in the restricted view of Fast Path, so a Task
Search is initiated.

• When you do not have access to Fast Path and you click the Navigator drop-down menu, the Task Search field
is displayed in place of Fast Path. The system then performs a task search on the input you enter in the Task
Search field.

The Task Search window displays a list of the tasks along with the task name, task ID, application ID, form ID, and
version ID. The search results are sorted on the Task ID. All the matching search entries in the list are highlighted in
boldface. The maximum number of tasks displayed in the search result is 100. You can further refine the search result to
filter the exact tasks by using the Task Search bar in the result window. You can also use wildcard characters to refine the
search.

Note:  The application ID, form ID, and version ID is not displayed for all the tasks.

When you click any task in the search result, the Task Search result window is closed and the corresponding task is
opened.

Feature Security for Task Search (Release 9.2.2.1)  
You must use Feature Security to activate the Task Search feature. You can enable the Task Search feature through the
Revise Feature Enablement form in Security Workbench. By default, the feature security for TASKSEARCH is disabled.

Feature security is a system setting for activating or deactivating the Task Search feature. See "Managing UDO Feature
Security" in the JD Edwards EnterpriseOne Tools Security Administration Guide .

Favorites  
If you frequently run a task or access a folder, you can save it as a favorite for quick access. The favorites that you add
are displayed under the Favorites menu. You can access that task or folder directly from the Favorites menu.

You can customize the list of favorites displayed in the Favorites menu. Depending on how your system administrator
configured your account, you might not be able to see or change your Favorites menu options.

See Working with Favorites in this guide.

Note:  When a customer upgrades to the latest JD Edwards EnterpriseOne Tools release, the existing Favorites for the
user appear in the Favorites menu.

Social  
The JD Edwards EnterpriseOne Social menu provides enterprise-level content and social collaboration through
integration with Oracle Content and Experience Cloud. This integration enables real-time enterprise conversations and
real-time access to content, connecting people and information in the cloud.
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The Social drop-down menu has the following sub-menus:

• User Conversation

• User Documents

See Chapter Using Oracle Content and Experience Cloud for JD Edwards EnterpriseOne (Release 9.2.1.2) in this guide.

User Conversation (Release 9.2.1.2)  
The Conversations icon in the Social menu enables you to start a new conversation or join existing conversations about
any topic you want within the EnterpriseOne application. The integration of Oracle Content and Experience Cloud with
JD Edwards EnterpriseOne enables social collaboration within the application.

For detailed steps about how to create user contextual conversation, see Creating a User Conversation in this guide.

User Documents (Release 9.2.2)  
The Conversations icon in the Social menu enables you to add documents to your personal folder in the cloud from
within the EnterpriseOne application. The integration of Oracle Content and Experience Cloud with JD Edwards
EnterpriseOne enables you to collaborate on content internally and with external users. You can upload, download,
share, and access the documents anywhere, anytime.

For detailed steps about how to add user documents, see Adding User Documents to the Cloud (Release 9.2.2) in this
guide.

EnterpriseOne Search (Release 9.2.1.2)  
EnterpriseOne Search feature enables you to search the transactional or master data within the EnterpriseOne system.

You submit your search request using the Search bar displayed adjacent to the login drop-down menu in the
EnterpriseOne interface. Irrespective of the application you are currently working with, the Search bar is always available
in EnterpriseOne menu bar.

Note:  The Search bar will be not available if:

• The EnterpriseOne Search Feature security is disabled.

• The currently logged-in user does not have UDO View access security enabled for any of the search groups
and does not have any personal search groups.

For detailed steps about how to use the EnterpriseOne Search, see "Working with EnterpriseOne Search (Release 9.2.1.2)"
in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide .

Roles - Role Chooser  
The tasks you see in the Navigator menu are filtered by role. Your system administrator decides the tasks that are
available for each role and then assigns the role to you. You can have one or many roles assigned to you. You choose
which role you want to use at the time you sign into EnterpriseOne. The role you choose determines the tasks that
are available to you. Your ability to choose roles at sign in and to choose roles from the Navigator menu depends on if
your system administrator has given you permissions to do so. If she/he has not, then you can only sign in using the
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*ALL (All My Roles) role. When signed in as *ALL, the EnterpriseOne Menu displays a concatenated list of all the tasks
enabled for each role that is included in *ALL.

Note:  Your system administration determines the roles that are included in *ALL role.

If enabled by your system administrator, the JD Edwards EnterpriseOne Menu bar displays the Role drop-down menu.
This menu enables you to display different sets of tasks by role. You can either select *ALL – ALL My Roles to view a
concatenated view of all of the tasks assigned to all of the roles in the *ALL role. Or you can select an individual role and
view only the tasks for that role. Only the roles that are included in the *ALL role appear in the drop-down menu. If your
system administrator has not enabled you to choose roles, the Roles drop-down menu will not appear. Instead, you only
see the *ALL role and the tasks enabled within that role. This feature is only available if your system administrator has
enabled viewing tasks by role. You sign in using *ALL.

Personalization  
The Personalization drop-down menu has the following sub-menus:

• My System Options

• My System Profile

• Preferences

• Manage Notifications

◦ My Subscriptions

◦ Assigned Subscriptions

◦ Message Center

• Record a Process

• My Content

◦ My Searches

◦ My Pages

• Manage Content

◦ Composed Pages

◦ Classic Pages

◦ Images

◦ Search Groups

See Working with User Options

Click My System Profile to view the details of your system such as the release number, environment, and role.

Select or deselect the check boxes in Preferences window to select or deselect the following user interface preferences
in JD Edwards EnterpriseOne. Click the Save & Close button to save the changes and to close the Preferences window.
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Preferences Default Value Details

Show Related Information
 

Checked
 

Select this option to activate the Composite
Application Framework for a User ID or Role.
 
Deselect this option to disable the Composite
Application Framework for a User ID or Role.
 

Enable Hover Forms
 

Checked
 

Use this option to enable/disable informational
hover windows when the mouse cursor hovers over
selected controls.
 

Enable Row/Form Exit Menu
on right click
 

Checked
 

Use this option to enable/disable right-click option on
Form/Grid cell to access Form / Row Exit menu.
 

Show Add Favorites Window
 

Checked
 

Use this option to enable/disable Add Favorites pop-
up window
 

Auto Suggest Enabled
 

Checked
 

Use this option to enable/disable auto-suggest
feature.
 

Zoom in
 

Checked
 

This option is available only when you are accessing
JD Edwards EnterpriseOne using an Apple iPad.
 
See "User Interface" in JD Edwards EnterpriseOne
Web Client for iPad Quick Start Guide.
 

Use Large Icons in Carousel
 

Checked
 

Select this option to change the size of the carousel
tile to large. De-select this option to change the size
of the carousel tile to small.
 

My Searches  
Click My Searches to set a preference for which search groups to include in the default search. The EnterpriseOne
Search Preferences window lists all the search groups (personal and shared) that the logged-in user can access. Select
or deselect the check boxes to include or exclude each search group from your default search groups. Starting with
Release 9.2.5, you can select the Select All check box to include all your search groups in your default search, and use
the Search field to filter the search groups that you want to include in your default search. The preferred search group
selections will be saved for future searches. A dot beside the name of a search group indicates that it is a personal
search group you created. By default, all the search groups that the user has access to are selected. Also, any new
search group created by a user is automatically selected in My Searches. Click Save to save the changes and to close the
EnterpriseOne Search Preferences window. EnterpriseOne saves the My Searches preferences. The next time you log
into EnterpriseOne, the search groups are selected based on the setting from your previous session. (Release 9.2.1.2)

Note:  My Searches will be not available in the Personalization drop-down menu if:

• The EnterpriseOne Search Feature security is disabled.

• The currently logged-in user does not have UDO View access security enabled for any of the search groups
and does not have any personal search groups.
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For detailed steps about how to use the EnterpriseOne Search, see "Working with EnterpriseOne Search (Release 9.2.1.2)"
in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide .

My Pages (Release 9.2.4.3)  
From the My Content drop-down menu, click My Pages to set the preferences for the pages you want to include in
the Page Navigation bar. The Select My Pages window lists all the pages that you can access. The pages are displayed
based on the role and user combination. Select or deselect the check boxes to include or exclude a page from your Page
Navigation bar. You can use the Search field to filter the pages that you want to include in your Page Navigation bar.
Starting with Release 9.2.5, you can select the Select All check box to include all the pages that you have access to. The
page selections are saved for future use. An asterisk (*) next to the name of a page indicates that it is a personal page.
By default, all the pages you have access to are selected. Click Save to save the changes and close the Select My Pages
window. After you save your preferences, you can view your saved pages in the Page Navigation bar. You can toggle
between My Pages and All Pages from the Select Pages menu icon on the left-hand-side of the Page Navigation bar.

Note:  My Pages will not be available if you do not have UDO View access security enabled for any of the pages and
you do not have any personal pages.

Resources  
Starting with JD Edwards EnterpriseOne Tools Release 9.2.5, you can access LearnJDE, the JD Edwards resource library
for all the resources related to JD Edwards EnterpriseOne.

To access LearnJDE, click the Down arrow located beside your login name and then click LearnJDE from the Resources
menu. The LearnJDE Home page is displayed in a new browser window.

Navigating in Navigator Menu  
Access Navigator.

1. In Navigator Menu, click a task (that is, a folder).

The drop-down menu displays the child tasks as sub-menu.
2. Continue to navigate through the sub-menu until you reach the object you want to launch.

Hover over a task to see more information about it. The system tells you what kind of object the task is (for
example, application, report, and so on) and other information, such as its number and version.

3. To launch the object, click it.

You can launch multiple applications. Depending on how your system administrator has configured your
system, additional applications launch in the same window or in a different window. If the system is configured
for multiple browser windows, you can hold down the CTRL key when you press Enter to launch the application
in a new window. Either way, the applications you have running appear at the top of the tree under Open
Applications.

4. If you have multiple applications open, click the application name under the Open Applications drop-down
menu to bring a specific application to the forefront. You can also click the application tile in the Open
Applications tab of the carousel container to bring a specific application to the forefront.

Depending on the object type, you might be able to select a version or to set data selection or processing
options. Right-click the task to make a choice from the context menu.
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Hot Keys  
Click the '?' button on any open JD Edwards EnterpriseOne form and then select the About option. In the About window,
click on Display list of all hot keys link to obtain the list of hot keys supported by the JD Edward EnterpriseOne software.
You can also use Ctrl+ Shift+? to open the hot keys information window.

UX One Page Navigation (Release 9.2.1)  
JD Edwards UX One pages implement the Alert, Analyze, and Act model, bringing together the pieces of information
that you need in specific job roles. When you log in to JD Edwards EnterpriseOne using a UX One role, you see the UX
One pages associated with that role.

For more information about the UX One roles, and their associated UX One pages and components, see "Understanding
UX One Role Navigation" in the JD Edwards EnterpriseOne Applications UX One Roles User Guide .

Standard and Simplified Modes  
EnterpriseOne has two modes: Standard and Simplified. Your system administrator determines the mode assigned to
you. Standard mode is for users who need access to the full range of EnterpriseOne actions. If you are using Standard
mode, you are able to view the Navigation bar, the Carousel, the Fast Path (if you have the appropriate permissions),
and Breadcrumbs.

In Standard mode, your Personal Preferences dialog box contains the following options:
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The Simplified mode is a scaled-down interface that provides you with only the limited actions you might need to use
in EnterpriseOne. In Simplified mode, you see the Banner Bar, Personalization, Help, Username, Environment, and Sign
Out options.

Simplified mode enables you to access applications by clicking the EnterpriseOne Page tabs located across the top of
the screen. Some EnterpriseOne Pages contain links and buttons that you click to access applications, URLs, etc.

In Simplified mode, your Personal Preferences dialog box contains the following options:

Selecting Standard or Simplified Modes  
If your system administrator has enabled you to do so, you can choose if your EnterpriseOne interface displays
Simplified or Standard mode.To choose Simplified or Standard mode:

1. Ensure that you have permissions to change the Standard or Simplified mode by clicking Personalization, My
System Options, and then User Profile Revisions.

2. Ensure that the Simplified mode option is set to Yes if you want to view EnterpriseOne in Simplified mode, and
that the option unchecked if you want to view EnterpriseOne in Standard mode.

Closing Applications when too Many are Open  
Your system administrator determines the number of applications you can have open at one time. If you have reached
the maximum number of applications that you can have open, you will receive the following error message:

Too many EnterpriseOne Applications are open at this time. Find one or more open application(s) with a Close button
located in the toolbar and click the Close button to close the application.

This message means that you must close one or more EnterpriseOne applications before you can open any others.

Some EnterpriseOne Pages, called Embedded Pages, launch an application automatically when you click the
EnterpriseOne Page tab. You cannot close these pages because they do not have a Close button. Therefore, find an
application that has a close button, save your work if desired, and click Close. You may resume opening applications
once you have closed enough applications so that you are below the maximum number specified by your system
administrator.

Note:  If you have opened the maximum number of Embedded EnterpriseOne Pages, you might have to log out and
log back in to JD Edwards EnterpriseOne.
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Working with Favorites  
This section discusses how to:

• Access the Favorites Menu

• Add a Favorite

• Add a Favorite from an Open Application

• Manage the Favorites Window

• Rename Favorites

• Remove Favorites

• Reorder Favorites

• Reorganize Favorites

Accessing the Favorites Menu  
To access the Favorites menu, click Favorites on the EnterpriseOne menu.

The Favorites menu displays all of the tasks and folders that you added.

Note:  The favorite tasks and folders are also displayed in the Favorites tab in the carousel container.

Adding a Favorite  
Tasks can be added as favorites. To add a favorite:

1. Right-click the task that you want to add as favorite, and select Add to Favorites from the context menu.
2. In the Add to Favorites dialog box, use the default name or enter the name for your favorite.
3. Click Create Favorite.

The task is added to the Favorites menu.

Note: 

• Duplication of favorites in the same folder level is not allowed.

• While adding a favorite, you can hide the Add to Favorites window from appearing again by placing a check
mark in the Do not show this screen again check box.

To make the Add to Favorites window appear again, access the Personalization menu, and from the
Preferences option, select the Show Add Favorites Window check box.
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Adding a Favorite from an Open Application  
You can add a favorite from any form of an open application instead of from a task view. Navigate to an application
either through the Navigator menu, or through the Fast Path. Your ability to add a favorite from an open application
form depends on whether or not your system administrator has enabled you to do so.

If you are a system administrator, the Server Manager interface for runtime and metric parameters provides details on
the usage of each setting applicable to that parameter. Access the interface by clicking the "i" (Information) icon for a
desired parameter. The ability to add a favorite from an open application form is enabled if the Setting name = Allow
Non-Task Favorites in the JAS.ini file is enabled.

Note:  You cannot add a favorite to an application that has form interconnects, which is the ability of application forms
to pass information back and forth between them.

1. To add a favorite from an open application, launch an application.
2. From the Tools menu, click Add to Favorites.

The Add to Favorites dialog box appears.
3. In the Name field, accept the default name or enter a new name.

Note:  Select the Do not show this screen again check box if you do not want the Add to Favorites Dialog
box to appear when you add a favorite. To make the Add to Favorites window appear again, access the
Personalization menu, and from the Preferences option, select the Show Add Favorites Window check box. 
Also, you can click the Manage Favorites link to launch the Manage Favorites window where you can delete,
rename, reorder, and create user-defined folders to reorganize the favorites. See Manage Favorites Window in
the Foundation guide for more information about this topic.

4. Click Create Favorites.
You will see your new favorite on the Favorites menu, and the Favorites folder on the Carousel.

Manage Favorites Window  
The Manage Favorites window displays the favorites that are added by the user. You can delete and edit favorites from
this window. The Manage Favorites window allows you to delete, rename, and reorder favorites, as well as create user-
defined folders to reorganize favorites.

You can access the Manage Favorites window in the following ways:

To access Manage Favorites from the Favorites menu:

1. Click Favorites.
2. Click Manage Favorites.

The Manage Favorites window appears.

To access Manage Favorites from the carousel:

1. Click the Favorites tab in the carousel.
2. Click the Manage Favorites icon.

The Manage Favorites window appears.
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Note:  The Manage Favorites link is also available in the Add to Favorites window, and the Favorites Properties option.

Renaming Favorites  
You can rename a favorite in the following ways:

To rename a favorite from the Favorite Properties:

1. Right-click a favorite from Favorites menu.
2. Select Favorite Properties.
3. Enter the name for the favorite in the Favorite Properties window.
4. Click Save Changes.

The new name of the favorite appears in the Favorites menu.

To rename a favorite from the Manage Favorites window:

1. Click Favorites.
2. Click Manage Favorites.
3. From the Manage Favorites window, select the favorite you want to edit.
4. Click the edit button next to the selected favorite.
5. Enter a name for the favorite.
6. Click outside the name field or press the Tab key on the keyboard.

The new name of the favorite appears in the Favorites menu.

To rename a favorite from the Add to Favorites Window:

When you add a task or folder as favorite the Add to Favorites window appears.

1. Clear the name that is displayed in the Favorites field.
2. Enter the new name.
3. Click Create Favorite.

The new name of the favorite appears in the Favorites menu.

Removing Favorites  
You can remove or delete a favorite in the following ways:

To remove a favorite from the Favorites menu:

1. Click Favorites.
2. Right-click the favorite which you want to remove.
3. Select Remove From Favorites.
4. On the Remove Favorite dialog box, click OK.

JD Edwards EnterpriseOne removes the favorite from the Favorites menu.

To remove a favorite from the Manage Favorites window:

1. Access the Manage Favorites window.
2. Select the favorite that you want to remove.
3. Click the Remove Favorite icon next to the selected favorite.
4. On the Remove Favorite dialog box, click OK.
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JD Edwards EnterpriseOne removes the favorite from the Favorites menu.

To remove all the favorites:

From the Manage Favorites window, click Delete All.

All the favorites are removed from the Favorites menu.

Reordering Favorites  
You can arrange favorites in the order you prefer them to appear in the Favorites menu. To reorder favorites:

1. Access the Manage Favorites window.
2. Drag and drop the favorites in the order you want them to appear.

The Favorites menu displays the favorites in the sequence you arranged.

Reorganizing Favorites  
You can create new folders to organize your favorites. To create a folder:

1. Access the Manage Favorite window.
2. From the Manage Favorites window, click New Folder.
3. Use the default folder name or enter the name for the folder.
4. Click outside the folder name field or press the Tab key on keyboard.

A user-created favorite folder is created.

In the Manage Favorites window, you can drag and drop the favorites into the user-created favorite folder to organize
your favorites.

You can view the content of the user-created favorite folder by clicking the Manage user-created folder icon, on the left
side of the user-created folder's name.The favorites appear in the order you added them in the user-created folder. To
navigate back to the main view of the Manage Favorites window, click the Back button.

Note:  You cannot drag and drop a user-created folder into another folder.

Working with Toolbar Options  
This section provides an overview of toolbar options and discusses how to:

• Work with Row and Form Exits

• Set Up Favorite Row and Form Menu Selections

Understanding Toolbar Options  
Most JD Edwards EnterpriseOne forms include a toolbar with buttons that provide access to specific tasks. You must
be familiar with toolbar options to use the JD Edwards EnterpriseOne system. Toolbar options vary depending on form

25



JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 2
Getting Started with the JD Edwards EnterpriseOne Web

Application User Interface
type. For example, a Find/Browse form usually includes a Select button so that you can select a record in the grid,
whereas a Fix/Inspect form does not have a Select button because it displays the values for a specific record.

The following table describes many of the standard toolbar buttons:

Toolbar Button Description

Find
 

The Find button displays records in a grid.
 

Select
 

The Select button selects one or more records and opens corresponding forms.
 

Search
 

The Search button displays all the entries from your database that match the search criteria that you
specify.
 

Add
 

The Add button opens a new form where you can add a new record.
 

OK
 

When you click the OK button, record additions and updates are written to the database.
 

Copy
 

From a Find/Browse form, the Copy button copies the entire record. The system copies all fields into
a new record, except those fields that are unique to the existing record.From a Fix/Inspect form, the
Copy button selects the fields for the new form. You must enter data in all other fields. You can modify
on the new form those fields that you copied from the existing record.
 

Delete
 

From a Find/Browse or Fix/Inspect form, the Delete button deletes the entire record.
 
Depending on the application that you are using, the Delete button might also remove related
information. For example, if you delete an Address Book record, the system also deletes the phone
numbers for that record. See your application user guide for information about deleting child records.
 

Close
 

The Close button closes the form.
 

Cancel
 

When you click the Cancel button, any changes you have made are lost and no database changes are
made.
 

Tools
 

The Tools button can include options such as Refresh, Export Grid Data, or Data Browser.
 

Collaborate
 

The Collaborate submenu under the Tools menu has the following options:
 

• Send Email

• Send Meeting Invite

• Send Shortcut

• Parameterized URL

In addition to standard buttons, the toolbar can include other options such as reports (which provides a list of reports
pertaining to the application), row exits, and form exits.
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Working with Row and Form Exits  
There are two types of Row and Form Exits: Standard and Simplified.

Standard Row and Form exits display as buttons on the toolbar. When you click the Form or Row button on the toolbar, a
list appears with options relating to the active form. The functions on the form and row exits vary from form to form. For
example, a form or row exit might open a data entry form or provide access to other forms that relate to the record you
selected.

You can also use row exit and form exit right-click options to access the selections on the row and form toolbar menus.
When you right-click a cell in the grid, the grid row is selected and the row menu selections display in a context menu.
Using this feature, you do not need to click the Row button at the top of the form. This feature has been enabled for
Find/Browse, Search & Select, Parent/Child, Headerless Detail, Header Detail, Power Browse, Power Edit, and Subform
forms.

The following example shows the context menu that displays on the Customer Service Inquiry form after right-clicking a
cell in the grid:
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Note:  If the JD Edwards EnterpriseOne form does not have any Row menu selections available, the default browser's
context menu appears and the grid row is not selected.

Similarly, when you right-click in the form outside the grid, the form menu selections display. The form menu selections
are not accessed from a row. Any disabled menu selections in the form and row menus do not display in the context
menu list.

The following example shows the form menu selections on the Customer Service Inquiry form:
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Note:  To hide the form exit context menu, you can click anywhere in the form header. To hide the row exit pop-up
menu, click anywhere in the grid unless the grid is editable. In the case of editable grids, you must click on the form
header or below the grid area to hide the pop-up menu.

Note:    Click here to view a recording of this feature.

Simplified Form and Row exits display as tabs on the side of the screen. If your system administrator has enabled you
to do so, you can choose if your EnterpriseOne interface displays Simplified or Standard mode.You can drag and drop
Simplified tabs vertically. In Simplified mode, you will see only the tabs. In Standard mode, you can choose the type of
Row and Form exits you see. The following graphic displays the Simplified tabs:
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Choosing Standard or Simplified Form and Row Exits  
To choose Standard or Simplified Row and Form exits:

1. Ensure that you have permissions to change the Standard or Simplified mode by clicking Personalization, My
System Options, and then User Profile Revisions.

2. Select the Enable Simplified Row/Form Exits option to view the Simplified Row and Form exit tabs. Deselect
the option to view the Standard Row and Form exit buttons.Click the Personalization menu, and then click
Preferences.

3. Log out and then log in to EnterpriseOne to see your changes.

Accessing Row Menu Selections  
To access row menu selections:

1. On a form with a Row button on the toolbar, click the Row button.

The row menu selections display in a drop-down list.
2. Click the desired menu selection.
3. Alternatively, click a cell in the grid to display the row menu selections in a context menu.

Accessing Form Menu Selections  
To access form menu selections:

1. On a form with a Form button on the toolbar, click the Form button.

The form menu selections display in a drop-down list.
2. Click the desired menu selection.
3. Alternatively, right-click anywhere in the form (except the grid) to display the form menu selections in a context

menu.
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Setting Up Favorite Row and Form Menu Selections  
To add favorites to a form or row pop-up menu:

1. On a form with a Row button on the toolbar, right-click a cell in the grid to display the row context menu.
2. If the form has a Form button on the toolbar, right-click the form to display the form context menu.
3. Click a selection in the Form or Row portion of the context menu and drag it to the Favorites section.

Note:  If there are no menu items in the Favorites section, drag and drop the menu selection onto the
Favorites label to add the menu item to the Favorites menu.

4. If necessary, drag and drop the Favorites selections to reorder them.
5. To remove a selection from Favorites, drag it to the Row or Form section of the context menu.

Using Parameterized URL  
The Simplified Parameterized URL is a feature that enables an external system to launch a native JD Edwards
EnterpriseOne application through the use of a simple URL. This feature provides external applications the ability to
have a nearly seamless user interface integration with any available JD Edwards EnterpriseOne application.

When you select Parameterized URL from the Tools menu on a form, a Java Script Alert message shows the
parameterized URL for that application. You can copy and paste the URL into a new browser page to launch the
application.

Note:  If you are using Microsoft Internet Explorer, you must select the parameterized URL and use the keyboard
shortcut Ctrl+C to copy it. If you are using the Mozilla Firefox browser, select the parameterized URL by using the Right
-click and copy option in the Alert window to copy it.

Considerations for Query Control  
If you use the Query control (for advanced queries) to create and save search criteria on a form, and your system
administrator has made the queries public, then the query information is available when someone uses a parameterized
URL to launch the application. If multiple public queries have been created, they are available when using the
parameterized URL.

Your system administrator must make the query available to other users. After doing so, a public version of the query
displays beneath a line in the Query drop-down menu.

Queries located above the line are queries available only to the user who created them. If user A sent a parameterized
URL to user B, then user B would be unable to access the query information for the query when using the parameterized
URL. Additionally, user B would receive the following error message:

Requested Query Wasn't Found

If you receive this error, contact your system administrator.

Queries located below the line are the queries that have been made public. Therefore, when user A sends a
parameterized URL to user B, and user B uses it to log into EnterpriseOne, the query information is available.
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If you are a system administrator, see the "Changing an Individual User Override to a Group User Override" section in the
The JD Edwards EnterpriseOne Tools Runtime Administration Guide  for more information.

For more information on the query control, see the "Queries" chapter in the JD Edwards EnterpriseOne Tools Using and
Approving User Defined Objects Guide .

Using Online Documentation  
You access field-level help by placing the cursor in a field and pressing F1. You can also access the field-level help
by clicking the Help icon located at the top-right corner of a form and then clicking the Item Help option. If the field
in which the cursor resides is a business view column, the system displays the alias name, business view name and
description, table name and description, and glossary text. If the field in which your cursor resides is a data dictionary
column, the system displays the alias name, the term Data Dictionary Item, and the glossary text.

You can access the online documentation by the following two ways:

• Click the Help icon located at the top-right corner of a form and then click the Help option.
(Release 9.2.5) If you use UPKs and set up online help to access both UPK documentation and online help
documentation in the Media Object Queues application (P98MOQUE), when you click the Help icon, the system
displays two options: UPK Help and EOne Help. Click the UPK Help option to access UPK documentation and
click the EOne Help option to access the online help documentation. However, if you set up online help to
access either the UPK documentation or the online help documentation, the system displays only the Help
option.

Note:    Click here to view a recording of this feature.

• Click the Down Arrow icon located next to your login name and then click the Help option.

Note: 

• If you are using an application with a product code equal to H20, H79, 98, or beginning with H9:

When you click the Help icon, EnterpriseOne searches the EnterpriseOne Tools Documentation Library
for topics with program IDs that correspond to the application you are using. For example, if you are using
Vocabulary Overrides, and click the Help icon, EnterpriseOne searches for all the documentation topics that
pertain to P9220 (Vocabulary Overrides Program ID).

• If you are using an application without one of the above product codes:

When you click the Help icon, EnterpriseOne searches the EnterpriseOne Applications Documentation Library
for topics with program IDs that correspond to the application you are using. For example, if you are using
Address Book, and click the Help icon, EnterpriseOne searches for all the documentation topics that pertain
to P01012 (Address Book Program ID).

• If you click the Help icon outside of an application, you are taken to a list of links to JD Edwards EnterpriseOne
libraries.

If you are unable to access the online documentation library, contact your system administrator.

Note:    Click here to view a recording of this feature.
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For information about how to set up online documentation, see "Setting Up Help" in the JD Edwards EnterpriseOne Tools
Runtime Administration Guide

Error Messages and Error Dialog Boxes  
When you enter information into a field that is inaccurate or unrecognizable by JD Edwards EnterpriseOne, or if you
fail to enter data into a required field, the field displays a red background to indicate the error, and an error message
displays at the top of the form. If there are multiple errors on one form, they display as a list at the top of the form. You
can view more information about the error by clicking the arrow located to the left of the error message. If the error
message has a Go To Error link to the right of it, you can click the link and JD Edwards EnterpriseOne places your cursor
in the field that correlates to the error message.

When you place your cursor in a field that contains an error, a dialog box displays that further identifies what you must
enter into the field to correct the error. You can move the dialog box by clicking the top of it and dragging it to another
location on the screen. You can tab out of the field to validate the information. After the information is validated, the
error message is removed from the list. To view all the errors on the form listed at the top of the form, click Go to Top. To
disable the pop-up dialog box, clear the Enable Error Pop-Ups check box at the top of the form.

To view error messages and correct errors:

1. On the application on which you are working, if there are red fields indicating errors, scroll to the top of the
form and review the error messages that are displayed.

2. If the error messages you are viewing contains a Go to Error link, click the link to go to the field that correlates
to the error message.

3. Enter valid information into the field.
4. Tab out of the field, to ensure that the information you entered is correct or recognizable. If it is, the dialog box

disappears, the field displays a white background, and the error message is removed from the list.

Note:    Click here to view a recording of this feature.

Turning Auto Populate On or Off  
AutoPopulate assists you when you are performing repetitive data entry on the grid control. It uses content that already
exists in the grid column to populate the cell in which you are currently typing. If the characters you are typing match
those that already exist in the same column, AutoPopulate automatically adds the whole string of characters from the
existing cell to the current cell. For example, you have already entered the following number into a cell in the column in
which you are currently typing: 330456 If you type a 3 in the current cell, AutoPopulate will automatically place 330456
in the cell in which you are working. You can opt to accept the number by pressing tab, or you can delete the number
and enter one of your own. You can turn AutoPopulate on or off. The action you select will apply to all applications to
which you have access within JD Edwards EnterpriseOne.

The feature is disabled for simplified Chinese, Korean, Japanese, and traditional Chinese language environments.

To turn Auto Populate On or Off, from the Tools menu, click AutoPopulate. If a check mark appears beside
AutoPopulate, the feature is turned on. If no check mark appears, it is turned off.

EnterpriseOne contains features that you use to globally impact the EnterpriseOne web client interface.
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Auto Suggest  
Auto Suggest is a user interface feature which progressively searches and filters through text. Auto Suggest searches
pre-defined tables and returns records that match text you type into a field. As you type text into a text field, one or
more possible matches for the text are found and immediately presented to you in the grid around the field. This
immediate feedback enables you to stop typing the entire word or phrase for which you are looking. Instead, you can
choose a record from the list that appears.

Auto Suggest searches for data in multiple tables and returns 10 matching records per page. The feature does not
require you to remember the code or number for the field. Instead, you can type the name or description of the field and
the system will search the name or description that begins with what you typed. For example, if you type in "Bi" in the
item number field, the system may return "Bike", "Bike-Mountain" and other items whose name starts with "Bi". Once
the list of suggested values is displayed, you can use arrow keys or the mouse to navigate to the correct record, then
press the Enter key or click on the record to select the record. When a record is selected, the code or item number value
(for example, 220) is automatically filled into the item number field. The system automatically queries the database
based on the description you typed, and fills in the field value with the proper code or value.

Note:  Auto Suggest is case sensitive. If the item descriptions stored in the database are all lowercase, typing "Bi" may
not return any suggested values because the first letter typed is uppercase.

Your system administrator determines which fields have Auto Suggest enabled, and determines the circumstances for
which it is activated. For example, Auto Suggest might begin searching after you type two characters into a field or after
you pause typing for a number of seconds.

Your system administrator can configure the Auto Suggest feature in the following two ways:

1. Automatic

The system administrator specifies the minimum number of characters you need to enter, and also specifies
that a manual hot key is not required to trigger Auto Suggest. When you type into these fields, you will notice
a gray down arrow at the bottom right corner of the field. After you type the minimum required number of
characters, the gray down arrow turns blue, and the suggested values display automatically. If the down arrow
turns blue but no values are displayed, there are no matching records in the system. You need to change or re-
type the name or description.

2. Manual

The system administrator specifies that you have to manually trigger the Auto Suggest process (hot key
required). The system administrator also specifies the minimum number of characters that you need to enter,
before the manual Auto Suggest feature is triggered. When you type into these fields, you will notice a gray
down arrow at the bottom right corner of the field. After you type the minimum required number of characters,
the gray down arrow becomes a clickable blue arrow. Clicking the blue arrow triggers the system's Auto Suggest
process. The system then starts searching for items based on what you typed. The Auto Suggest feature is not
triggered automatically. You need to click on the blue down arrow to trigger it.

See "Setting Up Auto Suggest" in the JD Edwards EnterpriseOne Tools Runtime Administration Guide.

If Auto Suggest is enabled, you do not need to remember codes in order to search for, or enter, data in a field.

If Auto Suggest is enabled, you see a grey color arrow icon in the lower corner of the text field, QBE field, or the grid cell
when you click into it. The grey arrow turns into blue arrow when you start typing in the text box. Type in one or two
characters and click the blue color arrow icon to display the list of Auto Suggested options.
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Enabling or Disabling Auto Suggest for a Single Form  
To enable or disable the Auto Suggest feature for a single form, Select Tools menu and select or deselect the Auto
Suggest option.

Enabling or Disabling Auto Suggest Globally  
You can select or deselect the auto suggest feature globally by selecting the Preferences option from the
Personalization drop-down menu. Select or deselect the Auto Suggest Enabled check box from the Preferences window
to enable or disable the Auto Suggest feature across all forms.

UDC Drop-down Menu  
UDC Drop-down is a user interface feature that enables the users to select text on fields.

If the drop-down is enabled for a UDC field, you see a Drop-down icon instead of Visual Assist and Auto Suggest
icons. When you click on the Drop-down icon, a window with a list of values is displayed from which you can select the
required value. You can click on the Next button at the bottom of the window to navigate to the next set of records. This
drop-down window does not contain a column header.
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Also, if the drop-down menu is enabled for a UDC, you can progressively search and filter through text. You can type in
a letter, number or any wildcard entry. The system searches the pre-defined tables and returns records that match the
text you typed into a field. As you type text into a UDC Drop-down enabled field, one or more possible matches for the
text are found and immediately presented to you in the grid around the field.

There is a Search link at the lower right corner of the window. You can click this link to open a visual assist window for
more advanced search capabilities.

See  Setting Up UDC Dropdown Menu in the JD Edwards EnterpriseOne Tools Runtime Administration Guide

Send Email and Meeting Invite Options  
JD Edwards EnterpriseOne enables users to collaborate with other users by using the Send Email and Send Meeting
Invite options.

All JD Edwards EnterpriseOne forms except the message forms include a toolbar with the Collaborate submenu in the
Tools menu. You can use the Collaborate submenu to access Send Email and Send Meeting Invite options.

Also, you can send emails and meeting invites to the required recipients using the Send Email and Meeting Invite
options from the Collaborate tab of the hover forms in the Address Book fields.
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Note:  You can use this feature with Outlook, Thunderbird, and Gmail as your default email clients, and, with Outlook
and Thunderbird as your default calendar clients. You can check or uncheck the Use Thunderbird As Calendar Client
option in the Preferences window from the Personalization drop-down menu to enable or disable Thunderbird as your
default calendar client.

Accessing Send Email Option from Tools Menu  
To access the Send Email option from the Tools menu:

1. On the form with which you are working, select the Tools menu.

Note:  The Tools menu is not supported on the embedded form and hence, the Send Email and Meeting
Invite options are also not supported on the embedded forms.

2. Click Collaborate.

3. Select the Send Email option.
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4. The system displays the Message window of the default email client.

The subject of the email contains the title of the form. The body of the email contains the title of the form and
the parameterized URL of the form. You can view the form or application by clicking the parameterized URL,
and then entering your user ID and password.

5. Enter the recipient's email address in the empty Email Recipient field.
6. Click Send.

Accessing Send Meeting Invite Option from Tools Menu  
To access the Send Meeting Invite option from the Tools menu:

1. On the form with which you are working, select the Tools menu.
2. Click Collaborate.
3. Select the Send Meeting Invite option.
4. The File Download window of the browser appears with an option to open or save the .ics (calendar file) file.

Note:  For Outlook, you can choose an option to open or save the .ics file.  For Thunderbird, save the .ics file
to a desired location; then, open Thunderbird, access the Events and Tasks tab, click Import, and navigate to
the location where you saved the .ics file. Select the .ics file and click Open. The meeting will be added to the
Thunderbird calendar, and also in the Events and Tasks window.

5. Click Open.

Note:  You can also save the file in a desired location and open it later.

6. The system displays the Appointment window of the default calendar. The subject of the meeting invite
contains the title of the form. The body of the meeting invite contains the title of the form and the
parameterized URL of the form. You can view the form or application by clicking the parameterized URL, and
then entering your user ID and password.

7. Schedule a meeting time and add the meeting recipients as required.
8. Click Send.

The meeting will be added in the calendar of your default email client.

The Send Meeting Invite creates the meeting request by default using the current time on the machine from
where the E1 HTML server is running. It does not use the time on the machine from where the browser with
the E1 web client is accessed. You can open your default email/calendar client and edit the time of the meeting
request.

Accessing Send Email and Meeting Invite options from Data
Dictionary items  
Hover forms contain context-based information. The hover form is displayed when you click the hover indicator in the
hover-supported JD Edwards EnterpriseOne control.

See Message Form as Hover Form in this guide.

You can use the Collaborate tab in the hover form to send emails and meeting invites to the required recipients. Your
system administration can enable the Collaborate tab in the following hover forms:
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• Employee Information hover form (P080100)

• Address book Information hover form (P01700)

• Customer Information hover form (P03B700)

• Supplier Information hover form (P04700)

The Collaborate tab in the hover form is enabled by default for the Address Number (AN8) type hover forms listed
above. You can disable this tab using Work with Feature Definitions (P958973) application.

See Enabling and Disabling Collaborate tab in the JD Edwards EnterpriseOne Tools Runtime Administration Guide.
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Accessing Send Email Option  
To access the Send Email option:

1. Enter a valid Address Book Number in the Address Book field.
2. Hover over the orange dot indicator in the Address Book field. The orange dot indicator will turn into a clickable

indicator.
3. Click the clickable indicator. The hover form is displayed.
4. Click the Collaborate tab. The Collaborate tab displays a list of email IDs associated with the Address Book

number. The list of email IDs that appears in the Collaborate tab is configured for a particular address number
in the Who's Who application. If an email ID is not configured for a particular address number, the Collaborate
tab is empty and the Send Email and Send Meeting invite buttons are disabled. If you are using the Chrome
browser, the hover form may close when you click the disabled Send Email or Send Meeting buttons.

5. In the Collaborate tab, select the email ID as required. You can select multiple email IDs. A maximum of
five email IDs are displayed per page in the Collaborate tab. You can use the Next and Previous links in the
Collaborate tab to navigate across the email IDs.

6. Click the Send Email button.

Note:  The Send Email and Send Meeting Invite buttons are disabled by default. The buttons are enabled
after you select an email ID.

7. The Message window of the default email client is displayed.

The subject of the email contains the title of the form. The body of the email contains the title of the form and
the parameterized URL of the form in the case of Employee and Address Book hover forms. You can view the
form or application by clicking the parameterized URL, and then entering your user ID and password.

The body of the email is empty in the case of Customer and Supplier hover forms.
8. The recipient email address is populated based on your selection.
9. Click Send.

Accessing Send Meeting Invite Option  
To access the Send Meeting Invite option:

1. Hover over the orange dot indicator in the address book field. The orange dot indicator will turn into a clickable
indicator.

2. Click the clickable indicator. The hover form is displayed.
3. Click the Collaborate tab. The Collaborate tab displays a list of email IDs associated with the Address Book

number.

The list of email IDs that appears in the Collaborate tab is configured for a particular address number in the
Who's Who application. If an email ID is not configured for a particular address number, the Collaborate tab is
empty and the Send Email and Send Meeting invite buttons are disabled.

4. In the Collaborate tab, select the email ID as required. You can select multiple email IDs. You can use the Next
and Previous links in the Collaborate tab to navigate across the contacts.

5. Click the Send Meeting button.
6. The File Download window of the default browser is displayed with an option to open or save the .ics file.
7. Click Open.

Note:  You can also save the file in a desired location and open it later.

8. The Appointment window of the default calendar client is displayed.
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The subject of the meeting invite contains the title of the form. The body of the meeting invite contains the
title of the form and the parameterized URL of the form in the case of Employee Information and Address Book
Information hover forms. You can view the form or application by clicking the parameterized URL, and then
entering your user ID and password.

The body of the meeting invite is empty in the case of Customer Information and Supplier Information hover
forms.

Note:  For Outlook, you can choose an option to open or save the .ics file.  For Thunderbird, save the .ics file
to a desired location; then, open Thunderbird, access the Events and Tasks tab, click Import, and navigate to
the location where you saved the .ics file. Select the .ics file and click Open. The meeting will be added to the
Thunderbird calendar and also in the Events and Tasks window. The Send Meeting Invite creates the meeting
request by default using the current time on the machine from where the E1 HTML server is running. It does
not use the time on the machine from where the browser with the E1 web client is accessed. You can open
your default email/calendar client and edit the time of the meeting request.

9. The recipient address will be populated based on your selection.
10. Click Send.

If the hover form contains lot of information, for example, if the email address is very long then the browser inserts the
scroll bar. It is recommended to have concise information on the hover forms since the hover forms are intended to
provide a small snapshot of the data.

If the parameterized URL is very long, the email clients such as Thunderbird and Gmail will not render the complete URL
as a hyperlink.

In that case, you have to manually copy the entire link and paste it into the address bar of your browser to access the E1
application. This does not happen if you are using Microsoft Outlook as your default email client.

Configuration Settings  
This section discusses the server manager settings for Send Email and Send Meeting Invite feature.

MailtoInNewWindow  
To use Gmail as the email client in browsers:

1. Access the Server Manager Console.
2. Navigate to the Configuration settings for the HTML Server.
3. Select the Advanced View.
4. In the Web Runtime section, set the value of Enable mail to links in new window to True.

When you click the Send Email link, the system will open the Gmail Compose Mail window enabling you to compose a
new email message if the value of MailtoInNewWindow setting is set as True.

In the case of Employee Information and Address Book Information hover forms, the body of the email message is
pre-populated with the JD Edwards EnterpriseOne parameterized URL to the EnterpriseOne application from which
the Send Email link was clicked. The body of the email is empty in the case of Customer Information and Supplier
Information hover forms.

If you are not signed in to Gmail before you click the Send Email link, when you click the Send Email link, the Gmail login
page appears. After you log in to Gmail, the Gmail Compose Mail window appears.
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If you are using a browser to access Send Email or Send Meeting Invite functionality, and if the MailtoInNewWindow
INI setting is set as True then, a new browser window/tab is displayed with an informational message before the email
client is loaded. The informational window/tab closes automatically after the email client is loaded.

Use Thunderbird  
Add the UseThunderbird setting in the OWWEB section of jas.ini and set the value as "true", to use Thunderbird as the
default Calendar client.

To use Thunderbird as the default Calendar client, from the Server Manager Console, navigate to the Configuration
settings for the HTML Server and then select the Advanced View. In the Web Runtime section, set value of Enable
Thunderbird as the default calendar client as True.
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3  Using the Carousel Container

Carousel Container Overview  
A carousel is a generalized container that holds objects which can be activated. These objects are displayed on tiles
arranged from left to right, and you can flip through these tiles. The carousel container provides quick access to the
open applications, batch versions, and favorite JD Edwards EnterpriseOne applications and batch jobs.

Note:  The carousel is to JD Edwards EnterpriseOne as the taskbar is to Microsoft Windows.

To access the carousel container, click the bar along the inside edge at the bottom of the browser window. Click this bar
to toggle between minimized and maximized modes of the carousel container.

When the carousel is minimized, only the toggle bar is visible, and the arrow points out from the edge towards the
center of the page. The carousel tiles are linear and have two distinct ends.

Click the Move icon, next to the Favorites tab, to hide and unhide the tabs of the carousel container.

Carousel Tiles  
The carousel tile uses a background image to indicate what type of tile it is. For example, application tiles have a
different icon to distinguish them from UBE's.

Each carousel tile contains text describing the application or UBE with which it is associated. For example, an application
tile lists the application name, form name, and application title.

Click the tile in the carousel container to open the task. As shown in the following example, the tile that represents the
application that is currently open is highlighted.
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You can change the carousel tile size by accessing Preferences dialog from the Personalization drop-down menu. Select
or deselect the Use Large Icons in Carousel checkbox and click the Save and Close button.
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The carousel container contains the following three tabs:

1. Open Applications
2. Recent Reports
3. Favorites

Open Applications  
Each application that is open is represented as a tile in the Open Applications tab of the carousel container. Click the tile
in the Open Application tab to bring a specific application to the forefront.

Note:  Open applications are also listed under the Open Applications drop-down menu.

Hover over the tiles in the Open Applications tab to view the details of each application.

Recent Reports  
The Recent Reports tab displays all of the recently submitted reports (batch versions). Click the first tile, which
represents Submitted Jobs, to open Submitted Job Search (P98305W).

Hover over the report tiles to view report, version, status, submitted date, and last activity as shown in the following
example.
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The tiles that represent the reports display visual cues to help you identify the status of the reports. The status of a
report is conveyed by the color of the pencil icon in the tile. For example, Green = Done (D), Red = Error (E), Blue =
Submitted (S)/Waiting (W)/Processing (P), Yellow = Held (H).
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Note:  Use the Refresh icon to trigger an immediate update. The Refresh icon will show the latest status for the report
(i.e. report is finished).  With EnterpriseOne Tools release 9.2.0.5 forward, the Poll Interval setting in Server Manager is
used to automatically update recent reports instead of having to manually refresh.

Favorites Tab  
The items that you add as favorites from the JD Edwards EnterpriseOne menu also display on the Favorites tab in the
Carousel. When the Carousel is docked on the bottom of EnterpriseOne, favorite items display on the Favorites tab.
When the Carousel is docked on the side of EnterpriseOne, favorite items display in the Favorites section. In most
cases, Favorites performs the same no matter where the Carousel is docked. However, there are some instances where
functionality differs slightly, and these will be noted in this documentation. This documentation describes Favorites and
its performance while docked at the bottom of EnterpriseOne. The Favorites tab can contain three types of tiles: task
folder tiles, user-defined folder tiles, and task tiles.

When you open the Favorites tab and click a parent-level task folder or user-defined folder located there, EnterpriseOne
adds a tab to the tab bar. This new tab displays the task folder or user-defined folder name and all the contents of
that folder. When you double-click a sub-folder, a '^' appears on the left side of the tab. The '^' indicates that there is a
higher-level folder. When you click the '^', the higher- level folder and its contents appear.

When you create a user-defined folder, you can include in it tasks and task folders, but not additional user-defined
folders. However, task-folders can, and often do, contain other task-folders as well as tasks, though you cannot add a
task-folder or task to any existing task-folder. If you click a task folder contained within another task-folder, the current
tab displays the new task folder name. If you hover above a task folder, a list of everything within that folder displays
in a box near the cursor. You can change the name of the parent-level task folder at the Favorites level but you cannot
change the names of items in the folder or the structure of its contents. You cannot change the name of the task folder,
or its contents. If you click a task, the appropriate application launches.

Note:    Click here to view a recording of this feature.

Organizing Favorites  
The Favorites tab can contain one or all of the following tiles:

• User-defined folder

• Task folder

• Task

You can move task or task-folder tiles from the Favorites tab to a user-defined-folder tab and you can move those tiles
back from a user-defined-folder tab to the Favorites tab. You cannot move user-defined folder tiles from the Favorites
tab.

To move a task folder or task tile, click the tile, hold the mouse button until a red border appears, and then drag the
tile over the user-defined folder tile to where you want the tile moved. The user-defined folder tile displays a grey
background and a green border when it is activated to receive an acceptable tile. Release the mouse button to drop the
tile. The tile will be moved to the user-defined folder's content.
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You can also move a task folder or task tile by briefly holding (or hovering) a tile over an open user-defined-folder tab
or Favorites tab. The tab is activated and enables you to view the contents of that tab. It also indicates that you can drop
the tile into the existing content on the receiving tab.

Note:  When the Carousel is docked on the side of EnterpriseOne, you hold the tile over a user-defined section. When
the section is ready to receive the tile, it will be highlighted in grey and display green borders. Releasing the tile when
the section is activated will drop the tile into the section. The tile is positioned at the end of the section.

EnterpriseOne ensures that you drop Favorite task tiles or task-folder tiles to an appropriate location. An appropriate
location is one where the tab is activated to receive a tile, and the tile meets the criteria to be moved and dropped. If
the location in which you are trying to drop is not appropriate, it will either move out from underneath the tile you are
dragging or change the mouse icon to "not-allowed," indicating that either the location to which you are trying to drop
is not activated or the tile you are dragging does not meet the criteria to be moved and dropped.

Ordering Tabs  
You can change the order in which the tabs display by dragging and dropping them to a different location on the
Carousel tab bar. The tab order will be the same if the Carousel is docked in the horizontal or vertical position. When you
log out and login back into EnterpriseOne, your latest changes to the tab order are retained.

Hiding and Showing Recent Reports, Open Applications, Favorites
Tabs and Sections  
You might want to hide the Recent Reports, Open Applications, and Favorites default tabs if you never use them, use
them infrequently, or just want more space on the screen. The changes you make to the Carousel are saved and remain
when you log off and log back into EnterpriseOne.

Note:  This document refers to "tabs" if you have docked the Carousel on the top or bottom of the screen, and
"sections" if you have docked the Carousel on either side of the screen.

If you hide any of these tabs or sections, you can show them again at any time.

You can hide only two of the default tabs or sections. You must have at least one tab or section visible at all times.

To hide a default tab when the Carousel is docked on the top or bottom of the screen, right-click the tab, then click the
tab name in the Hide pop-up window that displays, as shown in the following graphic:
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To hide a default tab when the Carousel is docked on the side of the screen, right-click the tab, then click the tab name
in the Hide pop-up window that displays, as shown in the following graphic:

In the following graphics, the Favorites tab and section are hidden:
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When you hide a default tab, the change is reflected wherever the Carousal is docked. For example, if you make the
change when the Carousal is docked at the bottom of the screen, then move it to the side, the changes remain.

To show the tab or section again, right-click the remaining tabs or sections, and select the tab or section name under
Show, as shown in the following graphics:
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EnterpriseOne does not enable you to hide all three default tabs or sections at once; instead, you can only hide two at a
time. Therefore, since you must have one tab or section shown at all times, EnterpriseOne gives you only the option to
Show if you have already hidden two tabs, as shown in the graphics below:
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Carousel Position  
The carousel can be docked along any of the four edges of the browser window.

By default, the carousel is docked along the bottom of the browser page.

You can change the carousel position by dragging and dropping the carousel to a new position. When docked along the
top or bottom of the browser window, the tiles are displayed horizontally. When docked along the right or left, the tiles
are displayed vertically.

When the carousel is docked along the top or bottom of the browser window, you can click on the caption text of the tile
to cycle through the different options.
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JD Edwards EnterpriseOne saves the carousel position. Next time you log into the JD Edwards EnterpriseOne
application, the carousel appears at the bottom, top, left, or right position depending on the setting during your last
session.
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4  Using the Grid

Understanding the Grid  
Similar to Find/Browse forms, hierarchical grids, or Parent/Child browse forms, are used to query business views (BVs)
and select records from BVs for operations. However, instead of a default grid control, hierarchical grids contain a
default parent child control. Whether you have hierarchical grids depends on if your system administrator incorporated
them into the applications you use.

The following table describes the features of the hierarchical grid:

Feature Description

Cut, Copy, and Paste
 

You can cut, copy, and paste a node in the tree. Cutting a node copies the data of a node and marks
the node as being cut. Copying a node copies the data of a node. Pasting a node pastes the node as
the last child of the new node. If the node is copied, the original node stays. If a node has been cut, the
original node is removed. Cancel Cut will cancel the operation. Use the copy, cut, and paste buttons
located on the toolbar of the grid to perform these functions.
 

Indent/Outdent
 

You can change the indentation of a tree node. Use the Indent and Outdent buttons located on the
toolbar of the grid to perform these functions.
 

Expand All
 

You can expand all the nodes in the tree. Use the Expand All button located on the toolbar of the grid
to perform this function.
 

Collapse All
 

You can collapse all the nodes in the tree. Use the Collapse All button located on the toolbar of the grid
to perform this function.
 

Fully Expand One Tree Node
 

You can fully expand a selected tree node. When this happens, all cascading children of the selected
tree node will be displayed. Use the Expand All button to perform this function.
 

View Location Number
 

If your system administrator has turned on the View Location Number option, you see a number
beside each tree node. Use this number to determine the location of the tree node within the tree.
 

Flat Display Tree
 

You can make all tree nodes display on one vertical level. Child nodes are not indented.
 

Select All Children
 

You can select all of the children in a node. Use the Select All button located on the toolbar of the grid
to perform this function.
 

Editable Parent Child
 

You can edit the tree column and all the grid columns in the hierarchical grid.
 

Change Data Dictionary Item on the Fly
 

You can display custom selected columns in a user defined sequence.
 

Vertical Scrolling Keeps Column Header
 

When scrolling down grid data, the grid column header remains visible.
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Understanding Grid Formats  
JD Edwards EnterpriseOne grid formats are personalized grid layouts that you create to customize how your grid data
is displayed. You can display the data either in Table View or List View grid formats. Using the intuitive Grid Format
Manager interface, you can select the columns you want to include in your grid formats.

Note:  If you are using a release prior to EnterpriseOne Tools release 9.2.0.5, you can create only the Table View grid
format.

Understanding Grid Icons and Buttons  
This table shows the icons and buttons that might display on the grid. Whether or not you see any of these icons or
buttons depends on if the application you are using was designed to display them. You might see a variation of these
icons and buttons, depending on the application in which you are working.

Icon Description

Delete
 

Edit
 

Lock
 

Unlock
 

Move Up
 

Move Down
 

Price
 

Print
 

Attach
 

Copy
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Icon Description

View
 

Toggle Off
 

Toggle On
 

Weigh
 

Summation
 

Using the Table View Grid Format  
Table View grid format is one of the grid formats that you can use to find and view records. Table View grid format
enables you to display information in a tabular format. Using the Grid Format Manager, you can select the columns you
want to include in your Table View grid format, and then show/hide columns as required.

Your ability to create a grid format depends on whether your system administrator has enabled the Personalize Grid
icon. If you do not see the Personalize Grid icon in the bar located at the top of the grid, you do not have permissions to
personalize the grid.

For more information on using the Grid Format Manager to personalize the grid, see "Grid Formats" in the JD Edwards
EnterpriseOne Tools Using and Approving User Defined Objects Guide .

Copying and Pasting Grid Data  
In JD Edwards EnterpriseOne, you can select a single cell or a range of cells that contains grid data to copy and paste
into any EnterpriseOne editable grid. An editable grid is one in which you can enter or delete data. You can also paste
grid data into a tab delimited spreadsheet, like Microsoft Excel. You deselect cells by pressing the F5 button on your
keyboard, or by clicking outside of the grid.

The "start cell" is the first grid cell you click to begin selecting a range of cells. The "end cell" is the last grid cell you click
to end selecting a range of cells. The cells you select to copy can be editable or non-editable.

To copy and paste grid data:

Navigate to an application grid that contains the data that you want to copy.

1. Select a range of cells to copy by completing one of the following actions:

◦ Click the start cell and, while holding down the left button, drag the mouse to the end cell. If the start cell
is editable, you cannot use this action to select a range of cells. Instead, use the action described below.

◦ Click on the start cell and while pressing the Shift key on your keyboard, click on the end cell. You can
expand the range of cells you have already selected by pressing the Shift key and clicking on a different
end cell.
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As you move your cursor toward the scroll bar, the grid will automatically begin scrolling so that you can
select a cell outside of those that are currently visible on the grid.

◦ Click the check box located beside a record. Press the Ctrl+C keys on your keyboard.
This option only works if you have not selected a range of cells as described in option A or B.

2. Press the Ctrl+C keys on the keyboard.
The grid data that you selected is copied to the EnterpriseOne clipboard, which is located at the following
location: \WINDOWS\system32\clipbrd.exe

3. Navigate to an editable grid, and place your cursor in an editable cell.
It is important that you notice in which columns you are pasting the grid data. EnterpriseOne enables you
to paste the grid data in any field on an editable grid, regardless of whether or not the columns match up.
Therefore, you can paste grid date from an Alias Name column into an Address column, and EnterpriseOne will
not correct the action.

4. Press the Ctrl+V keys on the keyboard.
EnterpriseOne pastes the data into the grid.

Using the List View Grid Format (Release 9.2.0.5)  
List View grid format is one of the grid formats that you can use to find and view records. List View grid format enables
you to stack columns vertically so that the information displayed is compact and easy to find. Using the Grid Format
Manager, you can select the grid columns you want to include in your List View grid format, and then group them in the
way you want them displayed.

Your ability to create a grid format depends on whether your system administrator has enabled the Personalize Grid
icon. If you do not see the Personalize Grid icon in the bar located at the top of the grid, you do not have permissions to
personalize the grid.

For more information on using the Grid Format Manager to create and modify List View Grid Formats, see "Grid
Formats" in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide .

List View Grid Format User Interface

When you open a form with a default List View grid format, the form displays the grid with only those fields that have
been added to the List View grid format. The fields are displayed in the same order in which they were arranged while
creating the List View grid format. The field width and alignment of the labels and values are displayed as specified
when the grid format was created. The List View grid format is also supported in the Visual Assist forms.

When a record in the grid contains underlined text, it indicates a hyperlink. Clicking the hyperlink text opens the form
associated with the text. A paper clip icon in the grid row indicates that attachments exist for the corresponding record.
Clicking the paper clip icon opens the Media Object Viewer form and displays the attachments.

Similar to the Table View grid, the List View grid format supports data privacy and data masking. For more information
about data masking, see "Display Rule" in the JD Edwards EnterpriseOne Tools Data Dictionary Guide.

Note:  A List View grid is read-only, and is not editable.

Pointing to a field in the grid displays the field's label and its value as Hover Text. This is helpful when data in the grid is
truncated due to resizing of the field width.
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Fore more information, see "Changing the Field Width" in the JD Edwards EnterpriseOne Tools Using and Approving User
Defined Objects Guide .

Fetching Records

When the grid retrieves the records that match the search criteria, the grid header bar displays the record range.
EnterpriseOne categorizes the records into groups so that you can view several records at a time. The default number of
records in a group is 20. You can click the Next button in the header bar to fetch the next set of records to be displayed
in the List View grid. To retrieve all records, click the Go to End button located on the header bar of the grid.

Note:  When there are no records to be retrieved in the grid, the following message is displayed: "No records found."

Filtering Records

The header bar of the List View grid contains the Search field that can be used for filtering the records in a grid. Filtering
is applicable only to the primary rows of the List View grid. You can filter records by entering text or numbers in the
Search field, and then clicking the Find button or pressing the Enter key.

You cannot to use the wildcard characters * or% in the Search field. EnterpriseOne automatically applies a wildcard
character to the searchable text fields in the primary row based on the value entered in the Search field. When you enter
a numeric value in the Search field, only records that exactly match the value are displayed.

Note:  Filtering does not apply to date values in the primary rows.

Sorting Records

You can sort the records in the List View grid using the Sort By drop-down list located in the header bar. You can select
the field you want to sort by from the drop-down list, and the records are sorted in ascending order of the selected field.
You can sort the records on just a single field. List View grid does not support sorting in descending order. The sorting
order is reset to default when a Search filter is applied.

Note:  The header bar of the List View grid displays the Sort By drop-down list only if the fields are enabled for sorting
in Form Design Aid.

Selecting Records

In the List View grid, you can select a single record, multiple records, or a range of records. You can select a single
record or multiple records by clicking anywhere on the corresponding grid rows. The selected row is then highlighted as
indicated by the change in background color. You can select multiple records only if the grid is enabled to support multi
select in Form Design Aid.

To select a range of records, click the start record, and while pressing the Shift key on your keyboard, click the end
record. You can expand the range of records you have already selected by pressing the Shift key and clicking a different
end record. The "start record" is the first row you click to begin selecting a range of records. The "end record" is the last
grid row you click to end selecting a range of records.

Note:  The List View grid format does not support Select All rows in a specified grid.

Note:    Click here to view a recording of this feature.
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Applying a Grid Format  
Access a form with a grid.

On any form with a grid, select a grid format from the drop-down list next to Personalize Grid icon.

You must create one or more grid formats before you can apply a grid format.

Note:  You must have permission to view grid formats in order to see the drop-down list.

Maximizing and Restoring the Grid  
Access the application containing the grid you want to change.

The Maximize Grid and the Restore Grid icons in the grid enable you to toggle between maximized and restored modes
of the grid.

Click the Maximize Grid icon, to display only the grid, and to hide all of the other fields in the form.

Click the Restore Grid icon in the grid to restore the grid as well as all of the other fields in the form.

Exporting All Records from a Grid  
You can export all records from a grid, rather than choosing a range of records to export.

(Release 9.2.5.4) To export all the records from a grid in ActiveX mode, in Internet Explorer set the value for Use ActiveX
Controls as TRUE in the Web Runtime section in the Server Manager.

To export all the records from a grid in non-ActiveX mode, set the value for Use ActiveX Controls as FALSE in the Web
Runtime section in the Server Manager. To export all the records from a grid in non-ActiveX mode along with the OLE
functionality, set the value for Use ActiveX Controls as OLEONLY in the Web Runtime section in the Server Manager.
You can enable this option to export all records from a grid in the Google Chrome, Edge Chromium, Firefox, Internet
Explorer, and Safari browsers.

1. Launch an application with a detail area, and then click the Find button to load the detail area with records.
2. Click the Tools icon, and then click the Export Grid Data menu. You can also click the Export Grid Data icon in

the grid.
3. On Export Assistant, select one of these options:

◦ Export To Excel

Note:  If you select this option, also select whether you want to export to a new workbook or an
existing workbook. If you select the option to export to an existing workbook, the file extensions XLSX,
XLSM and XLS are supported. For the XLS file extension, you must use a version of Excel 97-2003
Workbook. You cannot use XML SpreadSheet 2003.
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◦ Export To Word

◦ Export To Comma Separated Values (CSV) File character encoding

4. Select the Export All option.
5. Click Continue.

Note:  When you export to an existing workbook, you must ensure that the character count for the worksheet
name is between 1 and 31. It must not begin or end with a single quotation mark('). The worksheet name
cannot contain the following special characters: colon (:), backslash (\), slash (/), asterisk (*), question mark
(?), left bracket ([), right bracket (]), 0x0000 (null character), 0x0003 (end of text).

Exporting Detail Area Content to Microsoft Excel, Word,
or to a Comma-Separated Values File  
(Release 9.2.5.4) To export the records from a grid in ActiveX mode, set the value for Use ActiveX Controls as TRUE in
the Web Runtime section in the Server Manager.

To export all the records from a grid in non-ActiveX mode, set the value for Use ActiveX Controls as FALSE in the Web
Runtime section in the Server Manager. To export all the records from a grid in non-ActiveX mode along with the OLE
functionality set the value for Use ActiveX Controls as OLEONLY in the Web Runtime section in the Server Manager.
You can enable this option to export all records from a grid in the Google Chrome, Edge Chromium, Firefox, Internet
Explorer, and Safari browsers.

Access an application with a grid.

1. Launch an application with a grid, and then use Find to load the detail area with records.
2. From the Tools menu, click Export Grid Data.
3. On Export Assistant, select one of these options:

◦ Export to Excel

If you select this option, select if you want to export the data to a new workbook, or an existing
workbook.

◦ Export to Word

◦ Export to Comma Separated Values

4. Select Export All to export all the data in the grid, or clear the Export All check box to export a range cells within
the grid containing data that you want to export.

If you clear the Export All check box, then you must select on the grid the range of cells you want to export.
First, click the cell where you want the range to begin, then click the cell where you want the range to end.

If you click the wrong cell, click Reset Selection.
5. Click Continue.

The system exports the detail area contents that you selected to the appropriate file type and displays it.
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Importing Data from an External Spreadsheet to a Grid  
You can import data from an external spreadsheet into a grid in EnterpriseOne. The external grid must be in CSV or
Excel format. EnterpriseOne enables you to choose a range of data by entering the beginning and ending row and
column where the data resides in the spreadsheet.

(Release 9.2.5.4) To import records from an external spreadsheet into a grid in ActiveX mode in Internet Explorer set the
value for Use ActiveX Controls as TRUE in the Web Runtime section in the Server Manager.

(Release 9.2.7.2) You can import records into a grid from an external spreadsheet that contains functions, formulas,
and cell formatting. You can import your data values in the cells that are derived from formulas, functions, and cell
formatting.

To import all records from an external spreadsheet into a grid in non-ActiveX mode set the value for Use ActiveX
Controls as FALSE in the Web Runtime section in the Server Manager. To import all the records from an external
spreadsheet into a grid in non-ActiveX mode along with the OLE functionality set the value for Use ActiveX Controls as
OLEONLY in the Web Runtime section in the Server Manager. You can enable this option to import all records from an
external spreadsheet into a grid in the Google Chrome, Edge Chromium, Firefox, Internet Explorer, and Safari browsers.

Access an application with a grid.

1. From the Tools menu, choose Import.
2. Click the Import from Excel or the Import From Comma Separated Values (CSV) option.

If you choose the CSV option, the Excel file and Worksheet name options are hidden.

If you select the option to Import from Excel the file extensions XLSX and XLS are supported. For the XLS file
extension, you must use a version of Excel 97-2003 Workbook. You cannot use XML SpreadSheet 2003. Release
9.2.7.2 enables you to import records from the XLSM file extension.

3. In the Excel file field, enter the location where the external spreadsheet from which you want to import data
resides. You can also click the Browse button located beside the field and navigate to the file.

4. In the Starting Cell fields, in the Col and Row fields, enter the coordinates of the first cell in the range of cells
you want to import from the external file.

5. In the Ending Cell fields, in the Col and Row fields, enter the coordinates of the last cell in the range of cells you
want to import from the external file.

6. Click one of the following options:

◦ Insert (Import new rows at column A, row 0 of the grid): click this option if you want to add the rows you
identified to the beginning of the grid. This option does not overwrite the existing data that resides in the
grid; rather, it adds the rows to the existing data.

◦ Paste: click this option if you want to overwrite the existing data that resides in the grid. With this option,
you can paste the new rows anywhere in the existing grid. If you paste a range of data that exceeds the
existing range of data in the grid, EnterpriseOne appends the new data after the last row of the grid data.
These new rows are new, not overridden.

If you choose Paste, the Select Paste Location in Grid fields become active. Enter the first cell location
where you want to paste the data.

You can click Reset to undo your changes and to return the initial data that was in the grid when you first
entered the Import Assistant.

7. Click Apply.
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Importing and Exporting to the Clipboard  
Exporting/importing to the Clipboard is available in ActiveX mode and HTML mode. When HTML mode is enabled the
following options are removed:

• Export to Word

• Import from Excel

The clipboard functionality replaces these options when in HTML mode.

To export data to the clipboard:

1. Navigate to the Export Assistant
2. Select Export to Clipboard.
3. Define the cell range in the Export Assistant.
4. Click the Apply button.
5. Press Ctrl+C to copy the data to the clipboard.

To Import Data from the Clipboard:

1. Navigate to the source data.
2. Copy the desired data.
3. Navigate to the Import Assistant from the target application.
4. Select Import From Clipboard.
5. Define an import location.
6. Press Ctrl+V in the Import Assistant to view the data in the preview grid.
7. Click the Continue button to complete the import.

Importing and Exporting Grid Data to Microsoft
SharePoint Using Microsoft Office 365 (Release 9.2.7.3)  
Starting with Tools Release 9.2.7.3, you can import and export grid data from EnterpriseOne to Microsoft SharePoint
using Microsoft Office 365 tools.

Note:    Click here to view a tutorial of this feature.

Prerequisites  
To enable this feature in EnterpriseOne:

• Your organization must have an account with Microsoft Azure Cloud.

• You must register a client application in the Microsoft Azure Active Directory (AD). This application will enable
communication between EnterpriseOne and Microsoft SharePoint.

• You must add DigiCert Global Root G2 certificate. Access the list of root certificates in DigiCert Trusted Root
Authority Certificates page on the DigiCert website and locate DigiCert Global Root G2 certificate.
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Supported File Types  
The file types allowed for importing and exporting are XLS or CSV format.

Understanding How to Register Client Application in Microsoft
Azure AD  
For EnterpriseOne to communicate with Microsoft SharePoint, you must register a client application in Microsoft
Azure AD. The app registration generates a tenant ID, and an application (client) ID, a unique identifier assigned by the
Microsoft identity platform, which you must update while creating a softcoding record in EnterpriseOne. You must also
generate a client secret that acts as a password the application uses to authenticate user credentials with Microsoft
identity platform.

Note:  An administrator or a user with administrator privileges in Microsoft Azure AD can register the client
application.

Log in to portal.azure.com and perform the following configuration steps:

1. Select Azure Active Directory in the left menu.
2. Select App registrations.
3. Select New application registration.
4. Enter the following information:

◦ Name: Enter a name for the application. For example, JDESharePoint.

◦ Supported account types: Select Accounts in this organizational directory only.

◦ Redirect URI: This is the endpoint at which your app will receive responses from the Microsoft identity
platform. You can enter a value if your organization has a Redirect URI or leave it blank.

5. Click Register.
After successful registration, you can see the application (client) ID in the Overview pane. You must add a client secret
that will enable the app to authenticate user credentials and create a secure connection between EnterpriseOne and
Microsoft Azure AD.

1. Click Add a certificate or secret for Client credentials.
2. Click New client secret.
3. In Add a Client Secret, enter a description in the Description field. For example, ClientSecretforSharePoint.
4. In Expires field, use the drop-down to select the duration for which the client secret will be valid. You can use

the recommended settings or define a custom value.
5. Click Add.

Copy and save the populated secret string under Value. This acts as the application password for the communication
between Microsoft Azure AD and EnterpriseOne. You must update the value later while configuring the softcoding
record in EnterpriseOne.

After you have registered the client application in Microsoft Azure AD, you must configure the permissions the
application needs. Grant the following permissions:

• Application
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• Directory

• Files

• Sites

You need Administrator consent for all the above permissions. If you have admin privileges, you can use the option
Grant admin consent to provide consent for all the permissions you added. Alternatively, you must request your
administrator to grant access to the permissions.

For details on the permissions and consent, see “Introduction to permissions and consent” in Microsoft Azure AD
documentation.

Understanding How to Create Softcoding Record for Microsoft
Azure AD  
Tools Release 9.2.7.3 has a softcoding template available to enable communication between EnterpriseOne and
Microsoft Azure AD.

Note:  The option to import or export grid data to Cloud Storage is activated only when there is a softcoding record
configured and SupportActiveXIE ini setting is set to false.

See “Managing Softcoding Records” in Business Services Development Guide for details.

You must create a softcoding record based upon on the roles and access to folders in SharePoint sites. Access the Soft
Coding Records application, P954000, and enter the appropriate information in the following fields:

User/Role

Enter your JD Edwards EnterpriseOne user ID or role (such as *Public or User or Role). The access to folders available to
import and export data to in Microsoft SharePoint is based on the defined user or role.

Environment Name

Enter the name of the JD Edwards EnterpriseOne environment in which you are working.

Template Name

Enter SHAREPOINT in the Template Name field and click the Populate Soft Coding Value button. The values in the fields
for Soft Coding Value and Mask Field are populated.

Soft Coding Key

The Soft Coding Key is populated as SHAREPOINT.

Note: Instances where multiple soft coding records exist with the same Soft Coding Key, the system will consider the
soft coding record based on role hierarchy logic and ignore other records. For example, if soft coding records exist for
USER, ROLE, and *PUBLIC with the same Soft Coding Key, the system will only consider only the soft coding record for
USER.

Record Type

Use the drop-down list to select SHAREPOINT.

Soft Coding Description
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Sharepoint Template is populated in the Soft Coding Description of the record.

Soft Coding Value

The Soft Coding Value is populated after you click the Populate Soft Coding Value button that appears on the form
when you enter a valid template name. Use the below example to configure the Soft Coding Value in the template.

Enter the tenant ID that is generated after you register the application in Microsoft Azure AD in place of
DIRECTORY_OR_TENANT_ID.

Enter the Application (client) ID that is generated after you register the client application in Microsoft Azure portal in
place of CLIENT_ID.

Enter the client secret in the Masked Value field.

Enter the values for site, rootfolder, and scope.

Enter the values for redirect_uri, grant_type, use_proxy, proxy_host, and proxy_portif required.

Example:

<docs>
<endpoint>https://login.microsoftonline.com/DIRECTORY_OR_TENANT_ID/oauth2/v2.0/token</endpoint>
<username>CLIENT_ID</username>
<password>_||_client_secret_||_</password>
<properties>
<property><name>site</name><value>SITE_NAME</value></property>
<property><name>rootfolder</name><value>ROOT_FOLDERNAME</value></property>
<property><name>scope</name><value>https://graph.microsoft.com/.default</value></property>
<property><name>redirect_uri</name><value>https://localhost</value></property>
<property><name>grant_type</name><value>client_credentials</value></property>
<property><name>use_proxy</name><value>true</value></property>
<property><name>proxy_host</name><value>PROXY_SERVER</value></property>
<property><name>proxy_port</name><value>PROXY_PORT</value></property>
</properties>
</docs>

Click OK.

Exporting Grid Data to Microsoft SharePoint Using Microsoft
Office 365  

1. Launch an application with a detail area, and then click the Find button to load the detail area with records.
2. Click the Tools icon, and then click the Export Grid Data menu. Alternatively, you can click the Export Grid Data

icon in the grid.
3. On Export Assistant, select Cloud Storage.
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4. Select one of these options:

◦ Export To Excel

Use this option to export grid data to a new workbook. By default, the Excel file name is Book1.

◦ Export to an existing Workbook

Use this option to export the grid data to an existing workbook in the Microsoft SharePoint location
defined in the softcoding record. Define the Starting cell address if you want the data to be exported in a
specific cell.

◦ Export to Comma Separated Values (CSV)

Use this option to export grid data as a CSV file. By default, the CSV file name is Book1. Use the drop-
down in File Character encoding field to select the text encoding of the CSV file.

Note:  Define Cell Range option is set to All. This exports all rows and all columns. You can use the Selected
and Range options if you want to export specific grid data.

5. Click the Browse button to open the Microsoft SharePoint location defined in the softcoding record.
6. Click to select the folder where you want to export the grid data. If you are exporting the grid data to an existing

workbook, double click the folder and select the workbook in which you want to export the data.
7. Click Continue.

In Export Assistant, you can see the selected location in the Save Location field. Enter a name in the Excel file
field if you are exporting the data to a new workbook.

8. Click Continue.

Importing Grid Data from Microsoft SharePoint Using Microsoft
Office 365  

1. Access an application with a grid.
2. Click Import Grid Data icon.
3. On Import Assistant, under the Define Import File section, select Cloud Storage.
4. Select one of these options:

◦ Import from Excel

Use this option to import grid data from an XLS file. By default, Sheet1 is imported from the workbook.
Enter the specific sheet name in the Worksheet name field if you want to import data from a different
sheet.

◦ Import from Comma Separated Values (CSV)

Use this option to import the grid data from a CSV file. Use the drop-down to select the text encoding for
the CSV file.

5. Click the Browse button to access the list of folders in the Microsoft SharePoint location defined in the soft
coding record. Navigate the folders to locate the file you want to import.

6. Select the file and click Continue.
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7. In Import Assistant, enter the values for Starting Cell and Ending Cell under Define Cell Range. Use the Paste
option if you want to overwrite the existing data that resides in the grid. With this option, you can paste the new
rows anywhere in the existing grid. Enter the values for the Col and Row.

Under Define Import Location in Grid, Insert (Import new rows at column A, row 0 of the grid) is selected by
default. Use the Paste option if you want to overwrite the existing data that resides in the grid. With this option,
you can paste the new rows anywhere in the existing grid. Enter the values for the Col and Row.

8. Click Continue.
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5  Working with Records

Understanding Records  
Databases store information in units called records. Each record might contain more than one item of information. For
example, Dominique Abbott is an item of information in the EnterpriseOne system. When you access Dominique Abbott
from the Address Book application, the record that appears might also include Dominique's phone number, address,
and other pertinent information. The system might save all of this information as one record, or it might save some
of this information as a primary record and other information as secondary records. These types of relationships exist
throughout the system. Database tables store all system records. Each record must have at least one key that links the
record to a database table. Keys are unique identifiers that distinguish one record from another. For example, Address
Book uses Address Number as the key to distinguish each record. Therefore, each Address Number must be unique.
When creating new records, you must enter information into a key field. If you do not enter information into a key field,
the system displays an error message. Once you have entered information into a key field, you cannot edit that key field
later. To change the key field information, you need to create a new record. The Media Objects feature allows you to add
notes, graphics, and other objects to records.

Locating Records Using Specific Selection Criteria  
Selection criteria defines your search by specific types of records. For example, you can include information in filter
fields such as Name Search and Search Type to search only for employees whose names begin with the letter A.

1. On Work With Addresses, complete the Search Type field.

If you do not know the Search Type, use the Search button to view a list of user defined codes.
2. Click the Find button.

A list of matching records appears.

Using the Query-by-Example Line  
You can use the query-by-example line to search for records by a grid column. For example, if you are searching for a
person by name, enter all or part of the name in the query-by-example line directly above the Alpha Name column in
the grid. The information that you enter in the query-by-example line must be a valid value for the column. If it is not,
the system does not find a match. You cannot enter values in the disabled (grayed-out) columns because these columns
do not allow searches. Some query-by-example lines work differently. On some forms in the Tools setup applications,
tabbing to the end of a line after filling in one or more fields achieves the same result as clicking the Find button.

On any Find/Browse form, type the characters on which you want to search in the corresponding column of the query-
by-example line, and then click Find. For example, on Address Book Revisions (P01012), type all or part of the name of
the individual you are searching for in the Alpha Name column of the query-by-example line, and then click Find. The
record that matches the query criteria appears in the grid.
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Locating Records Using Wildcards and Operators  
You can use the asterisk (*) as a wildcard character in place of one or more letters. Using the asterisk widens your
search. For example, you can type abb* in the Alpha Name column of the query-by-example line to view all records that
begin with the letters abb. Or you can type *bb* in the query-by-example line to retrieve those records that contain the
letters bb in the middle of the name. In addition, you can search for values in a set using operators. For example, in the
Address Number column of the query-by-example line, type <87 to specify address numbers that are less than 87. Type
<b in the Alpha Name column of the query-by-example line to specify names that begin with a. The following operators
are valid in the query-by-example line:

< Less than

< = Less than or equal to

> Greater than

> = Greater than or equal to

! Not equal to

Each time that you enter values in a search, click the Find button to retrieve matching records.

Working with Search Criteria  
In addition to using QBE and wildcards to search for records, you can define additional search criteria by creating a
query. The Query control appears on Find Browse, Search/Select, and Power Browse forms that have a Find button,
unless the form appears in a popup window (such as when using the visual assist). Additionally, the Query control
appears in the Data Browser, which enables you to view the data in tables and business views and save the search
criteria as a query.

See Viewing the Data in Tables and Business Views in this guide.

Note:  The queries created using the Query control are Enhanced Queries, which differ from the Saved Queries that
users might have created in previous releases. You can convert the format of the old Saved Queries to Enhanced
Queries by using a conversion process. See "Converting Saved Queries to Enhanced Queries" in the JD Edwards
EnterpriseOne Tools Runtime Administration Guide

The query feature enables you to select additional fields from a form and add conditions to narrow the search results.
Queries enable you to create searches that are more specific than the search results from wildcards and QBE columns
alone. The system combines the conditions defined in the form filter fields, the QBE line, and the query to retrieve
records from the database.

Security options are available to prevent users from performing searches if they have not entered search criteria in
the form filters or QBE columns. If application query security has been implemented, you receive an error or warning
message that informs you that your search has been suppressed.

See "Managing Application Query Security" in the JD Edwards EnterpriseOne Tools Security Administration Guide
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If you want to search for records without using a query, set the Query field to All Records.

For more information on the Query Control and creating and managing queries, see "Queries" chapter in the JD
Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide

Choosing a Record  
You choose a record for a variety of reasons. For example, you might need to change an employee's address and phone
number. You can choose a single record or multiple records from the Find/Browse form, and then you can change the
information on a Revision form.

You can choose a record in one of two ways:

• Click the record and then click the Select button to open the corresponding form.

• Double-click a record to select it and open the corresponding form.

To choose a record:

1. On any Find/Browse form, locate a record.
2. Double-click the record to display it on a revision form.
3. On the revisions form, revise the record and then click OK.

If you selected more than one record, your second record might appear now. If your second record does not
appear, click the Next button at the top of the form. Continue to revise as needed.

4. After you finish, be sure to click OK to save your latest revision and then click Cancel to exit.

Adding a Record  
When adding records to the database, you add the primary record first and then add the secondary records.

To add a record:

1. On a Find/Browse form, click Add to open a blank revision form.
2. Enter the information for the new record.

Note:  Some fields enable you to enter any value, and some require you to select from a list of values. A
user defined code (UDC) is one value in a set of values that is assigned as valid for a field. UDCs simplify,
standardize, and validate the data that is contained in fields. See "Working with User Defined Codes" in the JD
Edwards EnterpriseOne Tools Runtime Administration Guide.

3. Click OK.

When you add records, the system uses the Next Numbers feature to automatically number Address Book
records, journal entries, purchase orders, and other documents.
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Changing a Record  
In EnterpriseOne, a Find/Browse form appears when you open most applications. On the Find/Browse form, you
choose the action that you want to perform. Choosing a button or function that you want to perform displays, for
example, a Fix/Inspect form on which you can change your record.

As you move from field to field, you view your changes reflected in the form. If you type an invalid value in a field, the
field highlights in red and an error appears. You must correct the error before you click OK. Clicking OK saves your
changes in the database.

Note:  Some fields enable you to enter any value, and some require you to select from a list of values. A user defined
code (UDC) is one value in a set of values that is assigned as valid for a field. UDCs simplify, standardize, and validate
the data that is contained in fields. See "Working with User Defined Codes" in the JD Edwards EnterpriseOne Tools
Runtime Administration Guide.

You cannot change information on the Find/Browse form itself. The information you have changed appears after you
choose the appropriate button on the Find/Browse form.

To change a record:

1. On a Find/Browse form, select a record.

You can double-click a record, or choose a record and then click the Select button.
2. On the revisions form, revise information as needed.
3. Click OK to accept the revisions.

Deleting a Record  
Occasionally, you might need to remove a record from your database. For example, you might no longer use a particular
supplier. Depending upon the application, if you delete a primary record the system might also delete any secondary
records related to the primary record, such as phone numbers. See the appropriate application guide for information
about deleting child records.

To delete a record:

1. On a Find/Browse form, select one or more records.
2. Click Delete.

The system prompts you to confirm the deletion.
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6  Work Center CafeOne Application (Release
9.2.1)

Understanding the Work Center CafeOne Application  
UX One combines the latest advancements of the JD Edwards EnterpriseOne user experience, centering around the
Alert, Analyze, Act design principles. Alert, Analyze, Act enables users to work the way they want and be more efficient.

The Work Center CafeOne application is a role-based solution that have been created and delivered across the broad
portfolio of JD Edwards EnterpriseOne products.

You use the Work Center CafeOne application to connect to the Work Center using CafeOne layouts.

JD Edwards EnterpriseOne Applications connected to the Work Center using CafeOne layouts:

• Work With Batches (P0011)

• View Job Status (P986110B)

Note:  The Work Center (P012503X) can only be use with the CafeOne Application.

Setting up Work Center (P012503X) Using CafeOne
Application  
You have different options to set up the Work Center (P012503X) with CafeOne.

1. Access the application you are going to connect to the Work Center (P012503X) through CafeOne.
2. Click the Personalize Form icon and select Edit Form Layout under Personalization.
3. Select Create Link to EnterpriseOne Application.
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4. Type P012503X in the Application field.

5. Select Dynamic Link to display Parameters Data Structure definitions and select the Parameters, Operations,
and Parameter Values.

6. Set up input variables to convey the error messages you want to display.

The following table displays different input variables setups.
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Application Report
Name

Version Exact
Match

Work
Center
Input 1

LengthJustificationWork
Center
Input 2

LengthJustificationWork
Center
Input 3

LengthJustification

P03B11Z1
 

R03B11Z1A
 

  EDUS (User
ID)
 

10
 

L
 

EDBT
(Batch
Number)
 

15
 

L
 

EDTN
(Transaction
Number)
 

22
 

L
 

P47010
 

R47011
 

 Y
 

EDOC
(Document
Number
 

n/a
 

n/a
 

      

P47040
 

R470412
 

 Y
 

EDOC
(Document
Number
 

n/a
 

n/a
 

      

P0411Z1
 

R04110ZA
 

  EDUS -
(User ID)
 

10
 

L
 

EDBT
(Batch
Number)
 

15
 

L
 

EDTN
(Transaction
Number)
 

22
 

L
 

P0911Z1
 

R09110Z
 

  EDUS (User
ID)
 

10
 

L
 

EDBT
(Batch
Number)
 

15
 

L
 

EDTN
(Transaction
Number)
 

22
 

L
 

Examples of different report setups  
• OBNM Report
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• R09801 Report

• R03B11Z1A Report
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• R47011 Report

Example on How to Set Up Input View Using the
CafeOne Application  
Access the application you are going to connect to the Work Center through CafeOne and complete the following
settings.

1. Report Name – The name of the report that was ran and created the errors the user will view.

2. Version – The version of the report that was ran. If you leave this field blank, the system uses all versions.

3. Exact Match – Valid values are blank or Y. If set this field to Y, the Work Center Input 1-8 values must match the
template value in F001131M or no records will be displayed.
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4. Work Center Input 1 – 8 – The value from the application to potentially be concatenated with other Input values
to create a string for the Template Value in F01131M.

a. P0011

b. V012503X

5. Field Length – Some of the Work Center inputs require a certain length to find the value in V012503X.
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6. Justification – Valid values are:

◦ L – Left Justified

◦ R – Right Justified

◦ Blank – No Justification

Additional Information About the Work Center CafeOne
Application Setup  

• The error for the row you selected generally displays at the bottom after the system finds the parent and the
other children to the parent.

• The system only finds 100 records at the top level from the parent. There may be more errors that are not being
displayed. The Work Center (P012503X) displays more records than the previous Work Center (P012503).

• If only the Report/Version or Report input variables are populated, the Work Center application displays an
input Date. The default date is one week back from the current week. If you change the default date, the system
uses the date until you close the browser (IE, Firefox, Chrome, and so on).

• If a Work Center Input is populated from CafeOne, then no date box displays. The system finds the most recent
records matching the input passed from the application.

• For some applications when they first start, no data is passed to the Work Center Input, so the date box displays
until you select a row. To resolve this issue, you can create a setting in CafeOne to only display if a certain
parameter is met.
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7  JD Edwards EnterpriseOne Accessibility

JD Edwards EnterpriseOne Web Client Accessibility
Compliance  
Web accessibility refers to the practice of improving access to websites for users with disabilities. JD Edwards
EnterpriseOne strives to meet W3C guidelines for accessibility in several ways. First, keyboard shortcuts (hot keys) are
provided to allow quick access to various website features, and all features are available to users without a mouse unless
specifically noted in the Voluntary Product Accessibility Template (VPAT) for this product. Second, an "accessibility
mode" can be set for a given user or role that provides additional descriptive information for users using text-to-speech
(screen reader) software.

A single HTML server port is used for both standard and visually impaired accessibility, as opposed to a separate HTML
server for visually impaired users. When the Accessibility mode is set to Yes in the User Profile Revisions application
(P0092), extra descriptive information tags are rendered so that they can be read by the screen reader software.

Enabling the Accessibility Mode Manually  
To enable the accessibility mode manually:

1. Sign In to the system with your User ID and Password.
2. On Home page, use the Tab key to select the Navigator drop-down menu.
3. Press the down arrow to select Actions.
4. Press the right arrow to view the menu options and then down arrow to select My System Options. Press the

Enter key.
5. On My System Options - User Default Revisions page, use the Tab key to select User Profile Revisions. Press the

Enter key.
6. Use the Tab key to select the Set Accessibility Mode radio button group and use the arrow keys to select "Yes"

for accessibility mode.
7. Press "Ctrl+Alt+O" (OK) to save the profile changes.
8. Sign out and sign back into the system for the profile changes to take effect.

JD Edwards EnterpriseOne Navigation Tips  
All items you can "click" on the application pages should be accessible from the keyboard without using a mouse.
Typically, you can use the Tab key can to move focus from the currently focused item to the next logical item and
you can use the arrow keys to navigate through menus. You can use the Enter key (and sometimes the Space bar) to
perform the action for the currently highlighted item, or select the current menu item.

In addition, JD Edwards EnterpriseOne provides a variety of keyboard shortcuts (or "hot keys") to assist users in
navigating through the application without a mouse. To get a full list of hot keys available, press "Ctrl+Shift+?" from any
screen, and a new window will open showing the list of available hot keys.

This table describes the most common hot keys and their functions:
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Hot Key Function

Ctrl+M
 

Moves focus to the home button at the top of the page.
 

Ctrl+Alt+O
 

OK – Usually used to submit the current form to the server.
 

Ctrl+Alt+S
 

Select – Performs the default selection action for the currently selected grid record.
 

Ctrl+Alt+L
 

Cancel/Close – Closes the current application form and usually cancels any changes that have been
made.
 

If you are using screen reader software, you will have other navigation options available. For example, using JAWS, you
can open a dialog containing a list of all links or buttons on the page and jump to a particular one. You can also use "T"
to find any tables on the page, or "H" to find headers.

JD Edwards EnterpriseOne Application Accessibility  
These components of JD Edwards EnterpriseOne applications are accessible through the screen reader software:

• Forms in JD Edwards EnterpriseOne

• Controls in JD Edwards EnterpriseOne

• Hot Keys

• Hyper Exit Menu

• Processing Indicator

• Drop-down Menu

• EnterpriseOne Pages

• Data Browser

• One View Report

• Advanced Query

• Personalize Grid

• Watchlists

• EnterpriseOne Search (Release 9.2.1.2)

• Advanced Media Objects (Release 9.2.1.2)

• Task Search (Release 9.2.1.4)

Forms in JD Edwards EnterpriseOne  
The screen reader software reads the form title when a form initially loads.

When the JD Edwards EnterpriseOne application is launched, the mouse cursor is set to the User ID field.

This table lists the details read by the screen reader software when you navigate through the log in page of JD Edwards
EnterpriseOne:
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Navigation Path Details given by the screen reader software

User ID
 

Reads as User ID edit, type in text.
 

Password
 

Reads as Password edit, type in text.
 
Note: When you enter the password, the screen reader software reads each letter as * (Star).
 

Details
 

Reads as Details link.
 

Environment
 

Reads as Environment edit, type in text.
 

Role
 

Reads as Role edit *ALL, type in text.
 

Sign In
 

Reads as Sign In button. You can press Enter to login.
 

Sign In Error
 

Reads as Sign In Error: Incorrect User ID or Password.
 

Select an Environment and Role
 

Reads as Select an Environment and Role.
 
The screen reader software reads all the available options to select the environment, role and the
description of the path code.
 

Remember my sign-in information
 

Reads as Remember my sign-in information check box not checked.
 

You have been successfully signed out
 

When you log out of the application, you will be provided with 'You have been successfully signed out'
window with the following two options if you have selected the Remember my sign-in information
option during sign-in.
 

• Sign in as the same user

• Sign in as a new user

The screen reader software reads this as You have been Successfully signed out.
 

Sign in as the same user
 

Reads as sign in as the same user radio button checked.
 

Sign in as a new user
 

Reads as sign in as a new user radio button not checked.
 

Hover forms  
You can use the links list window of the screen reader software to access the hover forms.

If the hover form is enabled for any of the fields in the form or a grid, it is displayed as a link in the links list window of
the screen reader software.

For example, if the hover form is enabled for the Item Number field in a form, it will be displayed as Item Number Hover
in the links list window. Use Up and Down arrow keys to select the hover form link of the field that you want to access.
Press Enter key to access the hover form.
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Press the Tab key to navigate through the tabs in the hover form if any. The screen reader software reads the content on
each tab of the hover form. Press Escape key to close the hover form.

Controls in JD Edwards EnterpriseOne  
The screen reader software reads the names of the controls and the associated details when you navigate to the various
form controls in the JD Edwards EnterpriseOne application.

This table lists the details read by the screen reader software when you navigate through the various form controls:

Name of the Form Control Details given by the screen reader software

Edit
 

Reads the following details:
 

• The text description of the associated label, when the edit control has an associated label.

• Required field - when the edit control is a required field.

• Errors and warnings when an error or warning is set on the edit control. The error details include
information which indicates "Error on Control" or "Warning on Control," the error "No," and the
cause and resolution for the error or warning.

• Visual assist details when the edit control is associated with a visual assist. The visual assist
details include information which indicates if the visual assist is a form interconnect, calendar,
 calculator or UTime.

• The text for the associated description, when a value entered in the edit control has an associated
description loaded onto the screen.

• The value entered in the edit control.

Push Button
 

Reads the title for the push button control. If a hot key is defined for the push button control, the
screen reader software reads the hot key information within parenthesis.
 

Check Box
 

Reads the text description of the label associated with the check box control.
 

Radio Button
 

Reads the text description of the label associated with the radio button control. When you navigate to a
radio button that is logically grouped inside a group box, the screen reader software reads the title for
the Group Box (if any) and then the text description of the label associated with the radio button.
 

Combo Box
 

Reads the text description of the label associated with the combo box control. When you navigate
through the list of items in the combo box, the screen reader software reads the text description for
each item.
 

Static Text
 

Reads the text description of the associated static text control.
 

Image
 

Reads the text description of the ALT associated with the image control.
 

Text Block
 

Reads the text description for the segment associated with the text block control.
 

Tab Control
 

Reads the following details:
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Name of the Form Control Details given by the screen reader software

• Active Tab and then the name of the tab page if you navigate to the currently active Tab page.
For example if the Versions tab is the currently active tab, the screen reader software reads it as
Active Tab: Versions.

• Tab and then the name of the tab page if you navigate to the currently inactive Tab page. For
example when you navigate to the Process tab that is inactive, the screen reader software reads it
as Tab: Process.

Note: When the Tab pages are displayed as links, you can navigate to the Tab Page links using the
screen reader software links list window.
 

Apart from the controls listed in this table, there are some additional controls in JD Edwards EnterpriseOne applications
that are accessible through the screen reader software.

The other controls include:

• Grid control

• Calendar control

• Tree control

• Extended form control (Release 9.2.2.4)

Grid Control

The screen reader software reads the associated details when you navigate through the grid in the JD Edwards
EnterpriseOne application.

The grid control is accessible as a table.

The QBE row and the column header row constitute the first two rows of the table, with the QBE row being the first row
and the column header row being the second row. When you navigate to the table, the screen reader software reads the
number of columns and rows, then the name of the grid. For example, in the Work with Addresses Grid in the P01012
application, after typing "T" to jump to the first table, the screen reader software might read "grid with 8 columns and 12
rows, Address Book Revisions - Work with Addresses QBE Row records 1-10, column 1, row 1."

Each data row is accessible using the screen reader table navigation commands (for example, CTRL+ALT+arrow keys in
JAWS), with the QBE row being the first row and the column header being the second row.

Note:  If user navigates horizontally in a grid row (including QBE row, grid header row, or grid data row), the screen
reader reads the column header for each cell the user navigates. If user navigates vertically in a grid column (including
row selector column, attachment column, or data column), the screen reader reads the row header for each cell the
user navigates.

This table lists the details read by the screen reader software when you navigate through the grid:

Navigation Path Details given by the screen reader software

QBE edit field in a QBE row
 

Reads the following details:
 

• The text description of the label for the QBE edit field which is actually the corresponding
column's header and then the text QBE. For example, for the Address Number QBE field, the
screen reader software reads it as Address Number QBE.
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Navigation Path Details given by the screen reader software

• The visual assist details, when the QBE edit field is associated with a visual assist. The visual
assist details include information which indicates if the visual assist is a form interconnect,
 calendar, calculator or UTime.

Cells in a data row
 

Reads the corresponding column header text and then the contents of the current cell.
 

Row selector check box cell in a data row
 

Reads as Checkbox checked or not checked and then reads the Row No.
 

Paper clip image
 

Reads Attachment or No Attachment, when you navigate to a paper clip image for Attachment in the
Click to search for the Attachments cell.
 

Next image
 

Reads as Next and then the name for the grid (same as the Form Title) as a suffix. Hence, if there is
more than one grid on the form, you can clearly identify the grid to which the Next image belongs. For
example, the Next image on the Work with Addresses grid, the screen reader software reads as Next:
Work with Addresses.
 

Previous image
 

Reads as Previous and then reads the name of the grid as a suffix.
 

Personalize Grid icon
 

Reads as Personalize Grid and then the name of the grid as a suffix.
 

Grid formats combo box
 

Reads as Grid Column Display and then the name of the grid as a suffix.
 

image for Export Grid Data
 

Reads as Export Grid Data (Ctrl+Shift+E) and then the name of the grid as a suffix.
 

image for Import Grid Data
 

Reads as Import Grid Data (Ctrl+Shift+I) and then the name of the grid as a suffix.
 

Restore Grid
 

Reads as Restore Grid (Alt+R) and then the name of the grid as a suffix.
 

This table lists the details read by the screen reader software when you navigate to the grid cells:

Navigation Path Details given by the screen reader software

Check Box
 

When you navigate to a grid cell that has its display style set to check box, the screen reader software
reads the corresponding Column Header text and then Check Box checked or unchecked.
 

Combo Box
 

When you navigate to a grid cell that has its display style set to combo box, the screen reader software
reads the corresponding Column Header text and then the text description of the item selected in the
combo box cell.
 

Edit Box
 

When you navigate to a grid cell that has its display style set to edit box, the screen reader software
reads the following information:
 

• The corresponding column header text.

• The value of the current cell.
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Navigation Path Details given by the screen reader software

• The error or warning details when an error or warning is set on the editable cell. The error details
include information which indicates "Error on Cell" or "Warning on Cell", the error or warning
description, and the cause and resolution for the error or warning.

• The visual assist details when the editable cell is associated with a visual assist. The visual assist
details include information which indicates if the visual assist is a form interconnect, calendar,
 calculator or UTime.

Icon
 

When you navigate to a grid cell that has its display style set to icon, the screen reader software reads
this information:
 

• The corresponding column header text.

• The value of the current cell.

• The ALT details of the <IMG> element corresponding to the icon.

Clickable Text
 

When you navigate to a grid cell that has its display style set to clickable text, the screen reader
software reads the corresponding column header text and then the data content of the current cell.
 

Calendar Control

The screen reader software reads the associated details when you navigate to the calendar controls in the JD Edwards
EnterpriseOne application.

This table lists the details read by the screen reader software when you navigate to the various calendar controls:

Navigation Path Details given by the screen reader software

Day tab
 

Reads as Active Tab: Day (Ctrl+Alt+D), when the Day tab is the currently active tab.
 

Week tab
 

Reads as Tab: Week (Ctrl+Alt+W).
 

Month tab
 

Reads as Tab: Month (Ctrl+Alt+M).
 

Add Activity button
 

Reads as Add Activity (Ctrl+Alt+A).
 

Previous link/image on the Calendar
control
 

Reads as:
 

• Previous Day (Ctrl+Alt+K), when the Day tab is the currently active tab.

• Previous Week (Ctrl+Alt+K), when the Week tab is the currently active tab.

• Previous Month (Ctrl+Alt+K), when the Month tab is the currently active tab.

Next link/image
 

Reads as:
 

• Next Day (Ctrl+Alt+Q), when the Day tab is the currently active tab.

• Next Week (Ctrl+Alt+Q), when the Week tab is the currently active tab.

• Next Month (Ctrl+Alt+Q), when the Month tab is the currently active tab.

Link for an activity added
 

Reads the text describing the activity details.
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Navigation Path Details given by the screen reader software

Calendar icon for an activity
 

Reads as Calendar Icon.
 

Previous image
 

Reads as Previous (Ctrl+Alt+K): Month Year. For example, for a Previous image on the Reference
calendar for month of June, 2017, the screen reader software reads it as Previous (Ctrl+Alt+K): June
2017.
 

Next image
 

Reads as Next (Ctrl+Alt+Q): Month Year. For example, for a Next image on the Reference calendar for
month of June, 2017, the screen reader software reads it as Next (Ctrl+Alt+Q): June 2017.
 

Calendar Week Drill image
 

Reads as Calendar Week Drill: Week No Month Year. For example, for a Calendar Week Drill image
referring to the first week of month of June, 2017 on the Reference calendar, the screen reader
software reads it as "Calendar Week Drill: Week 1. June 2017."
 
Note: The Week No can vary from 1 to 5, depending on the week the Calendar Week Drill image refers
to.
 

Day link
 

Reads the date, month, and the year details. For example, for the day link for 28 June 2017, the screen
reader software reads it as 28 June 2017.
 

Note:  For a tab that is currently active, the prefix is set as "Active Tab" while for the other tabs, the prefix is set as
"Tab."

Tree Control

The screen reader software reads the associated details when you navigate to the various tree controls in the JD
Edwards EnterpriseOne application.

The tree control is accessible as a table, where the first row in the table is the header row consisting of two columns with
the headers set as:

• Row Selector

• Tree Node Text

This table lists the details read by the screen reader software when you navigate to the Row Selector radio button in the
tree control:

Name of the Node Details given by the screen reader software

Root Node (collapsed)
 

Reads it as Tree Row Selector for Root Node, the value in the cell, and Collapsed.
 

Root Node (expanded)
 

Reads it as Tree Row Selector for Root Node, the value in the cell and Expanded.
 

Child Node at Level N (sibling collapsed)
 

Reads it as Tree Row Selector for Child Node at Level N with Sibling, the value in the cell, and Collapsed.
 

Child Node at Level N (sibling expanded)
 

Reads it as Tree Row Selector for Child Node at Level N with Sibling, the value in the cell, and
Expanded.
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Name of the Node Details given by the screen reader software

Child Node at Level N (without sibling
collapsed)
 

Reads it as Tree Row Selector for Child Node at Level N without Sibling, the value in the cell, and
Collapsed.
 

Child Node at Level N (without sibling
expanded)
 

Reads it as Tree Row Selector for Child Node at Level N without Sibling, the value in the cell, and
Expanded.
 

Leaf Node (with sibling at Level N)
 

Reads it as Tree Row Selector for Leaf Node with sibling: Level N and then the value in the cell.
 

Leaf Node (without sibling at Level N)
 

Reads it as Tree Row Selector for Leaf Node without sibling: Level N and then the value in the cell.
 

This table lists the details read by the screen reader software when you navigate to TreeNodeCell in the tree control:

Name of the Node Details given by the screen reader software

Root Node (collapsed)
 

Reads it as Root Node, the value in the cell, and collapsed.
 

Root Node (expanded)
 

Reads it as Root Node, the value in the cell and expanded.
 

Child Node at Level N (sibling collapsed)
 

Reads it as Child Node at Level N with Sibling, the value in the cell, and Collapsed. To expand use (Ctrl
+Shift+Right Arrow).
 

Child Node at Level N (sibling expanded)
 

Reads it as Child Node at Level N with Sibling, the value in the cell, and Expanded. To collapse use (Ctrl
+Shift+Left Arrow).
 

Child Node at Level N (without sibling
collapsed)
 

Reads it as Child Node at Level N without Sibling, the value in the cell, and Collapsed. To expand use
(Ctrl+Shift+Right Arrow).
 

Child Node at Level N (without sibling
expanded)
 

Reads it as Child Node at Level N without Sibling, the value in the cell, and Expanded. To collapse use
(Ctrl+Shift+Left Arrow).
 

Leaf Node (with sibling at Level N)
 

Reads it as Leaf Node with sibling: Level N: and then the value in the cell.
 

Leaf Node (without sibling at Level N)
 

Reads it as Leaf Node without sibling: Level N and then the value in the cell.
 

When you navigate to a TreeNodeCell of text type that is set with a special bitmap, along with the other details, the
screen reader software reads Special Setting for Node and the corresponding name of the image. For example, when
you navigate to a TreeNodeCell that is set with a special bitmap called Group, along with all the other details, the screen
reader software reads it as Special Setting For Node:Group.

Extended Form Control (Release 9.2.2.4)

Extended form controls that you add using the form extensions feature are accessible using the screen software reader.
You can navigate to these extended controls using the keyboard.
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Hot Keys  
When you navigate to a button, image, or icon in the hyper exit menus, EnterpriseOne Menu, grid, calendar or the tree
controls where an EnterpriseOne hot key is defined, the screen reader software reads the hot key information within
parenthesis.

Click the 'i' button on any open JD Edwards EnterpriseOne form to open the information dialog. Then click on Display
list of all hot keys to obtain the list of hot keys supported by the JD Edward EnterpriseOne software. You can also use
Ctrl+ Shift+? to open the hot keys information window.

Hyper Exit Menus  
When you navigate to a hyper exit menu, the screen reader software reads the name of the hyper exit menu. If
the hyper exit menu has a hot key defined, then the screen reader software reads the hot key information within
parentheses. Use the arrow keys to open the menu and navigate through the items.

When you navigate to a hyper exit menu that has sub-menus or items underneath it using the screen reader software
links list window, the screen reader software reads the name of the hyper exit menu and then the text corresponding
to the menu item or sub-menu. For example, when you navigate to the Refresh menu item under the Tools menu, the
screen reader software reads it as Tools: Refresh.

Processing Indicator  
When you fast path to an application from the JD Edwards EnterpriseOne Menu, as the application is in the process of
opening, the Processing Indicator text conveys the message "Opening Application". Once the application is loaded, the
Processing Indicator text conveys the message "Page loading complete".

Note:  The Processing Indicator text is accessible only until the application is loaded onto the screen.

JD Edwards EnterpriseOne Drop-down Menu
Accessibility  
The screen reader software reads the names of the links and the associated details when you navigate through the JD
Edwards EnterpriseOne Menu. All the JD Edwards EnterpriseOne menus are accessible as links using the screen reader
software's links list window.

The Ctrl+M hot key brings the focus to the drop-down menu Home link. You can use the tab key to move to other
menus, such as Favorites, Open Applications, and Reports.

Use the following navigation options in the main drop-down menu:

• Up/Down Arrow - For navigating up or down in the drop-down menu.
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• Right Arrow - Displays submenu and the focus is set to the first element.

• Left Arrow - Collapses the present submenu and the focus is set back to the parent drop-down menu.

You can use the CTRL or Shift key along with the right arrow to see the available options context menu for the folders or
tasks. Then, you can use the up/down arrow to navigate within these option. Use the Enter key to open these options.

This table lists the details read by the screen reader software for the corresponding controls or links when you navigate
through the JD Edwards EnterpriseOne Menu:

Controls/Navigation Path Details given by the screen reader software

Home
 

The screen reader software reads as Home link.
 

Drop-down menu
 

Reads as menu Name of the drop-down menu, to move through items press Up or Down arrow key.
 

Link for the Application task
 

Reads the names of the task, application, form, version and then the E1 Menu Application Task.
 

Link for the Report task
 

Reads the names of the task, application, form, version and then E1 Menu Report Task.
 

Link for the URL task
 

Reads the task name and then URL is followed by the URL name. For example, when you navigate to
a URL task link called "Test URL" that refers to the URL – http://www.yahoo.com , the screen reader
software reads as "Test URL. E1 Menu URL Task. URL Is http://www.yahoo.com".
 

Link for a Flyout task
 

Reads the task name and then E1 Menu Flyout. For example, when you navigate to the Flyout link for
the Favorites task, the screen reader software reads Favorites. E1 Menu Flyout.
 
Note. You can use the CTRL or Shift key along with the right arrow to see the available options
dialogue.
 

Link for an Action task
 

Reads the Action name followed by E1 Menu Action. For example, when you navigate to the My System
Options action link, the screen reader software reads My System Options. Application: P0085 Form:
W0085N. E1 Menu Action.
 

Link for Roles combo box
 

Reads as E1 Menu Roles.
 

Link for LearnJDE (Release 9.2.5)
 

Reads as LearnJDE.
 

Link for Preferences
 

Reads as Preferences, to move through items press Up or Down arrow.
 

Link for an Open Application
 

Reads the Application name, the number "N" which indicates that it is the Nth application that has
been launched and finally E1 Menu Open Application. For Example, when you navigate to the "Work
with Addresses" Open Application link, the screen reader software reads Work with Addresses (1). E1
Menu Open Application, where (1) indicates that "Work with Addresses" was the first application to be
launched.
 

Bread Crumbs
 

Reads as View Breadcrumbs History link.
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Note:  When you activate a Flyout link for a task and then navigate to a specific Flyout Item link under the Flyout, the
screen reader software first reads the name of the Flyout Item and then "E1 Menu Flyout Item For" followed by the
task name. For example, when you Activate the Flyout link for the "Favorites" task and then navigate to the Flyout
Item "Documentation", the screen reader software reads "Documentation. E1 Menu Flyout Item for Favorites."

Favorites Drop-down Menu Accessibility  
The screen reader software reads the Favorites drop-down menu as Favorites sub-menu. To move through items, press
the Up or Down arrow key.

When you move through the submenus in the Favorites drop-down menu, the screen reader software reads the name
of the sub-menu.

When you are in the Manage Favorites window, press the Tab key to move through the favorite tasks and folders. Press
Enter to select a favorite task or folder. Use the links list window of the screen reader software to access the Delete,
Rename, Reorganize, Move Up and Move Down buttons. Use these buttons to perform specific functions.

This table lists the details read by the screen reader software for the corresponding controls and the function of the
controls when you navigate through the Manage Favorites window.

Controls Description

Delete
 

The screen reader software reads the title of the push button control.
 
Use the Tab key to move through the tasks in the Mange Favorites window. Press Enter to select a
particular task or folder. Access the links list window of the screen reader software and then, select
Delete and press Enter to delete the Favorite task or folder. Select OK and press Enter to confirm. Select
Cancel and press Enter to cancel the delete operation.
 

Rename
 

The screen reader software reads the title of the push button control.
 
You can use the Rename button to edit the name of the user defined favorite folder or task. Use the Tab
key to move through the tasks in the Manage Favorites window. Press Enter to select a particular task
or folder. Access the links list window of the screen reader software and then, select Rename and press
Enter to enter the required name for your favorite task.
 

Move Up and Move Down
 

The screen reader software reads the title of the push button control.
 
You can use the Move Up and Move Down buttons to reorder the favorite tasks and folders. Use the
Tab key to move through the tasks in the Mange Favorites window. Press Enter to select a particular
task or folder. Access the links list window of the screen reader software and then, select Move Up and
press enter. The selected task is moved above the previously listed task or folder. Similarly, you can use
the Move Down option to move the task/folder below a particular task/folder.
 
You cannot use the Move Up option for the first task/folder listed in the Manage Favorites window.
Also, you cannot use the Move Down option for the last task/folder listed in the Manage Favorites
window.
 

Reorganize
 

The screen reader software reads the title of the push button control.
 
You can use the Reorganize button to reorganize the favorite tasks and folders. Use the Tab key to
move through the tasks in the Mange Favorites window. Press Enter to select a particular task/folder.
Access the links list window of the screen reader software and then, select Reorganize. A drop-down
window appears listing all the user defined folders. Use Up/Down arrow keys to select a user defined
folder and then, press Enter. The task will be moved into the selected user defined folder.
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Controls Description

 
The Reorganize option is not available for the user defined folders. You cannot move a user defined
folder into another user defined folder and also, you cannot move a favorite task or a favorite user
defined folder into a favorite folder.
 

JD Edwards EnterpriseOne Pages Accessibility  
The screen reader software reads the names of the fields, buttons, and links, and the associated details when you
navigate through the JD Edwards EnterpriseOne pages.

The EnterpriseOne pages are displayed as links. You can navigate to the EnterpriseOne pages links using the screen
reader software's links list window.

If there are any links (URLs) in the JD Edwards EnterpriseOne pages, they are displayed in the links list window of the
screen reader software.

This table lists the details read by the screen reader software when you navigate through the various form controls:

Navigation Path Details given by the screen reader software

Frames
 

The screen reader software reads the number of frames/pages available after you log in.
 

EnterpriseOne Pages
 

The screen reader software recognizes the EnterpriseOne pages as links. When accessed the screen
reader software reads the title and content of the EnterpriseOne page.
 

Collapse Tabs
 

Reads as Collapse. Press enter to hide the JD Edwards EnterpriseOne pages tabs.
 

Expand Tabs
 

Reads as Expand. Press enter to view the JD Edwards EnterpriseOne pages tabs.
 

Carousel  
The JD Edwards EnterpriseOne carousel provides quick access to three of the most commonly used menu items – Open
Applications, Recent Reports, and Favorites. This table lists the details read by the screen reader software when you
navigate through the carousel:

Note:  The screen reader reads slightly different text depending on whether the carousel is docked on the side or
bottom of the screen.

Navigation of the Form Control Details given by the screen reader software

Carousel Toggle bar
 

Reads as either "show carousel button" or "hide carousel button", depending on whether the carousel
is currently open or closed. You can press Enter to maximize or minimize the carousel.
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Navigation of the Form Control Details given by the screen reader software

 

Open Applications tab
 

Reads as Open applications carousel open applications link.
 

Favorites tab
 

Reads Favorites carousel favorites link.
 

Recent Reports tab
 

Reads Recent Reports carousel link.
 

Refresh
 

Reads Refresh Recent Reports carousel link.
 

Show/Hide Carousel tabs
 

Reads as Show Hide Carousel tabs.
 
You can press enter to show or hide the carousel tabs.
 

Applications in the Open Applications tab
 

If you have the Open Applications tab of the carousel open, then the links list window of the screen
reader software lists all the available open applications. The screen reader software reads the name of
the application followed by the form number. You can press enter to access the required application.
 

Applications/Reports in the Favorite tab
 

If you have the Favorites tab of the carousel open, then the links list window of the screen reader
software lists all the available favorite applications and batch versions. The screen reader software
reads the name of the application/batch version followed by the form number/report number. You can
press enter to access the required application or report.
 

Batch Versions in the Recent Reports tab
 

If you have the Batch Versions tab of the carousel open, then the links list window of the screen reader
software lists all the available batch versions. The screen reader software reads the name of the batch
version followed by the report number. You can press enter to access the required application or report.
 

Data Browser Accessibility  
The screen reader software, reads the names of the fields and the associated details when you navigate through the
Query Selector page.

This table lists the details read by the screen reader software for the corresponding fields when you navigate through
the Query Selector page:

Navigation Path Details given by the screen reader software

Personal Queries radio button
 

Reads as personal queries.
 

Select a Personal Query combo box
 

Reads the label for the combo box as queries you have created and then the text for the selected query.
 

Public Queries radio button
 

Reads as public queries.
 

Select a Public Query combo box Reads the label for the combo box as queries you have created and then the text for the selected query.
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Navigation Path Details given by the screen reader software

  

By Table radio button
 

Reads as By Table. The screen reader software also helps you to search and select tables.
 

Name Edit field to enter table name
 

Reads the label for the edit field as Table Name and then the visual assist details, the associated
description details (if any) and the pre – existing value (if any).
 

By Business View radio button
 

Reads as By Business Views. The screen reader software also helps you to search and select business
view.
 

Name Edit field to enter a business view
 

Reads the label for the edit field as Business View Name and then the visual assist details, the
associated description details (if any) and the preexisting value (if any).
 

Data Source Edit field to enter the data
source name
 

Reads the label for the edit field as Data Source and then the visual assist details and the preexisting
value (if any).
 

One View Report Accessibility  
The One View menu is available as a link in the screen reader software's links list window when you access a One View
Reporting enabled form. You can click the link to access the One View Report menu. Use the Up/Down arrows to open
the sub-menu items if any. Press the Escape key to close the One View menu.

Note:  Accessibility for One View Reporting is available only at runtime. There is no design time support.

This table lists the details read by the screen reader software for the corresponding menus when you navigate through
the One View Report menu.

Navigation Path Details given by the screen reader software

One View Menu
 

Available in the links list window of the screen reader software. The screen reader software reads it as
One View menu.
 

My Reports
 

The screen reader software reads the "My Reports" section containing all the personal reports, if there
are any, in alphabetical order.
 

Add Report
 

The screen reader software reads it as Add Report, if the user has edit permission on the form.
 

Manage Report
 

The screen reader software reads the flyout menu as Manage Report, if there is any Personal or Shared
Report.
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Advanced Query Accessibility  
The advanced query option is displayed as a link in the links list window of the screen reader software. The link is
labeled as Add, Edit Queries.

This table lists the details read by the screen reader software for the corresponding controls when you use the query
option.

Navigation Path Details given by the screen reader software

Advanced query
 

Displayed as a link in the links list window of the screen reader software. The screen reader software
reads it as Add, Edit Queries. Use Up or Down arrow to select the Add, Edit Queries link and then, press
Enter to access the Query Manager window.
 

Query Manager window
 

The screen reader software reads the title of the window; the focus is set to the Query field.
 

Name
 

The screen reader software reads it as Name Edit, to change selection use Arrow keys.
 

Set As Default
 

The screen reader software reads it as Set as Default not checked. Note. The screen reader software
reads it as Set as Default checked, if the check button is selected.
 

Run query when selected
 

The screen reader software reads it as Run query when selected checked.
 

Add
 

The fields that can be added into the query is displayed as links in the links list window. For example,
 you can use Up and Down arrows to select Add Order Number link and press Enter to add the Order
Number field to the query.
 
Note: Use Tab key, Up and Down arrows to select conditions and to enter value to your query.
 

Find
 

Find button is displayed as a link in the links list window of the screen reader software. The screen
reader software reads it as Find.
 

Remove Query
 

Remove query is displayed as the Delete Query link in the links list window of the screen reader
software.
 

Close
 

Select the link Close side panel in the links list window of the screen reader software and press Enter to
close the Query Manager window.
 

Personalize Grid Accessibility  
The Personalize Grid icon is displayed as a button in the form field list window of the screen reader software.
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This table lists the details read by the screen reader software for the corresponding controls when you use the
Personalize Grid icon to personalize the grid.

Navigation Path/Controls Details given by the screen reader software

Personalize Grid
 

Reads as Personalize Grid icon. Press enter to select.
 

Buttons
 
Create, Modify, Delete, Update Style and
Close buttons.
 
Display and Order Add All
 
Display and Order Remove All
 
Display and Order Add
 
Display and Order Remove
 
Display and Order Edit Column Name
(Release 9.2.2.4)
 
Display and Order Revert to Original
(Release 9.2.2.4)
 
Move Select Column UP
 
Move Select Column Down
 
Data Sequencing Add All
 
Data Sequencing Remove All
 
Data Sequencing Add
 
Data Sequencing Remove
 
Data Sequencing UP
 
Data Sequencing Down
 
Move Sequence Column Up
 
Move Sequence Column Down
 

Reads the title for the push button control.
 

OK and Cancel buttons
 

Reads the title for the push button control.
 
Select OK button and press Enter to save the grid format. Select Cancel and press Enter to cancel.
 

Data Sequencing Available columns
 

Reads as Data Sequencing Available columns list box, to move through items use the Arrow keys.
 
Data Sequencing Available columns is displayed as a link in the Form Field dialog of the screen reader
software.
 

Sequenced Columns
 

Reads as Sequenced Columns list box, to move through items use the Arrow keys.
 
Sequenced Columns is displayed as a link in the Form Field dialog window of the screen reader
software.
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Navigation Path/Controls Details given by the screen reader software

 

Display and Order Available columns
 

Reads as Display and Order Available columns list box, to move through items use the Arrow keys.
 
Display and Order Available columns is displayed as a link in the Form Field dialog window of the
screen reader software.
 

Display and Order
 

Reads as Display and Order list box, to move through items use the Arrow keys.
 
Display and Order is displayed as a link in the Form Field dialog window of the screen reader software.
 

Column Color
 

Reads as Column Color Edit, type in text.
 

Text Color
 

Reads as Text Color Edit, type in text.
 

Column Width
 

Reads as Column Width Edit, type in text.
 

Check boxes - Bold, Italic, Underline,
StrikeOut.
 

Reads the title of the check box, and also reads if the check box is checked or unchecked.
 

Watchlists Accessibility  
One View Watchlists represent collections of items that match user-defined criteria. They enable users to define
information to which they would like to be alerted.

See  JD Edwards EnterpriseOne Applications One View Watchlists Implementation Guide .

These components of JD Edwards EnterpriseOne Watchlists are accessible through the screen reader software:

• Watchlist Management window

• Watchlists drop-down menu

Note:  When you create a watchlist item in the Data Browser, the Data Browser cannot be launched from the Watchlist
drop-down menu, EnterpriseOne pages or Composed EnterpriseOne Pages.

Accessibility for Watchlist Management Window  
The Watchlist Management window is used to add, edit, share, or delete watchlists.

Note:  You must login to the JD Edwards Enterprise One web client with a User ID that has the right to create, share
and view Watchlists.

Use the Ctrl+Y hot key to open or close the Watchlist Management window when inside the main application frame.
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You can also use the links list window of the screen reader software to access the Add, Edit Watchlists link to open the
Watchlist Management window. Ensure that the application you use has an Advanced Query created.

Use the Tab key to focus on the required fields in the Watchlists Management window. The screen reader software reads
the label and value (if there is any) of the fields.

This table lists the details read by the screen reader software when you navigate through the Watchlist Management
window.

Navigation Path/Controls Details

Name
 

The screen reader software reads the title of the field.
 
In the Watchlist Name combo box, private watchlists created by the user is displayed under My
Watchlists section. The published watchlists assigned to the user are displayed under a Shared
Watchlists section and shared watchlists reserved by the user is displayed under a Reserved Watchlists
section.
 

My Watchlists section
 

When you navigate to the first or last watchlist in the My Watchlists section, the screen reader software
reads as Alert My Watchlists followed by the watchlist name to specify that it is the beginning of the My
Watchlists section.
 

Reserved Watchlists section
 

When you navigate to the first watchlist in the Reserved Watchlists section, the screen reader software
reads as Alert Reserved Watchlists (Reserved by the User ID) followed by the watchlist name to specify
that it is the beginning of the Reserved Watchlists section.
 

Shared Watchlists section
 

When you navigate to the first watchlist in the Shared Watchlists section, the screen reader software
reads as Alert Shared Watchlists followed by the watchlist name to specify that it is the beginning of
the Shared Watchlists section.
 
When you navigate to any Reserved Watchlist or a Shared Watchlist that has also been reserved,
 the screen reader software reads as Alert Reserved by the User ID followed by the watchlist name to
identify to the user that the watchlist has been reserved by the specific user.
 

Watchlist Description
 

The screen reader software reads the name of the field.
 

Warning Threshold
 

The screen reader software reads the name of the field.
 

Critical Threshold
 

The screen reader software reads the name of the field.
 

Advanced Options Link
 

Use the tab key to navigate to the Advanced Options link and press the Enter key to expand it and
display the fields under it.
 
After expanding the Advanced Options link, use the Tab key to access Refresh Interval and Max
Records to Return fields. You can also use the links list Window of the screen reader software to
activate the Advanced Options link and display the fields under it. To collapse the Advanced Options
link, use the Tab key to set the focus on the Advanced Options link and then, press Enter.
 

Query to be used
 

Use this combo box to select the Advanced Query over which the watchlist is to be created.
 
Use Up or Down arrow keys to navigate through the Advanced Query values and after selecting a
value, the details of the query is loaded into the Query Details group box. Use the Tab key to set focus
on the Query Details group box that has the complete details of the Advanced Query.
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Navigation Path/Controls Details

Use the Tab key to set the focus on Match all of the following or Match any of the following text and the
screen reader software will read the text.
 
Use the Tab key to set the focus on the first Query condition. The screen reader software will read the
Query condition. Use the Tab key to move to the next query condition.
 

Save Watchlist
 

Use the links list window of the screen reader software to access this link.
 

Save Watchlist As
 

Use the links list window of the screen reader software to access this link.
 

Publish Watchlist
 

Use the links list window of the screen reader software to access this link.
 

Reserve Watchlist
 

Use the links list window of the screen reader software to access this link.
 

Delete Watchlist
 

Use the links list window of the screen reader software to access this link.
 

About Watchlist
 

Use the links list window of the screen reader software to access this link.
 

Close Side Panel
 

Use the links list window of the screen reader software to access this link.
 

Validation errors or errors returned from
the server
 

The screen reader software reads these error messages as Alert followed by the appropriate error
message.
 
Use the Tab key to navigate through the fields. When the focus is set on the field that contains an error,
 the screen reader software reads the name of the field and it's value as Invalid Entry to indicate that it
is an error field.
 

Creating a new watchlist
 

When you are creating a new watchlist using the Save Watchlist/Save Watchlist As link or Publishing a
Watchlist using the Publish Watchlist link, an Enter New Watchlist Name window is displayed.
 
This window has a text field to enter the new watchlist name and an OK button to Save/Publish the
Watchlist.
 
You can use the Tab key to shift focus from the text field to the OK button. Press Enter key to select the
OK button.
 
Use the links list window of the screen reader software to select Close option to close the Watchlist
Name window.
 

Accessibility for Watchlists Drop-down Menu  
The screen reader software, reads the names of the links and the associated details when you navigate through the
Watchlists drop-down menu.

Note:  When you create a Watchlist item in the Data Browser, the Data Browser cannot be launched from the Watchlist
drop-down menu, EnterpriseOne pages or Composed EnterpriseOne pages. (Release 9.2.1)
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Use the Alt+W hot key to navigate to the Watchlists drop-down menu. The screen reader software reads as Watchlists
Sub-menu. You can also use Ctrl+M hot key to first navigate to the Home Link and then use the Tab key to navigate to
the Watchlists drop-down menu. Use the Down Arrow key to expand the Watchlists drop-down menu.

In the Watchlists drop-down menu there may be three sections.

1. Private Watchlists - These are created by the user and are displayed under My Watchlists section heading.
2. Shared Watchlists - These are the published Watchlists that are assigned to the user and are displayed under

Shared Watchlists section heading.
3. Reserved Watchlists - These are the published Watchlists that are reserved by the user and are displayed under

the Reserved Watchlists section heading.
Use the Down and Up Arrow keys to navigate through the individual Watchlist items and section headings such as My
Watchlists, Reserved Watchlists and Shared Watchlists.

This table lists the details read by the screen reader software when you navigate through the Watchlist drop-down
menu.

Navigation Path/Controls Details

My Watchlists section heading in the
Watchlists drop-down menu
 

The screen reader software reads as My Watchlists Sub-menu.
 

Reserved Watchlists section heading in the
Watchlists drop-down menu.
 

The screen reader software reads as My Watchlists Sub-menu.
 

Shared Watchlists section heading in the
Watchlists drop-down menu.
 

The screen reader software reads as My Watchlists Sub-menu.
 

Refresh Watchlist Control
 

When you are on a section heading, use the Down Arrow key to navigate to the Refresh Watchlist
Control.
 
The screen reader software reads the appropriate status for the Refresh Watchlist Control followed by
the watchlist name. Status for the Refresh Watchlist Control can be any one of the following:
 

• Update in progress for.

• Update pending, followed by Refresh.

• Update failed, followed by Refresh.

• Update interrupted, followed by Refresh.

• Time since last update, followed by the elapsed time, and then Refresh.

Refresh Watchlist Control
 

Use the Enter key to refresh the Watchlist count. After the refresh is completed, the focus will be set
back to the Refresh Watchlist Control.
 
Use the Down Arrow key to navigate to a watchlist item. The screen reader software reads the watchlist
name and the count of the records returned by the Advanced Query.
 
When the focus is set to the watchlist item, if the count for that watchlist is greater than or equal to the
Critical Threshold then, apart from reading the watchlist name and count, the screen reader software
also reads 'Count is greater than or equal to Critical Threshold'.
 
When the focus is set to the watchlist item, if the count for that watchlist is greater than or equal to the
Warning Threshold then apart from reading the watchlist name and count, the screen reader software
also reads 'Count is greater than or equal to Warning Threshold.'
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Navigation Path/Controls Details

Watchlist item
 

When the focus is set to the watchlist item, use the Enter key to launch the Enterprise One application
that has the Advanced Query and over which the Watchlist is created.
 

Close
 

Use the Esc key to close the Watchlists drop-down menu.
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8  JD Edwards Web Applications and Reports

Launching Applications and Reports  
JD Edwards provides a variety of applications, reports, and other objects. Typically, you access these objects from the
EnterpriseOne Menu.

Launching an Application or Report  
Access EnterpriseOne Menu.

1. In EnterpriseOne Menu, navigate to the application or report you want to launch.
2. To launch the application or report without defining processing options, version, and so forth, double-click the

report or application.

Applications launch immediately. If you launch a report the system launches Work with Batch Versions so you
can select which version you want to run.

3. To select processing options or version for an application, right-click and select Values or Versions, respectively.

(Release 9.2.5.3) After you select the processing options or version, the system launches the application in the
same browser window. You can run multiple applications simultaneously. All the applications that are running
are listed in the EnterpriseOne Menu under Open Applications toward the top of the page. You can switch
among the applications by clicking any application in the list.

4. To select processing options or version or to designate data selection parameters for a report, right-click and
select one of these options:

◦ Values

◦ Versions

◦ Data Selection

◦ Data Selection & Values

After you set the options, the system might launch Work with Batch Versions so you can select which
version you want to run. Then, the Version Prompting form appears. Select the prompting you want and
click Submit to select a printer and process the report.

Launching Applications in Separate Windows  
When you open more than one application, you can select to have the application launch in the existing window, or in a
new window. If you select to have it launch in the existing window, JD Edwards EnterpriseOne replaces the application
on which you are currently working with the application that you have just launched. If you select to launch additional
applications in new windows, then each application appears and is fully functional in its own window.

To launch applications in new windows:

1. Navigate to the task from the Navigator drop-down menu.
2. Right click on the task and select Open in New Window from the context menu.
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Note:  Access Preferences window from the Personalization menu and select Open Application In New Window check
box to open all the application that are launched in a new window.

Viewing Report Output  
Access the Personalization menu. 

Before you can view the output of your reports online, you must run a report version.

1. From the Personalization drop-down menu, select My System Options.
2. On User Default Revisions, click Submitted Reports.
3. On Work with Servers, select the server on which the report was run.
4. Click Select.
5. On Submitted Job Search, select the report you want to view.
6. From the Row menu, click View PDF.

The report appears in read-only, PDF format.

To view report data on pages other than the one currently displayed, type a page number in the field located at
the bottom of the PDF viewer.

JD Edwards EnterpriseOne contains a feature called Page at a Time PDF that assists in downloading large files
quickly. If your system administrator has enabled this feature, you should immediately see the first page of the
PDF file. If Page at a Time is not enabled, you will see a blank screen in the PDF viewer while the file downloads.
If this is the case, contact your system administrator.

Changing your Password  
Access the Personalization menu.

1. From the Personalization drop-down menu, select My System Options.
2. On User Default Revisions, click Change Password.
3. On User Password Revisions, complete the following fields and click OK:

◦ Old Password

◦ New Password

◦ New Password - Verify

Sending a Shortcut to an Application Form  
While you are working in the JD Edwards EnterpriseOne web client, you can email other users a shortcut to the
application and form that you are looking at. The recipient double-clicks the shortcut in the email to access your current
position in the software.

To send a shortcut to an application form:

1. Launch a JD Edwards EnterpriseOne application and access the form that you want to send.
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2. Click Tools and select Send Shortcut.
3. On Send Shortcut, complete these fields:

◦ Address Number / User / Role / Distribution List

Note:  If you are sending a shortcut to members of a distribution list, you must click the Distribution
List option and then select the address book number of the distribution list. If you enter the
distribution-list address-book number without choosing the Distribution List option, the shortcut will
be sent only to the distribution-list address-book number and not to the members of the distribution
list.

◦ Mail Box

Select which mailbox/queue you want the message to be sent to.

◦ Subject

Type the text that you want to appear in the Subject line of the email message.
4. If you want to include a message with the shortcut, type it in the large field at the bottom of the form.
5. Click OK to send the shortcut.

The recipient will receive the shortcut using an email in the Work Center or a third-party email system,
depending on the recipient's email preferences in JD Edwards EnterpriseOne.

Viewing the Data in Tables and Business Views  
If you want to view the data in tables and business views, you can use Data Browser. This tool enables you to verify the
existence of data in a table or business view, as well as to determine the table or business view structure.

Release 9.2.3

If a table or business view contains a BLOB, the Repository BLOB column appears in the grid on the Data Browser
search form. Click on the icon in the Repository BLOB column to view the content as a string. This can be helpful for
troubleshooting purposes.

Accessing Data Browser  
Type databrowser in the Fast Path. If you type databrowser in the Fast Path, the Query Selector form appears. If you
are in an application, you can access the Data Browser by clicking the Tools menu, and then clicking Data Browser. If
you access the Data Browser from an application, the Query Selector and the Data Browser forms appear. The Query
Selector form enables you to select queries, tables, or business views to search for data. The Data Browser form enables
you to search for data for a specific table or business view. When you access Data Browser from an application, the only
tables and business views on which you can search are those that correspond to the application you are in.

Searching for Data in Tables  
Access the Data Browser.

1. Type databrowser in the Fast Path.
2. Select the By Table option.
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3. In the Name field located under the By Table option, type the name of the table on which you want to search, or
use the Search button to locate a table.

4. Press Tab.

The Data Source field automatically displays the name of the data source in which the table resides for the
environment that you are logged into.

5. In the Data Source field, if the data source that is displayed is different than the one from which you want to
search, type a new data source, or use the search button to locate a data source.

6. Click OK.

The Data Browser search form appears for the table you specified.
7. Use form filter fields, QBE columns, and Query control to locate data; if desired, save the query for future use.

See Also "Queries" in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide

Searching for Data in Business Views  
Access the Data Browser.

1. Type databrowser in the Fast Path.
2. Select the By Business View option.
3. In the Name field, type the name of the business view on which you want to search, or use the search button to

locate a business view.
4. Click OK.

The Data Browser search form appears for the business view you specified.
5. Use form filter fields, QBE columns, and the Query control to locate records; if desired, save the query for future

use.
See Also "Queries" in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide

Using Existing Queries to Search for Data in Tables and Business
Views  
Access the Data Browser.

1. Select the Personal Queries or Public Queries option.

The Personal Queries option enables you to select queries you have created for yourself from a drop-down
menu. The Public Queries option enables you to choose from a drop-down menu queries that have been made
available to you by a system administrator.

2. From the drop-down menu located next to the option you selected, select the query on which you want to
search.

3. Click OK.
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Creating Personal Search Queries to Search for Data in Tables and
Business Views  
Access the Data Browser.

1. Follow the instructions for searching for data in tables or searching for data in business views in the previous
sections.

2. On Data Browser, use the Query control to design a query.

See "Queries" in the JD Edwards EnterpriseOne Tools Using and Approving User Defined Objects Guide .
3. Click the Find button in the Query Manager side panel or on the form to run the query.
4. If you want to save the query, click the Save Query icon in the Query Manager side panel.
5. Enter a name for the query.

The new query name appears in the Query field.
6. Close the Query Manager side panel.

The new query name appears in the Query field on the form. To find records without using a query, you must
reset the Query field to All Records.

Note:  The queries created using the Query control are Enhanced Queries, which differ from the Saved Queries that
users might have created in previous releases. You can convert the format of the old Saved Queries to Enhanced
Queries by using a conversion process. See "Converting Saved Queries to Enhanced Queries" in the JD Edwards
EnterpriseOne Tools Runtime Administration Guide.

Viewing Table Definition  
You can view table definition and data dictionary detail from a web client using Table Definition Inquiry (P90U100). You
can view the data item glossary by selecting a record and clicking View Glossary from the Row menu.

Access Table Definition Inquire:

1. From the Navigator menu, EnterpriseOne Menus, EnterpriseOne Life Cycle Tools, Application Development,
Table Definition Inquiry

2. Enter a table (fxxxx) in the Table Name field..
3. Click the Search button on the tool bar.

Recovering Data  
This section provides an overview of how to recover data and discusses how to:

• Retrieve all records from the database.

• Voluntarily save data.

• Retrieve data.
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• View data.

Understanding how to Recover Data  
You use JD Edwards EnterpriseOne web client to recover data from applications that have erred or timed out due to:

• Catastrophic errors

• Transaction failures

• Session time outs

• Voluntary save

Data saved from system failures is saved at the moment when the system errors, failures, or time outs occur. The
Application Failure Recovery Applications program (P95400) enables you to access and recover data from any
transaction from which you have saved data. Using P95400, you can view the data from failed transactions. You must
be granted permission by an administrator to view data from applications that are not your own. For example, an
administrator might give a sales department supervisor the permission to recover data from transactions performed by
other users in the department. If you are unable to save data, check with your system administrator.

Retrieving All Records from the Database  
Fetch All Records enables you to retrieve all records from the database that match your search criteria. JD Edwards
EnterpriseOne then categorizes the records into larger groups so that you are able to view several records by scrolling
through the grid, rather than having to view only ten at a time. The default number of records in a group is 200.

To fetch all records, click the Go to End button located on the blue bar on the grid.

Voluntarily Saving Data  
Your ability to save data voluntarily depends on whether or not your system administrator has this feature enabled or
disabled. Access an application in which you have entered data.

1. Click Tools, then select one of these options:

Save

Save As
2. On Select Application Failure Header Label, select the check box if you want the JD Edwards EnterpriseOne to

assign a label to the data you are saving. To manually enter a label and description, clear the box and enter a
label and description in the respective fields.

Note:  The label is a name you assign the data, like a filename. The description is a brief explanation that
helps you identify what the data is.

3. Click OK.

JD Edwards EnterpriseOne saves the data you have entered in the application.
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Retrieving Data  
The Failure Recovery Data and Application Saved Data links on the JD Edwards EnterpriseOne Menu opens the P95400
application.

Access the P95400 application.

1. On Work with Application Failure Records, search for data using these criteria:

From Saved Date and To Saved Date

Type the dates between which the data for which you are searching was saved.

If you select one of the following options in addition to the dates you have entered in these fields, JD Edwards
EnterpriseOne retrieves the data saved within the dates, and that matches the search criteria you specify.

View All

Click this option to view all of the data that was saved, including system failures, time outs, or voluntary saves.

View Failures

Click this option to view only that data that was saved due to system failure.

View Saves

Click this option to view only that data that was saved voluntarily.

View Timeouts

Click this option to view only that data that was saved because the system timed out.
2. Click Find.

JD Edwards EnterpriseOne retrieves the data that matches the search criteria you entered.
3. Click the record that contains the data you want to save.

On Saved Application Data, click the record or records containing the data you want to view.

Note:  Each record is a form within the application where data was saved. If no data was saved on the form,
either because it was not saved voluntarily or because there was no data added to it (for example, Search/
Browse form), you will see an N in the Data Saved (Y/N) column.

Viewing Data  
After you have retrieved data, you view the information contained in the records.

1. Retrieve the data you want to view.
2. Select a record from the bottom grid, and then click View Data.

The information contained in the record displays in a read-only format.
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Working with Tasks, User Options, and the Calendar  
The section discusses how to:

• Filter tasks by role.

• Use task profiles.

• Work with user options.

• Access the calendar.

Filtering Tasks by Role  
You filter the tasks that you see by selecting a role. Each role contains its own set of tasks. When you log into JD
Edwards EnterpriseOne using the *ALL role, you see only those tasks associated with a single role rather than a
concatenation of all tasks associated with all roles.

In the web client, you view the other roles assigned to you by choosing the role from the Role drop-down menu located
on EnterpriseOne Menu, and then clicking the button to the right of the field.

The tree view changes to show the tasks that are available to the role that you chose.

Using Task Profiles  
For each task, you can view profile information about the task itself. To display the profile for a task, click the triangle to
the right of the task and select Task Profile.

The Task Profiles window has three tabs: Basic, Intermediate, and Advanced. The information in the window varies
based on the item currently selected. Some of the information on the tabs is described below:

• Version resides on the Intermediate tab.

• Object Name resides on the Intermediate tab.

• Task ID resides on the Advanced tab. If you know an object's task ID, you can launch it directly from the Fast
Path toolbar.

Working with User Options  
When you click My System Options, the User Default Revisions form appears. The following list describes the associated
action for each button on the User Default Revisions form:

Button Description

User Profile Revisions
 

Launches the User Profile Revisions program (P0092). Only system administrators should change user
profiles.
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Button Description

Change Password
 

Launches the JD Edwards EnterpriseOne Security program (P98OWSEC), which you use to change
your password.
 

Submitted Reports
 

Launches the Work With Servers program (P986116), which you can use to review the status of a
submitted report or job, change your report or job priority, work with the report output, and review
errors.
 

Set Default Printer
 

Launches the Printer Application program (P98616). Only system administrators should change default
printer settings.
 

Accessing the Calendar  
The calendar enables you to enter and view time sensitive information, such has meetings and appointments.
Depending on the permissions your system administrator has assigned you, you can view, add, delete, and modify
activities listed in the calendar. You can view the calendar one day at a time, by the week, or by the month. Your system
administrator determines the calendar view that you see.

This section discusses the default features and functionality that are available in the calendar. You might not see some
of these features or might not be able to perform some functions due to your permissions. The default view for the
calendar consists of one large calendar on the left with a Day tab, a Week tab, and a Month tab. Three small calendars
are located on the right side. The first small calendar shows the month previous to the month displayed in the large
calendar. The second calendar shows the month displayed in the large calendar. The third calendar shows the month
following the month displayed in the large calendar. Today's date is highlighted in a yellow box in the appropriate small
calendar.

The large calendar and the three small calendars are fully interactive. Clicking in any calendar automatically adjusts the
other calendars. For example, if you select a week in the large calendar, the week will be selected in the corresponding
small calendar as well.

You can double click in the large calendar to add an activity, if you have appropriate permissions. If you are adding
an activity on the Day tab, double clicking on a time line automatically assigns a 30 minute time slot, which you can
change. Clicking on the time located at the beginning of the line automatically assigns a 1 hour time slot, which you can
change as well. If you your calendar displays an activity that exceeds 24 hours, the activity displays in the All Day row at
the top of the large calendar. The calendar automatically adjusts across time zones. For example, if someone schedules
a meeting for 8:00 a.m. Pacific time, the activity will appear at 10:00 a.m. Central time.

To access the calendar, type P01311 in the Fast Path.
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9  Messages and Queues

Messages and Queues Overview  
With JD Edwards EnterpriseOne, you can send and receive messages through the Work Center program. The JD
Edwards EnterpriseOne Work Center includes messages sent by users and messages sent by a workflow process.

You can organize your messages by placing them into queues (storage areas for your messages) provided by the
software or by setting up your own queues. This section explains how to work with your messages and with your
queues. In addition, you can indicate your work-time location and add remarks to your time log.

Internal and External Messages  
JD Edwards EnterpriseOne sends your messages in different ways, depending upon whether the message is internal or
external to the system.

Messages Description

Internal Messages
 

Internal messages stay within the JD Edwards EnterpriseOne system. They are read using the Work
Center.
 

External Messages
 

External messages are sent to third-party email software packages such as Microsoft Outlook or Lotus
Notes.
 

You system administrator configures your JD Edwards EnterpriseOne user account to receive either internal or external
messages. However, certain messages are sent as internal messages regardless of this preference; for example,
notifications of submitted UBE jobs.

Workflow Messages  
In addition to sending and receiving internal and external messages, you can receive an active message, which is a type
of message that a system workflow process automatically sends to a recipient.

Messages Description

Active Messages
 

Workflow processes sometimes generate messages that require you to take action, such as approving
or rejecting a change to a customer record. A lightning bolt button identifies an active message.
 
Active messages contain a shortcut button that links directly to an application. When you click the
shortcut button, the system retrieves the most current information from the database, which ensures
that you get accurate information even if changes are made after an active message is sent to you.
 
You can set up a workflow process to send active messages to specific queues.
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Note:    Click here to view a recording of this feature.

Queues  
Queues are storage areas that enable you to organize messages using the Work Center. For example, messages can
be organized into queues for priority mail or for submitted jobs. Through a queue, users can approve or reject specific
tasks in a workflow process. A queue is actually a UDC, and you set up a queue in the same way that you would set up a
UDC.

Queues Provided with JD Edwards EnterpriseOne  
JD Edwards EnterpriseOne provides these queues:

Queues Description

Sent
 

Messages that you have sent to others.
 

Deleted
 

Messages that you have deleted. After you delete a message, you can view it but you cannot move it to
another queue.
 
The system administrator has the authority to purge deleted messages from the system, which is
typically done periodically or on a predetermined schedule. You can also remove a message from the
system by deleting it from your Deleted queue.
 

Submitted Jobs
 

Messages generated by the system for jobs that you have submitted for batch processing, such as the
General Ledger Post.
 

Workflow Queues  
Workflow includes several predefined queues, but you might want to set up a custom queue for messages generated
by processes that you create. For example, you might want to set up a queue for messages generated by a credit limit
approval process. This queue would gather any approval or rejection messages related to credit limits for customers. A
user could then open that queue and act on the message contained within it.

Working with Messages  
This section contains the following topics:

• Sending Messages

• Using Shortcuts

• Using the Work Center

• Printing Messages

• Using the Message Center (Release 9.2.3)
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Sending Messages  
When you send internal e-mail messages, you send them to other users within JD Edwards EnterpriseOne software.
You can control the time of delivery for a message by assigning a tickler date to the message. A tickler date is a date in
the future when the system automatically shows the message. Assigning a tickler date is especially helpful if you plan
to be out of the office on the day that you want others to receive your message, or if you want to remind yourself about
upcoming meetings or other obligations.

When you send internal messages, you can also include an attachment. Attachments enable you to include files,
images, or links that conform to the OLE standard, such as word processing documents and spreadsheets.

You can send messages to one or more recipients. If you are sending a message to multiple recipients, you can use a
quick list, a predefined distribution list, or a role.

Sending an Internal Message to a Single Recipient  
1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On the Work with Work Center form, select New Message.
3. On Send Internal Mail, click the Search button in the "To: Address Number/ User/ Role" field.
4. On Address Number / User / Role, select one of the following options to search for a recipient by address

number or user ID, and then click OK:

◦ Address Number

◦ User

5. Find and select the address number or user to whom you want to send the message.
6. Type the subject of the message in the Subject field.
7. Complete the following optional fields, as necessary:

◦ Keep Copy

◦ Receipt Notify

◦ Contact

◦ Address

◦ Tickler Date

◦ Phone Number

8. Type your message in the text area at the bottom of the form.
9. To include an attachment with your message, right-click the panel with the Text button.

10. Choose New, and then one of these options:

◦ Image

◦ OLE

◦ Shortcut

◦ URL/File

11. Click OK to send the message.

If you opt to keep a copy of a message that you send, you can view it in the same queue from which you sent
the message.
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Using a Quick List to Send a Message to Multiple Recipients  
1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On the Work with Work Center form, select New Message.
3. On Send Internal Mail, select To:Quick List from the Form menu.
4. On Quick List, complete either of the following fields for each person you want on the list, and then click OK:

◦ Alpha Name

◦ Address Number

5. Follow the steps for sending an internal message to a single recipient.

Note:  You cannot save a quick list.

Sending a Message to Members of a Role  
1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On the Work with Work Center form, select New Message.
3. On Send Internal Mail, click the Search button in the "Send To Address Number / User / Role" field.
4. On Address Number / User / Role, select the Role option, and then click OK.
5. Highlight the row that contains the role that you want to use and then click Select.
6. Follow the steps for sending an internal message to a single recipient.

Using Shortcuts  
With the JD Edwards EnterpriseOne messaging system, you can send messages that contain a shortcut to a JD Edwards
EnterpriseOne application. When you send a shortcut, you can preface it with a message for the recipient to review and
approve. For example, you might want your manager to approve a change that you made to a customer record. After
sending a shortcut to your manager, he or she can view the record immediately by clicking the shortcut button. When
you send a shortcut, the system sends the key for that particular record to the recipient. When the recipient clicks the
shortcut button, the system opens the application and retrieves the record.

The JD Edwards EnterpriseOne system uses workflow to automatically send messages with a shortcut to an application.
These types of messages, called active messages, require that the recipient open the shortcut to verify information or
approve a transaction.

Since JD Edwards EnterpriseOne software supports Windows and Web clients, the message can contain a shortcut for a
Windows application or a Web application.

Sending a Non-Workflow Shortcut  
From the application from which you want to create a shortcut, access any records you want the recipient to view.   

1. Open the Tools drop-down menu and select Send Shortcut.

The Send Shortcut form appears with a shortcut to the application.
2. On Send Shortcut, complete these fields:

◦ Address Number, User, Role, or Distribution List

◦ Mail Box (Internal Messages Only)

◦ Subject
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3. Type your message.
4. Click OK to send the message.

Using the Work Center  
Use the Work Center to send and receive internal messages within the JD Edwards EnterpriseOne system. Work Center
enables you to perform standard email functions.     

Viewing Messages  
You can view your messages in the Work Center. Messages sent from other users will appear in either your Personal In
Basket queue or, if you set them up, your Priority Mail and Secondary queues. You can also view workflow messages, or
active messages, sent by a workflow process.

Note:  If you cannot view messages, make sure that queue security is set up to enable you to view the Address Book
number and queue that you want to view.

To view messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, expand a queue that contains a message.

Unless the All Queues check box is selected, only those queues that contain mail will display. Any messages in
that queue appear. Messages that have not been viewed appear in bold.

3. Click the message that you want to view.
The message appears in the view area on the right side of the Work Center form.

Revising Messages  
You can revise the text of messages in any of your queues. This feature opens up the actual message and enables you
to change the text or add new text.

To revise messages:.

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, select the message that you want to revise.
3. From the Row menu, select Message Revisions.
4. On the Message Revisions form, change any of the following fields and then click OK:

◦ From

◦ Contact

◦ Subject

◦ Phone Number

◦ Tickler Date

◦ Text area

Moving a Message to Another Queue  
You can move a message from one queue to another. For example, you might want to move a message from your
Priority queue to your Personal To Do List queue.
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To move a message to another queue:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, click the All Queues option if the target queue to which you want to move the message does

not appear.
3. Click and drag the message to the target queue.
4. To verify the placement of the message, double-click the target queue and view the contents.

Redirecting Messages to the Priority or Secondary Queue  
You can redirect messages that you receive from an individual to your Priority Mail queue. When you do this, the
system sends all future messages from that individual directly to your Priority Mail queue. Alternatively, you can redirect
messages from an individual to your Secondary queue.

Note:  To redirect messages to the Priority Mail or Secondary queue, you must follow these steps and not the ones for
moving messages. Moving messages only moves individual messages, whereas redirecting messages to the Priority
Mail or Secondary queue affects all messages from that user until you remove the designation. Although you can
move a message to the Archived or Deleted queue, the system does not redirect future messages from the sender to
that queue. You must manually move the sender's message to the Archived or Deleted queue each time.

You can redirect messages from more than one person to your Priority Mail and Secondary queues. You can also
prevent messages from being delivered to a specific queue.

To redirect messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, select the message that you want to redirect to your Priority Mail or Secondary queue.
3. From the Row menu, select one of these options:

◦ Priority

◦ Secondary

4. Expand the target queue to verify the placement of your message.

Any further messages that you receive from this sender will arrive in the queue that you selected. Repeat these
steps for redirecting other users' messages.

Canceling the Delivery of Messages  
If you decide that you no longer want the system to automatically redirect messages from an individual to a Priority Mail
queue, you can cancel the automatic delivery of messages to your Priority Mail or Secondary queue.

To cancel the delivery of messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, select a message from the user for which you want to cancel automatic delivery.
3. From the Row menu, select Remove.
4. Move any other messages from this particular sender out of the Priority Mail or Secondary queue.

As long as you keep any messages in your Priority Mail or Secondary queue from the sender whom you
removed, future messages from that sender will appear in that queue.

Reassigning Messages  
The messaging system enables you to reassign a message to another user after the message is sent to the original
recipient. This process changes whose queue the message appears in. For example, if you originally sent a message to
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Jim, you can reassign that message to Betty. The message will now be in Betty's queue and will not be in Jim's queue.
You can also reassign messages that you receive.

Note:  You can only reassign messages in other users' queues if your queue security enables.

To reassign messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, select the message that you want to reassign, and then, from the Row menu, select Reassign.
3. On Assign Message, complete these fields and click OK:

◦ Address Number / User / Role

◦ Queue Designator

Deleting Messages  
To delete a message, drag the message to the Deleted queue. Alternatively, select the message and click Delete.

You cannot recover a message after you move it to the Deleted queue. It remains in your Deleted queue until your
system administrator purges messages, which is typically done on a periodic or predetermined schedule. Alternatively,
you can remove a message from the system by deleting it from your Deleted queue.

Printing Messages  
You might find that you want a printed copy of a message for your records. You can do either of these tasks:

• Print a message.

You can print a message from any of your queues.

• Print a report that lists all messages within a queue.

This report includes a summary for each message. The two types of message reports are:

◦ Message Center - Summary

◦ Message Center - Detail

These reports show the sender and recipient of the message, as well as the subject of the message. The detail
report shows the content of each message.

Printing a Message  
To print a message:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
2. On Work Center, select the message that you want to print.
3. From the Row menu, select Print.
4. On Printer Selection, click OK.

Printing a Report that Lists All Messages in a Queue  
To print a report that lists all messages in a queue:

1. Open the Navigator drop-down menu, select Actions, and then select Work with Work Center.
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2. On Work Center, select the message queue that you want to print.
3. From the Form menu, select Print.
4. On Work with Batch Versions - Available Versions, select the version and submit the report.

Using the Message Center (Release 9.2.3)  
You can also use the Message Center to view Work Center messages. Use the Message Center to view, sort, search over,
and delete messages. For more information, see Working with Work Center Messages.

Working with Queues  
Queues are a way to group related messages together in the Work Center. This topic describes how to manage your
queues by creating new ones or adding security. As with a message, you can also add a shortcut to a queue.

You set up queues in the system as UDCs. The following task describes how to create queues or modify existing queues.

Setting Up a Queue  
Access the Work With User Defined Codes form.

1. On Work With User Defined Codes, click Add.
2. On User Defined Codes, complete the following fields in an empty row on the grid and click OK:

◦ Codes

Enter a unique number for the queue.

◦ Description 1

Enter a name for the queue.

◦ Description 2

◦ Special Handling

◦ Hard Coded

Enter N in this field.
Codes
A list of valid codes for a specific user defined code list.

Description 1
A user defined name or remark.

Description 2
Additional text that further describes or clarifies a field in the system.

Special Handling
A code that indicates special processing requirements for certain user defined code values. The value that you enter in
this field is unique for each user defined code type.Programming is required to activate this field.

Hard Coded
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A code that indicates whether a user defined code is hard-coded. Values are:

Y

The user defined code is hard-coded

N

The user defined code is not hard-coded

A check mark indicates that the user defined code is hard-coded.

Specifying the Queues that a User Can View  
You can change the security status for a user or group of users within a queue. You can either give a user authority to
monitor every queue within a group, or you can deny users access to certain queues.

You can add security by user, distribution list, or role. For example, you might want to set up security so that a manager
can monitor all messages within certain queues. Or you might set up security by distribution list or role so that users
within the group have authority to monitor certain queues.

If you want to give only a few people within a distribution list or a role access to certain queues, you enter the
distribution list or the role, and then enter the users' address book numbers to define which queues those users in the
group can access.

Access the Work With Workflow Message Security form.

1. On Work With Workflow Message Security, click Add.
2. On Workflow Message Security Revisions, complete these fields:

◦ User

◦ Group/Role

3. Specify the queues that a user can view by completing the Authority Y/N field and clicking OK.
User
A user in the workflow system. This can also be a group.

Group/Role
A group or list of users in the workflow system. The address book number that identifies a list of users in the workflow
system.

Authority Y/N
Indicates whether the user is authorized to make changes to security information.

--- FORM SPECIFIC ---

For workflow, indicates whether the user can view other queues in the Work Center.

Logging Time and Adding Remarks  
The Work Center enables you to inform others of your whereabouts. You can specify when you are in or out of the office
by using the Check In and Check Out options. You can add remarks to your check out to provide detailed information
about where you are. You can view this information from the Time Log form.
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Checking In and Out  
Checking in and out informs others of your whereabouts. When you check out, you can also enter a remark, return date,
and return time. If you do not enter a remark, the system supplies the wordhome. If you do not enter a return date, the
system enters the next business day. The check in and check out information that appears on the Time Log form is
discussed later in this topic.

Access the Work With Employee Queue Manager form.

1. On Work With Employee Queue Manager, locate and select your record.
2. From the Row menu, select one of these menu options:

◦ Check In

◦ Check Out
Each time you select Check In or Check Out, the system updates your status, which you can view from
the Time Log.

Entering Remarks  
You can enter a remark to provide more information about your whereabouts, your schedule, and so on. For example,
you might enter a remark indicating that you are in a meeting, on vacation, or can be reached at a particular phone
number. You can update an existing remark.

Access the Work With Employee Queue Manager form.    

1. On Work With Employee Queue Manager, locate and select your record.
2. From the Row menu, select Remark.
3. On the Check In/Out and Update Remark form, select the Update Remark option.
4. Enter your remark in the Remark field.
5. The following fields in the Return area are optional; complete them if necessary:

◦ Return Time

◦ Return Date

6. Click OK.
7. To view your remark, click Find on Work With Employee Queue Manager.

Viewing Time Logs  
You can view the times when you or other employees check in and out, and you can view any remarks.

Access the Work With Employee Queue Manager form.

1. On Work with Employee Queue Manager, select the employee record time log that you want to view.
2. From the Row menu, select Time Log.

Using Message Center to View Work Center Messages
(Release 9.2.3)  
You can view your Work Center messages using the Message Center application. The Message Center is accessible from
the Manage Notifications menu, which is found on the user ID drop-down menu in the upper-right corner of the screen.
Message Center is also available on the My Worklist composed page.
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For more information about the Message Center, see Working with Work Center Messages in the Message Center
chapter of this guide.
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10  Media Object Attachments

Media Object Attachments Overview  
JD Edwards EnterpriseOne software media objects and imaging features enable you to attach useful information to an
application, including information that might currently exist as a paper-based document. The media objects feature
enables you to attach the information to JD Edwards EnterpriseOne software applications, forms and rows, and Object
Librarian objects. The imaging feature within media objects gives you the flexibility to create an efficient method of
information storage.

Use media objects to link information to applications, either to individual rows in a grid or to a form. The following list
discusses the types of information that you can attach to a grid row or form:

Information Description

Text
 

The media objects functionality includes a word processor that lets you create a text-only attachment.
For example, you could use a text attachment to provide specific instructions for a form or additional
information about a record.
 

Image
 

Images include files such as Windows bitmaps, Graphics Interchange Format (GIF) files, and Joint
Photographic Experts Group (JPG) files. These files might represent electronically created files as well
as scanned images of paper-based documents.
 

Object Linking and Embedding (OLE)
 

Media objects can be files that conform to the OLE standard. OLE enables you to create links among
different programs. Using these links, you can create and edit an object from one program through a
different program. JD Edwards EnterpriseOne software provides the links that you need to attach OLE
objects.
 
You attach OLE media objects at the base form level. Media objects attached at this level are attached
to a form and not to any data that might appear in the form. You can attach media objects to a grid row
or a form, but the files themselves exist in separate directories. The only file information included with
the application to which the OLE links is the path to the supporting file.
 
You can only use OLE objects that you properly register and install as OLE objects through Windows.
 

JDE shortcuts
 

A JDE shortcut is a link that opens a JD Edwards EnterpriseOne software application. Within media
objects, you can only attach JD Edwards EnterpriseOne software shortcuts; you cannot attach
shortcuts to third-party applications.
 

Uniform Resource Locators (URL)/files
 

Media objects can be links to Web page URLs or other related files. When a developer attaches a URL
media object to a control object on a form, the Web page appears as part of the form. When a user
attaches a URL to a form or Object Librarian object, the media object acts as a link to the URL.
 

System administrators can set up templates that might include their own attachments, such as images and shortcuts.
For example, you can create a letterhead and a standard form for a memo. Also, you might create a shortcut, to be
included in the template, that provides access to an application that uses data specific to the information that you add
to the template.
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Each time you save a media object, whether it is a new media object, or whether you have modified an existing one,
EnterpriseOne timestamps the media object with your user ID, the date, and time. This information appears in the
upper right corner of the media object. The information that displays is retrieved from the Enterprise server, so if your
Enterprise server resides in a different time zone, the time and date that displays will be different than the time zone
in which you are working. For example, if you work in the Eastern time zone, but the Enterprise server you are using
resides in the Pacific time zone, the date and time that is recorded when you save the media object is Pacific time.

Note:  If you open a Microsoft Excel OLE media object, place the cursor in the spreadsheet, then click Save,
EnterpriseOne timestamps the media object even if you have not made changes.

Prerequisites  
Before you complete the tasks in this chapter, an administrator must have done the following:

• Enabled media object queues.

Fore more information, see Understanding Media Objects and Imaging in the JD Edwards EnterpriseOne Tools
Runtime Administration Guide.

• Enabled Media Object Attachments, not Advanced Media Object Attachments in Server Manager.

For information on Advanced Media Object Attachments, see Advanced Media Object Attachments (Release
9.2.1)

To enable basic Media Object Attachments, an administrator must do the following in Server Manager for your
HTML Server:

Within the Web Runtime - Media Objects section, ensure that the Use Enhanced Media Objects user interface
setting is not selected (false).

For more information on configuration group settings for a server, see the  JD Edwards EnterpriseOne Tools
Server Manager Guide .

Using Media Objects  
You can use the Media Objects feature to add text, graphics, and other objects to forms and records. For example, you
can use a text attachment to explain special circumstances surrounding a journal entry. Or you can attach drawings,
animations, and other types of objects to forms and records. A pop-up menu provides access to established templates
for attachments and an option to set the properties for the Media Objects form.

When you attach a media object to a form, the attachment might not be available if you access different data on
the form. For example, if you attach a media object to a detail form that contains data for Order Number 2002, this
attachment does not appear on the detail form that appears when you access data for Order Number 3003. The base
form, which in this case is a detail form, is the same for both Order Numbers, but the data associated with the form is
specific to each Order Number. The Order Number represents the key to the location where an attachment is stored.

JD Edwards EnterpriseOne software supports Object Linking and Embedding (OLE). OLE enables you to create links
among different programs. Using these links, you can save an object from one program into a different program. The
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system provides the links that you need to attach OLE objects. You can attach OLE objects as media objects and at the
base form level. When you attach an object at the base level of the form, you attach the object to the form and not to
any data that might appear in the form.

If attachments exist for a form, a paper clip button appears at the right of the status bar when you open the form. For an
OLE object attached at the base form level, a document button appears at the right of the status bar.

When a form first opens, grid rows do not indicate whether attachments exist for the corresponding records. You
can perform a search on every record that the system loads onto your workstation or you can search each record to
determine whether attachments exist for records.

The Text feature includes a word processor that lets you create, view, edit, and delete notes. When you create a text
attachment, you can also set up templates. You can use templates to create a format for a frequently used media object.

HTML Media Objects  
The HTML editor offers eight font faces (Arial, Courier New, Comic Sans, Georgia, Helvetica, Impact, Tahoma, Times
New Roman) and font size from HTML size 1 to 7.

Note:  The font appearance is dependent on the browser being used.

Note:  Tab space is not supported in the HTML editor.

When the HTML mode is enabled and you access an existing ActiveX attachment you are presented with two options:

1. Download File
2. Data conversion

The data conversion option converts the ActiveX text to HTML and is displayed in the HTML editor.

Note:  Once the data is converted and saved to the database in HTML it cannot be returned to the ActiveX RTF
format.

The ActiveX rich text editor supports font sizes from 10 to 72 pts, the HTML editor supports HTML font size 1 to 7. The
font mapping for the data conversion is listed below.

ActiveX Font Size HTML Font Size

10
 

2
 

11, 12
 

3
 

13, 14
 

4
 

16, 18
 

5
 

20, 22, 24
 

6
 

26, 28, 36, 48, 72 7
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ActiveX Font Size HTML Font Size

  

If a company switches from HTML mode to ActiveX mode after attachments were created, the attachments become
read-only.

Checking for Attachments  
To find out whether an attachment exists for a record, you must first perform a search on the record. You can perform
this search on one record or on a number of records simultaneously. The system only searches for attachments on
records that you load onto your workstation. For example, when you initially click the Find button to locate a number of
records, only the records that appear in the grid exist on your workstation. Use the page buttons to view more records.

Access a form with the attachments feature available.

To check for all attachments:

On a form with the attachments feature available, click the Search for Attachments button to the left of the row of
column titles. This button looks like a paper clip overlapping a magnifying glass.

A paper clip appears in the row header for each loaded record with an attachment.

Checking for Attachments for a Single Row or a Range of Rows  
Access a form with the attachments feature available.

1. On a form with the attachments feature available, hold the cursor over the row header for the grid row.

If an attachment exists for the row, a paper clip button appears in the row header.
2. Move the cursor up or down in the row header column to search for attachments for adjacent rows.

Attaching Media Objects  
Use the Attachments feature to attach text, photos, drawings, spreadsheets, video images, sounds, and application
shortcuts to forms and grid rows. For example, you might attach the image of an invoice to a data entry record, attach
a legal document to a record that describes a contractual agreement, or attach text that describes a process on a form.
The attachments feature is not available on all forms.

Note:  You cannot create attachments until an administrator has established and mapped media object queues as
described in Setting Up Media Object Queues in the JD Edwards EnterpriseOne Tools Runtime Administration Guide.

When you enter text, you can format the paragraphs and run a spell check. JD Edwards EnterpriseOne software also
supports object linking and embedding (OLE).
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Attaching Text  
Access a form with the attachments feature available. 

1. On a form where attachments are available, do one of these tasks:

◦ To attach text to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To attach text to a grid row, select the row and then, from the Row menu, select Attachments.

The Media Objects workspace is split into two panels. The left panel is the button panel and the right
panel is the viewer panel. Icons for any files previously attached to the record appear in the button panel.

2. Do one of these tasks:

◦ From the File menu, select New, and then Text.

◦ In the button panel, click the right mouse button, select New, and then select Text from the pop-up
menu.

3. In the viewer panel, type the desired text.
4. When you finish, from the File menu, select Save and Exit.

You can use the formatting tools at the top of the viewer panel to format the text of your note.

Spell Checking Text Media Objects  
EnterpriseOne enables you to spell check text media objects. When you run spell checker, EnterpriseOne displays your
text in a read-only field, and highlights each word in red that it identifies as a possible error. It displays why it identified
the item as an error, and provides suggestions to correct it. You can choose a suggestion, manually correct the word in
Replace With field, or ignore the word.

You can enable or disable the items you want spell checker to identify as possible errors. The list below shows which
items are enabled or disabled by default:

1. Ignore All-Caps Words Option - Disabled.
2. Ignore Words with Numbers Option - Disabled.
3. Ignore Words with Mixed Case Option - Disabled.
4. Ignore Domain Names Option - Enabled.
5. Report Doubled Words Option - Enabled.
6. Case Sensitive Option - Enabled.
7. Suggest Split Words Option - Enabled.

If the language preference setting you are using is not supported by the spell checker, you will receive an error when you
try to spell check your text media objects.

To spell check your text media objects:

1. Click the Spell Check icon located on the media object control toolbar.
2. On Spell Checker, choose one of the following options:

◦ Change

Click this option if you accept the suggestion displayed in the Replace With field. You can also manually
change the word in the Replace With field, and click Change.
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◦ Change All

Click this option if you want spell checker to automatically replace every instance of the word with the
suggestion displayed in the Replace With field. You can also manually change the word in the Replace
With field, and click Change All.

◦ Ignore

Click this option if you want to disregard that the word displayed in the Problem field is an error.

◦ Ignore All

Click this option if you want to disregard that all instances of the word displayed in the Problem field is an
error.

◦ Show Options

Click this option to display a list of the items spell checker identifies as possible errors. Click the check box
to enable or disable any item.

3. Click OK to close the Spell Checker.

Attaching a File  
Access a form where attachments are available. 

1. On a form where attachments are available, do one of these tasks:

◦ To attach an image to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To attach an image to a grid row, select the row and then, from the Row menu, select Attachments.

2. On Media Objects, do one of these tasks:

◦ From the File menu, select New and then Image.

◦ In the button panel, click the right mouse button, select New, and then select Image from the pop-up
menu.

3. Complete these options:

◦ Queue Name

◦ Files of Type

The Preview option contains a default check mark to display a sample of the selected image. Toggle this
option to display or hide the preview image.

4. Choose an image, and then click OK.

If the system supports the graphic format, the image appears in the viewer panel.
5. When you finish, from the File menu, select Save and Exit.

Field Explanation

Queue Name
 

The name of the directory where the image file exists.
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Field Explanation

Files of Type
 

The list of file extensions that the system supports. For example, file types might include .bmp
for a Windows bitmap, .gif for a graphics interchange format file, and .jpg for a joint
photographic experts group file.
 

Attaching an OLE Object  
Access a form where attachments are available. 

1. On a form where attachments are available, do one of these tasks:

◦ To attach an OLE object to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To attach an OLE object to a grid row, select the row and then, from the Row menu, select Attachments.

2. On Media Objects, do one of these tasks:

◦ From the File menu, select New and then OLE.

◦ In the button panel, click the right mouse button, select New, and then select OLE from the pop-up
menu.

3. On Insert Object, to create a new object, select an object type and click OK.
Selections vary from system to system depending on what the system administrator installs on your
workstation and on the network.

4. Create your object.
5. To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the
object displays in the viewer panel either a blank workspace or the existing object.
The menu bar displays the menus for the application from which you call the object. For example, if you select
an Excel document, the Excel menus display on the menu bar.

6. On Media Objects, edit the object in the viewer panel as necessary.
7. When you finish, from the File menu, select Save and Exit.

Attaching a Shortcut  
Access a form where attachments are available. 

Include a shortcut to provide access directly from a record to an associated application.

1. On a form where attachments are available, do one of these tasks:

◦ To attach a shortcut to a form, from the Form menu, select Attachments.
If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To attach a shortcut to a grid row, select the row and then, from the Row menu, select Attachments.
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2. On Media Objects, do one of these options:

◦ From the File menu, select New and then Shortcut.

◦ In the button panel, click the right mouse button, select New, and then select Shortcut from the pop-up
menu.

3. On the Open form, browse through your files, select the appropriate shortcut, and click Open.

Your shortcut appears in the viewer panel.
4. When you finish, from the File menu, select Save and Exit.

Attaching a URL or File  
Access a form where attachments are available. 

Attach a URL to provide access to a Web page or a file on a disk. You can also attach file types that cannot be attached
as images or OLE files, such as bitmaps.

1. On a form where attachments are available, do one of these tasks:

◦ To attach a URL or file to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To attach a URL or file to a grid row, select the row and then, from the Row menu, select Attachments.

2. On Media Objects, do one of these tasks:

◦ From the File menu, select New and then URL/File.

◦ In the button panel, click the right mouse button, select New, and then select URL/File from the pop-up
menu.

3. On Add URL/File, browse your files or queues, select the appropriate URL or file, and click Open. You can also
type a URL in the field.

4. Click OK.

Your URL or file appears in the viewer panel. If you are attaching a URL, a download dialog box appears. You
can either verify that the URL is active or you can click Cancel.

5. When you finish, from the File menu, select Save and Exit.

Attach Media Objects Directly from Applications  
This feature allows you to manage media objects directly from applications. The Manage Media Object system
function can be invoked from the Event Rule (ER), to bring up the Manage Media Object window. This system function
can be used on any control such as a Link, Button or clickable image.

The following screenshot is an example of the Manage Media Object window.
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See Media Object System Functions in the JD Edwards EnterpriseOne Tools Form Design Aid Guide

Searching for Media Objects  
You can search for a specific media object in the system by using information such as creation date, alternate keys, or
UDCs.

Note:  You can only search for media objects that already have codes defined for them and that your system
administrator has made available to all users in the system.

Searching for a Media Object  
Access a form where attachments are available.

1. On a form where attachments are available, do one of these tasks:

◦ To search for a media object to attach to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To search for a media object to attach to a grid row, select the row, and then from the Row menu, select
Attachments.

2. On the Media Objects form, do one of these tasks:

◦ From the File menu, select New and then Search.

◦ In the button panel, click the right mouse button, select New, and then Search from the pop-up menu.
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3. On the Media Object Search form, complete the Type field and click Find.

Enter the type of media object attachment for which you are searching. You can use the Query by Example line
to limit your search.

Only attachments with defined metadata appear.
4. Choose an attachment and click Select.

Your media object appears in the viewer panel.
5. When you finish, from the File menu, select Save and Exit.

Renaming Attachments  
When you add an attachment, the system displays its filename under its button in the button panel. You can rename the
button to make it more meaningful to other users if you want.

Access media objects. 

1. On the Media Objects form, select a button and do one of these tasks:

◦ From the File menu, select Rename.

◦ In the button panel, click the right mouse button and select Rename from the pop-up menu.

2. Type a new name for the button and then click anywhere on the form.

Deleting Media Objects  
When you no longer need an attachment, use the Delete feature on Media Objects to remove the object. When you
delete text, the text is permanently erased. When you delete images and OLE objects, you remove the attachment of the
file to the record. The system continues to store a file for the object.

Access a form where attachments are available.

1. Complete one of these tasks:

◦ To delete an attachment to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.

◦ To delete an attachment to a grid row, select a row with a paper clip button, and then, from the Row
menu, select Attachments.

2. On the Media Objects form, select the appropriate button in the button panel and then select Delete from the
File menu.

3. On Confirm Media Object Delete, click Yes to confirm the deletion.

The button disappears from the button panel.
4. When you finish, from the File menu, select Save and Exit.
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Using Templates  
This section discusses how to:

• Create a template

• Attach a template

• Modify a template

• Delete a template

• Delete a template with media objects

Creating a Template  
On the Media Objects form, you can access the Work With Media Objects Templates form. On this form, you can attach,
create, modify, and delete templates to help you format your text attachments.

Access a form where attachments are available.   

1. Select the row from which you want to attach a template, and then select Attachments from the Row menu.
2. On the Media Objects form, in the button panel, click the right mouse button and select Templates from the

pop-up menu.
3. On the Media Objects Template form, click Add.
4. On the Media Object Template Revisions form, complete these fields, and then enter your template information

into the workspace:

◦ Template Name

◦ Description

5. Click Add.

Attaching a Template  
Access a form where attachments are available.   

1. Select the row to which you want to attach a template, and then select Attachments from the Row menu.
2. On the Media Objects form, in the button panel, click the right mouse button and select Templates from the

pop-up menu.
3. On the Work With Media Object Templates form, click Find.

You can use the query-by-example line to refine your search.
4. To preview the template, double-click the paper clip button in the row header.
5. Choose the grid row for the template that you want to attach, and then click Select.
6. The template appears in the workspace on Media Objects.
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Modifying a Template  
Access a form where attachments are available.   

1. Select the row from which you want to modify a template, and then select Attachments from the Row menu.
2. On the Media Objects form, in the button panel, click the right mouse button and then select Templates from

the pop-up menu.
3. On the Work With Media Object Templates form, click Find.

You can use the Query by Example line to refine your search.
4. Choose the grid row for the template that you want to modify and then click Select.
5. On the Media Objects form, modify the template as necessary and then from the File menu, select Save and

Exit.

Deleting a Template  
Access a form where attachments are available.    

1. Select the row from which you want to delete a template, and then select Attachments from the Row menu.
2. On the Media Objects form, in the button panel, click the right mouse button and then select Templates from

the pop-up menu.
3. On the Work With Media Object Templates form, click Find.

You can use the Query By Example line to refine your search.
4. Choose the grid row for the template that you want to delete, click Delete, and then on Confirm Delete, click OK.

Deleting a Template on Media Objects  
Access a form where attachments are available.   

1. Select the row from which you want to delete a template, and then select Attachments from the Row menu.
2. On the Media Objects form, in the button panel, select the text button for the template, and then select Delete

from the File menu.
3. On the Confirm Media Object Delete form, click Yes.

The template and the text button disappear.

Setting Media Object Properties  
The pop-up menu that appears when you right-click in the button panel on the Media Objects form provides you with
the option to view and, for some objects, to change the properties of an object. Each object has unique properties.

In addition, you can define metadata for an object. Metadata contains information about the object, such as a
description of the object, who created it, and when it was created. Other users can search for the object based on this
information.

138



JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 10
Media Object Attachments

Access Media Objects. 

1. On the Media Objects form, in the button panel, right-click and then select Properties.

The form or row must contain an attachment in order to access the Media Objects properties.
2. On the Properties form, review the "Technical information about the key for the form" on the Key Information

tab.
3. Click the Flags tab and review this information:

◦ Allow Text Items

◦ Allow Image Item

◦ Allow OLE Items

◦ Allow RTF Text

◦ Show Text Item On Open

◦ Read Only

Setting Text Properties  
Access Media Objects.  

1. On the Media Objects form, in the button panel, right-click a text button, and then select Properties from the
pop-up menu.

2. On the text properties form, review these fields on User Audit Information:

◦ Created by

◦ Date Created

◦ Time Created

◦ Updated By

◦ Date Updated

◦ Time Updated

3. Click the Printing Information tab and then do the following, if necessary:

◦ Click the Check to print before report item option

◦ Complete the Effective From field

◦ Complete the Effective To field

Setting Image Properties  
Access Media Objects. 

1. On the Media Objects form, in the button panel, right-click an image button, and then select Properties from
the pop-up menu.

2. On the Image Properties tab, review these fields:

◦ File Name

◦ Queue Name
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◦ Queue Path

3. To give the image a title, complete the Description field.

Viewing OLE Properties  
Access a form where attachments are available.  

1. On the Media Objects form, in the button panel, right-click an OLE object button, and then select Properties
from the pop-up menu.

2. On the OLE Object Properties tab, review these fields:

◦ File Name

◦ Queue Name

◦ Queue Path

Setting Shortcut Properties  
Access Media Objects.  

1. On the Media Objects form, in the button panel, right-click a shortcut button, and then select Properties from
the pop-up menu.

2. On the JDEShortcut Control Properties form, review these fields on the General tab:

◦ Menu Name

◦ Selection

◦ Icon File

◦ Icon Index

3. Do these tasks, if necessary:

◦ Click the Colors tab to set the color for the shortcut hypertext.

◦ Click the Fonts tab to set font properties such as size, family, bold, italics, underline, and strikeout.

Enabling Metadata for Media Objects  
The system enables you to add information to media objects in the form of metadata. Metadata can include items such
as author, creation date, and language of the media object attachment.

Before you can add metadata, you must enable the metadata fields for the media object in the Media Object Category
Constants program (P00167).

Enabling Metadata Fields  
To enable metadata fields for media objects:
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From the GH9016 menu, select Media Object Constants (P00167).

1. On the Work With Media Object Category Constants form, find the media object that you want to enable.

The system enables the metadata fields for all the media objects that are associated with the media object that
you select.

2. Highlight the media object and then click Select.
3. On the General tab of the Media Object Category Constants Revisions form, select the check boxes next to the

available metadata field options to enable those metadata fields in the media object.
4. Click OK.

Viewing and Defining Metadata  
Access a form with an attachment.   

1. On any form with an attachment, in the Media Objects button panel, right-click an object button, and then
select Characterize Object from the pop-up menu.

2. On the Media Object Category Revisions form, click the General tab, and then complete the available fields for
the media object.

3. Click OK.

Description Glossary

Description
 

A short description to describe what the media object is about.
 

Author
 

This is the author of the media object document or attachment.
 

Creation Date
 

For World, used in the DDS specifications for IBM's file-field reference display.
 

Status
 

Indicate if this media object is active or obsolete.
 

Attaching OLE Objects at the Base Form Level  
At the base level of a standard form, you can attach OLE objects using the OLE Objects button on the Links toolbar.
Menu bars and toolbars appear on all standard forms. When you attach an OLE object at the base level of a form, rather
than associating the attachment with a record, the OLE object attaches only to the form. No matter what record appears
on the form, the OLE object that you attach using the OLE Objects button will always appear when you open the form.

Access a standard form.    

1. Complete one of these tasks:

◦ From the Links toolbar, select Preferences, and then OLE Objects.

◦ From the Preferences menu, select OLE Objects.
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◦ If attachments exist for the form, click the document button to the right of the status bar.

2. On the Choose Queue form, select the appropriate queue.

Note:  If you do not know the queue in which the object you want to attach exists, ask your system
administrator.

3. On the OLE Objects form, do one of the following:

◦ From the File menu, select Add Object.

◦ In the button panel, click the right mouse button and then select Add Object.

4. On Insert Object, to create a new object, select the type of object that you want to create and then click OK.

Selections vary from system to system depending on what the system administrator installs on your
workstation and on the network.

5. Create your object.
6. To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the
object displays either a blank workspace or the existing object in the viewer panel.

The menu bar displays the menus for the application from which you call the object. For example, if you select
an Excel document, Excel menus display on the menu bar.

7. Edit the object in the viewer panel.
8. To return to the main form, click the Cancel button on the OLE Objects form in the application workspace.

Deleting OLE Objects at the Base Form Level  
Access a standard form.    

1. Complete one of these tasks:

◦ From the Links toolbar, select Preferences and then select OLE Objects.

◦ From the Preferences menu, select OLE Objects.

◦ Click the document button to the right of the status bar.

2. On the OLE Objects form, select the object and complete one of these tasks:

◦ From the File menu, select Delete Object.

◦ In the button panel, click the right mouse button and select Delete Object.

3. On Confirm Media Object Delete, click Yes.
4. To return to the main form, click the Cancel button on the OLE Objects form in the application workspace.
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11  Advanced Media Object Attachments
(Release 9.2.1)

Advanced Media Object Attachments Overview  
Starting with EnterpriseOne Tools Release 9.2.1.0, the EnterpriseOne Media Object Attachments functionality improves
the user experience by allowing you to:

• Access attachments from the grid using the paper clip.

• Use the Attachments option from the Row or Form menu to access or edit attachments, depending on the
application.

• Drag and drop files to attach to records.

• Increase usability by allowing you to search, sort, and filter attachments.

• Edit text or eTXT attachments.

Starting with Release 9.2.4.4, you can select multiple attachments at one time to download or delete the
attachments.

Note: 

• Oracle recommends that you use the Advanced Media Object Attachments feature instead of the classic
Media Object Attachments, to take advantage of additional functionality.

Your access to viewing and editing attachments depends on an administrator performing Media Object
setup, including enabling Advanced Media Object Attachments in Server Manager and setting up necessary
permissions for the appropriate applications.

• The Download selected attachments icon is not available on mobile devices. (Release 9.2.4.4)

Prerequisites  
Before you complete the tasks in this chapter, you must ensure that an administrator has enabled Advanced Media
Object Attachments.

To enable Advanced Media Object Attachments, these settings must have the correct values. They can be found in
Server Manager, within the Web Runtime configuration settings for your HTML Server:

• Within the Web Runtime - Media Objects section, the Use Enhanced Media Objects User Interface setting
should be selected (true).

• Within the Web Runtime section, the Use ActiveX Controls setting should be set to false.

For more information on configuration group settings for a server, see the  JD Edwards EnterpriseOne Tools Server
Manager Guide .
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For more information on general media object setup, see Understanding Media Objects and Imaging in the JD Edwards
EnterpriseOne Tools Runtime Administration Guide.

Note:  Advanced Media Object Attachments do not support OLE, ActiveX, and JDE Shortcuts.

Adding Advanced Media Object Attachments  
Advanced Media Object Attachments work the same way as classic Media Object Attachments. You can add Local,
Queue, or URL files.

Attachment types you can add using Advanced Media Object Attachments include:

• Editable text or eTXT

• Local Files

Select multiple files or Drag and Drop multiple files.

• URL Files

• Queue Files

To add Local files:

1. Access the Attachment Manager.
2. Select the Add icon, and then select File/URL Attachment.

Select Local File as the Attachment Type.
3. When you add local files, you can attach multiple files using the Choose Files/Browse button to select the files

or you can use Windows Explorer to drag and drop the selected files into the dotted drop area labeled "drop file
here".

Note:  In Grid View, you can also drop files directly onto the Click or Drop Files target (plus sign), to quickly add them.

Note:  When you add files from your local machine, the file extensions must comply with the following two settings
for your HTML Server in Server Manager: Web Runtime - Media Object Settings Section --> Invalid Media Object
File Extensions  Security - Upload Inclusion Lists Section --> Media Object Extension List  For more information on
configuration group settings for a server, see the  JD Edwards EnterpriseOne Tools Server Manager Guide .

To add Queue files:

1. Select the row to which you would like to add an attachment. Then select Row, Attachments, to open the
Attachment Manager.

2. Select the Add icon and then select File/URL Attachment.

Select Queue as the Attachment Type.
3. Select the Queue and the File from the drop-down lists, and then click Save.

If the Preview option is selected, the system opens a window to preview the Queue file. The only files you can
preview are images with extensions .jpg, .jpeg, .png, .gif, and .bmp.
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To add URL files:

1. Select the row to which you would like to add an attachment. Then select Row, Attachments, to open the
Attachment Manager.

2. Select the Add icon and then select File/URL Attachment.

Select URL as the Attachment Type.
3. Enter the URL and click Save. The system either opens a new window or pop-up form to preview the URL.

The system will open a new window based on the Open URL Media Object Attachments in a New Window
setting in Server Manager for your HTML Server.

Note:  Oracle recommends that URLs are set to display in a new window. An administrator can set this using the
"Open URL Media Object Attachments in a New Window" setting within the Web Runtime - Media Object Settings
section for the HTML Server in Server Manager. For more information on configuration group settings for a server,
see the  JD Edwards EnterpriseOne Tools Server Manager Guide .

Finding Advanced Media Object Attachments  
To find attachments, you can sort the files when in list view and perform a properties search over the files. The system
automatically sorts the files by name when first opening the Attachment Manager.

Release 9.2.1.2

The Attachment Manager displays the attachments in a list or grid view (icons).

Searching for Media Object Attachments  
To choose the Attachment Manager view and search for files:

1. In the Attachment Manager, click the List View or Grid View icon to view attachments in a list or as icons,
respectively. (Release 9.2.1.2)

2. Enter your search text in the Search field to perform a search over the properties of the attachments (name,
type, user, and date).

When searching for a date, you can use the following formats:

◦ - YYYYMMDD
- YYYYMM
- YYYY

Sorting Media Object Attachments  
To sort files:

In Attachment Manager, in List View, you can sort files by Name, Type, User, or Date. To sort by alphabetical order, click
on the row header for the column by which you want to sort. If you click a second time, the system toggles between
ascending and descending order.
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Finding and Replacing within Text Media Objects  
EnterpriseOne enables you to find and replace text media objects. You can search for a word, phrase, or a sentence and
EnterpriseOne shows all the instances in the text attachment for the occurence of the search query. You can replace the
findings of the search with another text input.

To find and replace your text media objects:

1. Click the Find icon located on the media object control toolbar. The system will display the search bar on a
separate window.

2. You can search for a word, phrase, or a sentence. The Find option has the following fields:

Match case: Check this option to limit the search operation to words whose case matches the spelling
(uppercase and lowercase letters) entered in the Find What field. This means that the search becomes case-
sensitive.

Match whole word: Check this option to find entire words only.

Match cyclic: Check this option to continue the search from the beginning of the document after the end of the
document is reached.

3. Click the Replace tab. The first occurrence of the text is highlighted. If the text cannot be found, a message box
opens informing you that the text was not found in the selected content. Click OK to close the message box.

4. Click Replace to replace the first occurrence with the replacement text.
5. Click Replace as needed to replace the next occurrence of the text or Click Replace All to replace all

occurrences with the replacement text.

Viewing Advanced Media Object Attachments  
You can view most and download many types of attachments. OLE attachments are visible in the Attachment Manager
but cannot be viewed nor downloaded. Some audio and video formats are also supported. When viewing attachments
using the Advanced Media Objects functionality, you can:

• View images such as .jpg, .jpeg, .gif, .bmp, and .png attachments. The size of the image is based on the
available viewing space.

• View URLs on your screen.

Note:  Oracle recommends that URLs are set to display in a new window. An administrator can set this using
the "Open URL Media Object Attachments in a New Window" setting within the Web Runtime - Media Object
Settings section for the HTML Server in Server Manager. For more information on configuration group
settings for a server, see the  JD Edwards EnterpriseOne Tools Server Manager Guide .

• View videos, such as .mov, and .mp4 files.

• Listen to audio, such as .mp3 and .wav files.

• Download all types of attachments, including editable text files. If you cannot view an attachment, download
the attachment to your local machine to view it.

• Starting with Release 9.2.4.4, you can download multiple attachments at one time. The multiple download
feature is not supported for the following attachment types: URL, Link, and OLE.
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To view files:

Within Attachment Manager, right-click the attachment you would like to view and select View or click the attachment.
The system displays the attachment that you selected.

Note:  You can only view certain attachment types. If the View option is not available, you can download the
attachment to your local machine to view it.

To download files:

1. From the row header of a record, click the paper clip button to open the Attachment Manager side panel.
2. (Optional) Search for the file or files you want to download by using the Search field and then sort the files. See

Finding Advanced Media Object Attachments.
3. Select the file or files you want to download. You can select the file or files by selecting the check box displayed

next to the attachments. To select all the files that are displayed, select the Select all check box (Release
9.2.4.4).

4. Perform either of the following actions:

◦ To download a single attachment, right-click the attachment that you would like to download and
select Download. Alternatively, if you selected the check box displayed next to the attachment, click
the Download selected attachments icon, and then click OK in the confirmation dialog box (Release
9.2.4.4).

◦ To download multiple attachments, after selecting the check boxes displayed next to the attachments,
click the Download selected attachments icon and then click OK in the confirmation dialog box (Release
9.2.4.4).

The system downloads the attachment or attachments to your local machine.

Note:  The Download selected attachments icon is enabled only if you select at least one of the attachments by
selecting the check box next to the attachment (Release 9.2.4.4).

Editing Advanced Media Object Attachments  
When editing attachments using the Advanced Media Object functionality, you can:

• Edit text or eTXT attachments.

• Rename attachments.

• Delete attachments.

• Designate an attachment as a default image.

• Characterize attachments.

Starting with Release 9.2.4.4, you can download multiple attachments at one time. The multiple download feature is not
supported for the following attachment types:

• URL

• Link

• OLE
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To edit files:

1. Use the Attachments option from the Row menu to access the Attachment Manager in edit mode.

Note:  When the Edit Media Object Manager is open as a side panel, the parent form is disable until you close
the Edit Media object Manager side panel.

2. (Optional) Search for the file or files you want to edit by using the Search field and then sort the files. See
Finding Advanced Media Object Attachments.

To download or delete a single or multiple files, you can select the file or files by selecting the check box
displayed next to the files. To select all the files that are displayed, select the Select all check box. (Release
9.2.4.4).

3. Perform any of the following actions, as applicable:

◦ To edit text, right-click the file and select View. The system displays the text editor where you can make
the change or rename the file.

◦ To download a file, right-click the file and select Download. Alternatively, if you selected the check box
displayed next to the attachment, click the Download selected attachments icon, and then click OK in
the confirmation dialog box (Release 9.2.4.4)

To download multiple files, after selecting the check boxes displayed next to the attachments or selecting
the Select all check box, click the Download selected attachments icon and then click OK in the
confirmation dialog box (Release 9.2.4.4).

The system downloads the attachment or attachments to your local machine.

Note:  The Download selected attachments icon is enabled only if you select at least one of the
attachments by selecting the check box next to the attachment (Release 9.2.4.4).

◦ To rename a file, right-click the file and select Rename. Enter the new name of the file you selected and
press Enter.

◦ To delete a file, right-click the file and select Delete. Alternatively, if you selected the check box
displayed next to the attachment, click the Delete selected attachments icon, and then click OK in the
confirmation dialog box (Release 9.2.4.4).

To delete multiple files, after selecting the check boxes displayed next to the attachments or selecting the
Select all check box, click the Delete selected attachments icon and then click OK in the confirmation
dialog box (Release 9.2.4.4)

Note:  The Delete selected attachments icon is enabled only if you select at least one of the
attachments by selecting the check box next to the attachment (Release 9.2.4.4).

◦ To designate an attachment as the default image, right-click the file and select Set as Default. The
system displays a check mark on top of the icon to indicate that it is the default image. This option is only
available for .png, .jpg, .gif, and .bmp files.

◦ To characterize a file, right-click the file and select Characterize. For more information about media
object attachment characterization, see Enabling Metadata for Media Objects.

Note:  Some of these options may not be available depending on security and your permissions. For more
information, contact your administrator.
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Previewing Text Media Objects (Release 9.2.5.3)  
EnterpriseOne enables you to preview text media objects. To preview your text media objects click the Preview icon
located on the media object control toolbar.

The text information appears in a new window on the web browser.

Creating Tables in Text Media Objects  
EnterpriseOne enables you to create tables within text media objects. You can insert new tables and also edit the tables.

To insert a new table within a text attachment:

1. Click the Table icon located on the media object control toolbar. A pop up window appears on the screen with
the table properties.

2. You can select the number of rows and columns that you want to add in the table. You can also define the
height and width of the columns and rows.

3. Click OK. The system creates a table with the properties you have selected.
4. To add or delete rows and columns in the table, right-click to open the Options menu and select Add or Delete.

You can also delete the entire table.

You can add rows and columns before or after the existing rows and columns in the table.

Adding an Image in Text Media Objects  
EnterpriseOne enables you to add an image as a reference within a text attachment.

To add an image within a text attachment:

1. Click the Image icon located on the media object control toolbar. The system displays the image properties in a
separate window.

2. You can copy the link of the image from the browser and paste it in the URL field.
The image appears in the text attachment directly from the web browser.

Copying and Pasting  
EnterpriseOne enables you to copy text from Microsoft Word, Excel, and Google Docs and paste the content into text
media objects. You can copy and paste images, tables, and lists.

With this functionality you can retain the orginal structure of the document like images, font styles, amd heading levels
when you copy text from Microsoft Word, Excel, and Google Docs and paste it in a text attachment.
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Copy Formatting in Text Media Objects  
EnterpriseOne enables you to use the copy formatting functionality between sections of the text attachment.

You can use the Copy Formatting icon to copy text formatting features such as font style and font size from one place in
the text attachment and apply it for another.

Using Templates  
You can use templates with advanced media objects. For more information, see Using Templates.

Adding Contextual Conversations and Documents
(Release 9.2.1.2)  
The integration of Oracle Content and Experience Cloud with JD Edwards EnterpriseOne enables social collaboration
within the EnterpriseOne application.

The Conversations icon in the Attachment Manager enables you to start a new conversation or join existing
conversations in the context of the selected record.

The Documents icon in the Attachment Manager enables you to attach documents to the cloud in the context of the
selected record.

For detailed steps about how to create contextual conversations and add contextual documents, see Using Oracle
Content and Experience Cloud for JD Edwards EnterpriseOne (Release 9.2.1.2) in this guide.
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12  Using MailMerge Workbench

Understanding MailMerge Workbench  
MailMerge Workbench merges Microsoft Word 6.0 (or higher) word processing documents with JD Edwards
EnterpriseOne system records to automatically print business documents, such as form letters. Some application
suites, such as Human Resource Management, use these documents within their normal workflow process. See your
application guides to determine which applications use mail-merge documents. In these applications, the system
automatically prints the mail-merge documents as part of the workflow process, and no user intervention is needed.

You can use the Maintain MailMerge Documents application to add or change text in the business documents included
with JD Edwards EnterpriseOne software to create new documents and to delete documents.

JD Edwards EnterpriseOne software enables you to create HTML versions of mail-merge documents to send to web
client users. After you add text and fields to the mail-merge document, you can copy it to an HTML version so that you
can send mail-merge letters to web client users. When a mail-merge letter is generated, the system displays the letter in
the Web Mail Merge program (P980040).

Creating a Data Set and Attaching Templates  
A data set is the way you define the data structure that passes data to the API. After you define the data set, you will
attach to it a simple template or a composite template. A simple template is a single template that you attach to a data
set. A composite template is a collection of simple templates. Use only templates in the .rtf format.

After you have created a data set, you must attach either a simple template, or a composite template.
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Understanding Processing Options  
A processing option is a parameter in which you enter a value to control how an interactive or batch program runs.

You use processing options to instruct the system to perform functions to meet your specific business needs. If a
program contains processing options, you set the required and optional processing options for the program during
setup or before you run or submit a program.

You can create different versions of each program if your business needs require specific processing for different
processes. You can then set these unique processing options differently in multiple versions of the same application.
Changes to processing options immediately affect that version for every user. Anyone who uses that version after you
make the change uses the new processing option values. You can also use processing options to access a version of
another program.

Note:  XJDE versions are considered owned by JD Edwards. During an upgrade, the system might overwrite these
versions. You should use these versions only as templates for your own versions. ZJDE versions are used for default
purposes, and are typically interactive applications or versions called from another application. You usually attach
these versions to a menu. You can set these processing options. When called from a menu, interactive applications
with a version are called with a blind execution based on predetermined processing option values.

Understanding Processing Option Functions  
Use processing options to complete one of these tasks:

• Set up default values

• Customize an application for different companies or even different users

• Control the format of forms and reports

• Control page breaks and the location where totaling occurs for reports

Processing options appear in the system as a tabbed form. Tabs organize the processing options by purpose and
function. Each processing option tab contains these items:

• A standard or unique tab name

• Processing option titles

• Lists of values

• Online help (enhanced processing options)
You access field-level help by placing the cursor in a field and pressing F1, or by clicking the Item Help icon
located at the top-right corner of a form. If the field in which the cursor resides is a business view column, the
system displays the alias name, business view name and description, table name and description, and glossary
text. If the field in which your cursor resides is a data dictionary column, the system displays the alias name, the
term Data Dictionary Item, and the glossary text. This information enables you to identify problems in the item
help functionality, should any occur.
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Note:  If your system administrator has not turned on the appropriate functionality, you will see only the alias
name and glossary text.

Understanding the Types of Processing Options  
Processing options can be of two types: enhanced and non-enhanced.

Enhanced processing options provide detailed information. For example, you can look at the field name and values
on the tab and quickly determine how to use the processing option; or you can access online help by pressing F1
on the processing option for a detailed explanation. These processing options have been enhanced to JD Edwards
EnterpriseOne standards. Enhanced processing option forms have a number, a brief title, and, if applicable, a concise list
of values. These processing options have online help attached to them.

Non-enhanced processing options provide only a brief description in paragraph form. Sometimes these fields have no
title; instead, they are numbered, and each number is followed by a brief explanation, in paragraph form, of relevant
information (usually values). The processing option numbers sometimes span all tabs. The fields typically have data
items attached but do not follow the same naming conventions as enhanced processing options.

Working with Processing Options  
You can work with processing options in these two ways:

• From a menu

• From a version list

When working with processing options from a menu, you can access them for an object either from the menu bar or
by right-clicking the object. In either case, one of the options is Prompt For. The Prompt For submenu contains these
options, when available:

Options Description

Values
 

Choose this option to specify processing option values.
 

Version
 

Choose this option to select which version of the object to run. Depending on how the version was
designed, you might be prompted to enter processing option values after you select the version, or you
might be able to modify them from the Row menu.
 

Data Selection
 

Choose this option to specify which data to use.
 

Data Selection and Values
 

Choose this option to specify which data to use and then to specify processing option values.
 

If you select to run processing options from a menu, the processing details defined at the menu level take precedence.
Not all objects enable you to select from all four of these options.
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Using Interactive Version Processing Options  
The processing options that you define in interactive versions are a set of parameters that alter how an application runs.
They are similar to initialization (.ini) files and command-line arguments for a traditional executable. These processing
options let you specify the options that you want when you open an application. For example, you can specify how
a form appears, show or hide a field, change the default status for order activity rules, and set default information to
appear in a field.

Not all JD Edwards EnterpriseOne software applications have processing options. If the Prompt For Values option on the
Edit menu is grayed out, either no processing options are associated with the application or the system administrator
has secured a version for the application. When you open a secured version from the Interactive Versions application, a
security message appears to inform you that you do not have access to the version.

You must set processing options for an interactive application before you use versions with the application.

Using processing options, you set up interactive programs to suit your business requirements. For interactive versions,
processing options complete these tasks:

• Change functions. For example, you can set a processing option to turn on or off order holds. You can also
specify whether you want to automatically print pick slips after you enter an order that is based on a processing
option value.

• Change default values. For example, you can set the processing options to set defaults for document types
(such as quote orders or purchase orders) or line types (such as stock or nonstock items).

• Control the display of forms. For example, you can set the processing options to hide or show a cost field, a
price field, or a commission field.

Note:   The Versions Compare report (RD983051NA) compares the processing options for interactive versions and
batch versions between two environments or data sources. You can use this report as an audit or validation tool
to determine which versions were added, deleted, or changed. See "Versions Compare Report" in the JD Edwards
EnterpriseOne Tools Software Updates Guide .

To use interactive version processing options:

1. Using the EnterpriseOne Menus, navigate to the application for which you want to set processing options.   
2. Right click on the application and select Prompt For Values from the menu.
3. On Processing Options, enter appropriate values where applicable and click OK.

Using Version Processing Options  
You can change the processing options for an existing batch version to suit your business requirements. For example,
you can change processing option values that specify a range of dates for a report. However, not all batch versions have
processing options associated with them. For example, a list of addresses might not require special prompting.

For batch versions, processing options complete these tasks:

• Change functionality. For example, you can set a processing option to move records to a history file after a
report runs.

• Change input parameters. For example, you can set a processing option to specify which category code to use
when processing a report.
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• Define data. For example, you can set a processing option to define the fiscal year for which you want to run a
report. You can also define the employee information included in a report.

Note:  The Versions Compare report (RD983051NA) compares the processing options for interactive versions and
batch versions between two environments or data sources. You can use this report as an audit or validation tool to
determine which versions were added, deleted, or changed. For batch versions, the report also shows processing
option values that are different between the versions in the data sources being compared. See "Versions Compare
Report" in the JD Edwards EnterpriseOne Tools Software Updates Guide .

Launching Processing Options for Batch Versions Manually  
Access a Solution Explorer task view.

1. From a EnterpriseOne Menu, select the batch version application for which you want to set processing options.
2. On Work With Batch Versions - Available Versions, find and select a version of the report or other batch

application.
3. On Work With Batch Versions - Available Versions, select Processing Options from the Row menu.
4. On Processing Options, enter appropriate values where applicable and click OK.

Using Processing Options for Master Business Functions  
The purpose of a master business function (MBF) is to provide a central location for standard business rules about
entering documents such as vouchers, invoices, and journal entries.

The MBF is composed of processing options that are shared by some programs. For example, the following journal
entry programs use the processing options for the journal entry MBF:

• Journal Entries (P0911)

• Journal Entries with VAT (P09106)

• Journal Entry Batch Processor (R09110Z)

• Store and Forward JE Batch Processor (R09110ZS)

• Recurring Journal Entry Compute & Print (R09302)

• Indexed Comp Compute and Print Report(R093021)

• Variable Numerator Compute and Print (R093022)

Access Work With Interactive Versions from the System Administration Tools menu (GH9011).

1. Type the application number in the Interactive Application field and click Find. For example, type P0900049.
2. Choose a version.
3. To review the processing option settings for the version, select Processing Options from the Row menu.
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Understanding User Defined Codes  
Most forms in JD Edwards EnterpriseOne contain fields. Some fields enable you to enter any value, and some require
you to select from a list of values. A user defined code (UDC) is one value in a set of values that is assigned as valid for
a field. You can use UDCs to categorize your data and make sure that users provide consistent input on forms. Because
users can select only values from the list, UDCs simplify, standardize, and validate the data that is contained in fields.

From any JD Edwards EnterpriseOne application, you can identify fields that have UDCs attached to them by using the
visual assist button that appears when you tab into or click in a field. If you do not know the value to enter in a field with
a user defined code attached to it, click the visual assist button, which accesses the Select User Define Code form. This
form displays all values contained in the user defined code tables for this field. You can then select the value to use.

JD Edwards EnterpriseOne provides predefined UDCs, but many of the UDCs that you use are unique to your enterprise,
and your needs are likely to change. Therefore, the system lets you change, add, and delete UDCs to meet the needs of
your enterprise.

Category Codes  
Throughout the system, you will see references to category codes. Category codes are UDC types that JD Edwards
EnterpriseOne provides for you to customize according to your needs. You can change the code type and the
description, and you can redefine the UDCs as appropriate for your purposes. For example, you might see a UDC type
called Category Code 01. You can change its description and define the UDCs within it to suit your business needs.

Example: User Defined Codes in Address Book  
JD Edwards EnterpriseOne systems use UDCs. For example, Address Book uses a field called Search Type to classify the
entries in the address book. When you click the visual assist button in the Search Type field on the Work With Addresses
form, a list of the search types appears. These search types are UDCs. Some of the search types include the following:

• A - Applicants

• C - Customers

• V - Suppliers

• E - Employees

You can use these UDCs to classify your address book entries, and you can add or change UDCs to accommodate your
needs. For example, if you need to categorize some of your address book entries as students, you can add a UDC to the
list, such as S - Students.

UDCs are also used to supply values for the following:

• State and province codes

• Units of measure

• Document types

• Languages
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When you click the visual assist for a field and the system displays the Select User Defined Code form, you know that
you are working with UDCs.

Customizing User Defined Codes  
A UDC is made up of two parts. The first part is the code, which consists of the characters that you enter in a field. The
second part is the description, which is text that describes what the code means. You can change both the code and
the description. For example, the UDC list of search types contains the code C, which designates Customers. A medical
facility might change this code and description to P for Patients.

Prerequisite  
Every UDC belongs to a UDC type. Verify that a UDC type exists for which you will add the UDC.

For more information on UDC types, see "Customizing UDC Types" in the JD Edwards EnterpriseOne Tools Runtime
Administration Guide.

Changing a UDC  
Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne web client, from a System Setup
menu for your product, access the P0004A program.

1. Complete the Product Code and User Defined Codes fields and click Find.

For example, to display the list of Address Book search types, which is UDC 01/ST, type 01 in the Product Code
field and ST in the User Defined Codes field.

2. Select the code that you want to modify and click Select.
3. On the User Defined Codes form, modify any of these fields and click OK:

Field Description

Codes
 

A list of valid codes for a specific user defined code list.
 

Description 01
 

A user defined name or remark.
 

Description 02
 

Additional text that further describes or clarifies a field in the system.
 

Special Handling
 

A code that indicates special processing requirements for certain user defined code values. The
value that you enter in this field is unique for each user defined code type.
 

Hard Coded
 

A code that indicates whether a user defined code is hard-coded. Valid values are:
 
Y
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Field Description

 
The user defined code is hard-coded
 
N
 
The user defined code is not hard-coded
 
A check mark indicates that the user defined code is hard-coded.
 

Adding a UDC  
Add a UDC to a UDC type when none of the existing codes is appropriate for your needs. For example, if you need to
identify the entries in the address book that are your business partners, you can add a search type B - Business Partners
to UDC 01/ST.

Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne web client, select the appropriate
program for changing UDCs. 

1. Complete the Product Code and User Defined Codes fields and click Find. In the User Defined Codes field, enter
the UDC type for which you want to add the UDC.

2. On the Work With User Defined Codes form, click Add.
3. On the User Defined Codes form, scroll to the last empty row of the detail area.

Note:  Be sure to add each new code on the last detail row so that you do not inadvertently overwrite a blank
code, which might appear in the first detail row. A blank code might have only a period in the Description
field.

4. Enter a code in the Codes field. To allow a blank as a valid value, leave this field blank.
5. Enter a description in the Description 1 field. To allow a blank as a valid value, type any character (such as a

period) in the last space in this field.
6. Complete the Special Handling and Hard Coded fields, and then click OK.

Adding a UDC to Color Code an Environment  
Starting with EnterpriseOne Tools Release 9.2.4.0, you can color code the environments by adding the UDC 98/CO.
When you log in to an environment, this feature enables you to identify the environment by its color.

To color code the environments:

1. Access the Work With User Defined Codes form.
2. Enter the Product Code as 98 and User Defined Codes as CO, and then click Find.
3. On the Work With User Defined Codes form, click Add.
4. On the User Defined Codes form, scroll to the last empty row of the detail area.
5. Enter the environment in the Codes field.
6. Enter the Hex color code (for example: #850505) in the Description 1 field.
7. Complete the Special Handling and Hard Coded fields, and then click OK.
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Note: 

• Ensure that the UDC cache is cleared before you log in.

• If an UDC entry does not exist for an environment, the environment is displayed in the default Alta scheme.

• This feature is not supported with Internet Explorer 11 (IE11). Alta scheme will be the default scheme when you
log in to an environment using Internet Explorer 11.

Deleting a UDC  
You can delete UDCs from a UDC type, but do so with caution. Only delete UDCs as part of a coordinated plan within
your enterprise. For example, you might delete the F - Facilities UDC from the list of search types if you do not want
users to select that UDC.

If you delete a UDC, the system deletes only the code from the UDC type. UDC values in existing records are not deleted.

Note:  Do not delete hard-coded UDCs because JD Edwards EnterpriseOne applications might depend on them. Hard-
coded UDCs have the value Y in the Hard Coded field on the Work With User Defined Codes form.

Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne web client, from a System Setup
menu for your product, access the P0004A program, or enter UDC in the Fast Path field.

1. Complete the Product Code and User Defined Codes fields and click Find.
2. On the Work With User Defined Codes form, select the UDC from the detail area that you want to delete and

click Delete.

Note:  Ensure that you want to delete this UDC. The only way to replace a deleted UDC is to add it again.

3. Click OK to confirm that you want to delete the UDC.

Note:    Click here to view a recording of this feature.
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15  Using Oracle Content and Experience Cloud
for JD Edwards EnterpriseOne (Release 9.2.1.2)

Oracle Content and Experience Cloud for JD Edwards
EnterpriseOne Overview  
JD Edwards EnterpriseOne provides enterprise-level content and social collaboration through integration with Oracle
Content and Experience Cloud. This integration enables real-time enterprise conversations and real-time access to
content, connecting people and information in the cloud.

Note:  You can configure SSO-enabled JD Edwards EnterpriseOne system with Oracle Content and Experience Cloud.
See "Configuring Federation SSO in Content and Experience Cloud" in the JD Edwards EnterpriseOne Tools Security
Administration Guide  for more information.

The JD Edwards EnterpriseOne integration with Oracle Content and Experience Cloud offers you the following
capabilities:

• Interact with internal teams and work with external vendors or partners to accelerate decision making across
the enterprise.

• Connect and work efficiently across the organization regardless of role or location.

• Share large files such as presentations, documents, and images with employees internally and outside the
organization.

• Drive social conversations in the context of discussions, files, folders, teams, or projects.

• Manage real-time conversations between teams to provide resolutions to customer service requests quickly.

• Access business documents through the EnterpriseOne application, attach files to transactions and store them
in the cloud.

• Integrate any record or document into the conversation, from sales opportunities to support cases and
contacts. (Release 9.2.2)

To use Oracle Content and Experience Cloud, a system administrator must configure EnterpriseOne with Oracle Content
and Experience Cloud and set up an Oracle Content and Experience Cloud user account for you. See the chapter
"Configuring EnterpriseOne with Oracle Content and Experience Cloud" in the JD Edwards EnterpriseOne Tools Runtime
Administration Guide  for details.

Content and Social Collaboration in JD Edwards EnterpriseOne facilitates the following:

• User Conversations: Start or participate in social conversations about a topic of interest within EnterpriseOne
using the Conversations icon from the Social menu as shown in following graphic:
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For example, employees can communicate about processes, tasks, and awareness issues.

• User Documents (Release 9.2.2): Store your business documents in the cloud and organize documents from
within EnterpriseOne. Share and collaborate on files with others outside your organization. Add documents to
the cloud using the Documents icon from the Social menu as shown in the following graphic:

• Contextual Conversations: Start or participate in conversations about specific business records within
EnterpriseOne. Create conversations within the context of a transaction using the Conversation icon in the
header bar of the Attachment Manager as shown in following graphic:

For example, an Inventory Manager who has identified a lot that is on HOLD can create a real-time conversation
to alert the Sales team to avoid any further order/quote processing jobs.

• Contextual Documents: Add documents to the cloud and organize documents while still keeping them in the
context of your business record by using the Document icon in the header bar of the Attachment Manager as
shown in following graphic:

Creating a User Conversation  
Each user with a valid Content and Experience Cloud account can start an independent conversation about any
topic with the EnterpriseOne. The conversations are not tied to any business records. You can add members to the
conversation and share the conversation. Members can post comments in the conversation and reply to comments
from other members. This type of conversation is called user conversation. You can add files to an independent
conversation as attachments.

Note:  Before you start a conversation, ensure that the social connection softcoding record is created for the Content
and Experience Cloud user as mentioned in "Adding EnterpriseOne Users to Oracle Content and Experience Cloud"
section of the JD Edwards EnterpriseOne Tools Runtime Administration Guide .
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To start a user conversation:

1. Log in to the EnterpriseOne application.
2. Click the Social icon in the menu bar, and then select the Conversations icon.
3. In Sign In To ORACLE CLOUD, enter your Content and Experience Cloud user name and password, and then

click Sign In.

Note:  If you close the "Sign In To ORACLE CLOUD" window before entering your login credentials, click
Refresh in the "Waiting For Sign In Through Another Tab Or Window" screen to once again display the Oracle
Cloud sign in window.

4. In the Content and Experience Cloud pane, click Create to start creating a new conversation.
5. In Create New Conversation, enter a title for the conversation, and then click Create.

A conversation is started with the title that you entered.
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6. Enter your message in the conversation box and click Post. This adds your message to the conversation.

The following example shows a user conversation:

164



JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 15
Using Oracle Content and Experience Cloud for JD Edwards

EnterpriseOne (Release 9.2.1.2)

165



JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 15
Using Oracle Content and Experience Cloud for JD Edwards

EnterpriseOne (Release 9.2.1.2)

For information about the additional features of Content and Experience Cloud such as sharing or adding member to
conversation, see the section "Using Conversations to Collaborate" in the Using Oracle Content and Experience Cloud
Guide .

Minimizing and Maximizing Conversation Pane  
You can minimize a conversation pane to view other EnterpriseOne applications.

To minimize a conversation pane, click the Minimize icon displayed in the title bar. The conversation pane then appears
as a smaller pane in the right-hand side of the frame.

To maximize a minimized conversation pane, click the Maximize icon. The conversation pane appears in the same
position it was before you minimized it.

Resizing the Conversation Pane  
You can change the size of a conversation pane. Place the cursor on the border of the pane and drag the border as
required.

Note:  If you resize the conversation pane smaller than the default dimension, the Close icon might not be visible.
Drag the pane border towards the left to display the Close icon.

Viewing the Conversation in a Separate Browser Window  
Each conversation pane title bar includes a popup icon. When you click the popup icon, the conversation appears in a
separate browser window. The Content and Experience Cloud users can access conversations and private documents
from this browser window. Close the browser window to return to the application.

Closing the Conversation Pane  
Click the close icon in the conversation pane title bar to close the pane. Closing the pane does not log you out of Oracle
Cloud. When you click the Conversation icon again, the conversation pane is displayed, listing all the conversations that
you have access.

Adding User Documents to the Cloud (Release 9.2.2)  
You can upload content to the cloud from within EnterpriseOne, access the content from anywhere, and share content
within and outside your organization. Content items can be documents, images, video files, audio files, or presentations.
You can store multiple versions of the documents and reuse the content. You can add, view, and manage content stored
in Oracle Content and Experience Cloud from your computer, tablet or smartphone.
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Note:  Before you add documents, ensure that the social connection softcoding record is created for the Content and
Experience Cloud user as mentioned in "Adding EnterpriseOne Users to Oracle Content and Experience Cloud" section
of the JD Edwards EnterpriseOne Tools Runtime Administration Guide .

To add documents:

1. Open an EnterpriseOne application.
2. Click the Social icon in the menu bar and then select the Documents icon.
3. In Sign In To ORACLE CLOUD, enter your Content and Experience Cloud user name and password, and then

click Sign In.

Note:  If you close the "Sign In To ORACLE CLOUD" window before entering your login credentials, click
Refresh in the "Waiting For Sign In Through Another Tab Or Window" screen to once again display the Oracle
Cloud sign in window.

4. In the Content and Experience Cloud pane, use the Upload icon to select and attach multiple files to your folder.
Alternatively, you can use Windows Explorer to drag and drop the selected files into the folder area. The folder
area lists all the documents added.

5. Close the Content and Experience Cloud pane.
You can also edit the cloud documents through the Content and Experience Cloud interface.

For information about the additional features of Oracle Content and Experience Cloud such as adding users to
access content, previewing, managing version, and sharing, renaming, downloading, or deleting files, see the section
"Managing Your Content" in the Using Oracle Content and Experience Cloud Guide .

Creating a Contextual Conversation  
You can start a conversations about a topic related to a specific business record such as a sales order or incident report
within EnterpriseOne. In an EnterpriseOne application, you open a record and begin conversation by posting comments
and discussing that record. This type of conversation is called a contextual conversation.

Note:  Before you start a conversation, ensure that the social connection softcoding record is created for the Content
and Experience Cloud user as mentioned in "Adding EnterpriseOne Users to Oracle Content and Experience Cloud"
section of the JD Edwards EnterpriseOne Tools Runtime Administration Guide.

Note:   IDCS Environment. For additional information regarding requisite setup for JD Edwards EnterpriseOne
connections using the Oracle Identity Cloud Service (IDCS), refer to  "Configuring OAuth Services in IDCS" section of
the JD Edwards EnterpriseOne Tools Security Administration Guide.

To start a contextual conversation:

1. Open an EnterpriseOne application.
2. Select the row to which you want to add a conversation. Then select Row, Attachments, to open the Attachment

Manager side panel.

Note:  Contextual Conversations are supported only in Advanced Media Object Attachments. See Advanced
Media Object Attachments (Release 9.2.1) for more information about the setup required to enable the
Advanced Media Object Attachments functionality.
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3. Select the Conversations icon in the header of the side panel.
4. In Sign In To ORACLE CLOUD, enter your the Content and Experience Cloud user name and password, and then

click Sign In.

A conversation is started in context to the selected record. The Oracle Content and Experience Cloud pane
displays the application name as the title and the record number as the name of the conversation.

Note that Content and Experience Cloud authorization is required to access the conversation.
5. Enter your message in the conversation box and click Post. This adds your message to the conversation. Note

that for a contextual conversation, you cannot add a document in Content and Experience Cloud.
For more information about Conversations and features of Content and Experience Cloud, see "Using Conversations to
Collaborate" in the Using Oracle Content and Experience Cloud Guide .

Note:  Only users who are authorized to access that application can see the conversation.

Adding Contextual Documents  
You can upload contextual content to the cloud within EnterpriseOne. Content items can be documents, images, video
files, audio files, or presentations. You can store multiple versions of the documents and reuse the content.

Note:  Before you add a document, ensure that the social connection softcoding record is created for the Content and
Experience Cloud user as mentioned in "Adding EnterpriseOne Users to Oracle Content and Experience Cloud" section
of the JD Edwards EnterpriseOne Tools Runtime Administration Guide .

To add contextual documents:

1. Open an EnterpriseOne application.
2. Select the row to which you want to add a document. The Attachments column displays a paperclip icon if a

media object is associated with the row.
3. Select Row, Attachments, to open the Attachment Manager side panel.

Note:  Contextual Documents are supported only in Advanced Media Object Attachments. See Advanced
Media Object Attachments (Release 9.2.1) for more information about the setup required to enable the
Advanced Media Object Attachments functionality.

4. Select the Documents icon in the header of the side panel.
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5. In Content and Experience Cloud pane, use the Upload icon to select and attach multiple files. Alternatively, you

can use Windows Explorer to drag and drop the selected files into the folder area. The folder area lists all the
documents added for the specific record.

The following example shows a document attached to a transaction:
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For information on the types of files that can be uploaded, see "Restricting File Types and Sizes" in the
Administering Oracle Content and Experience Cloud Guide .

6. Close the Content and Experience Cloud pane.
The Attachment Manager lists the contextual cloud documents along with the media object attachments for the specific
record. You can differentiate the media object attachments from the contextual cloud files using the icons displayed in
the side panel. Icons for the cloud files contain a cloud symbol. You can preview the cloud files through the Attachment
Manager.

Using the Attachment Manager, you can find the contextual documents by either searching for or sorting files. The
system automatically sorts the files by name. For more information, see Finding Advanced Media Object Attachments in
this guide.

You can edit the contextual cloud documents through the Content and Experience Cloud interface. The Attachment
Manager does not allow you to set the contextual cloud documents as default, or download, rename, or delete the
documents.

For information about the additional features of Oracle Content and Experience Cloud such as adding people to content,
previewing, version management, sharing, renaming, downloading, or deleting files, see the section "Managing Your
Content" in the Using Oracle Content and Experience Cloud Guide .

Accessing Contextual Documents in Content and Experience
Cloud (Release 9.2.2)  
You can directly access the contextual cloud documents in Oracle Content and Experience Cloud without logging to
EnterpriseOne.

To access the contextual content:

1. Open an EnterpriseOne application.
2. Select the row that contains the documents you want to access in Oracle Content and Experience Cloud. The

Attachments column displays a paperclip icon if a media object is associated with the row.
3. Click the paperclip icon to display the Attachment Manager side panel. The side panel lists all the attachments

for the selected row.
4. Click the Documents icon in the header of the side panel. The system adds you as a contributor to the

corresponding documents folder in Content and Experience Cloud.
When you log in to Content and Experience Cloud, this folder will be in shared mode and you can access all the items in
the folder.

Note:  When you enable row security for a user, ensure that the attachments related to the specific row are not shared
with the user in Content and Experience Cloud.

Accessibility for Social Drop-down Menu (Release 9.2.2)  
The screen reader software reads the names of the links and the associated details when you navigate through the
Social menu. The Alt+S hot key brings the focus to the Social drop-down menu.
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16  Subscribing to Notifications (Release 9.2.2)

Understanding Subscriptions to Notifications  
JD Edwards EnterpriseOne notifications enable you to improve your business efficiency through the use of proactive
notifications that are actionable. Proactive notifications enable the system to notify users of business events as they
happen without the need for the user to be online.

Subscriptions to notifications are convenient, timely, and easy to set up. You can choose to subscribe to available
notifications and receive updates by email, email to SMS (Short Message Service) text message, as browser pop-up
messages, through the Work Center, or on the EnterpriseOne menu bar. By subscribing to notifications, you know when
key transactions or events occur without having to log in to EnterpriseOne. This close monitoring helps you respond
quickly and do your job more efficiently.

Note:  If using SMS to receive text messages, keep in mind that your mobile service provider may charge text
messaging fees.

You can add, delete or modify your notification subscriptions at any time.You use the Subscription Manager to create
and manage your subscriptions.

With Release 9.2.2.4, you can also view and, in some cases, modify or opt out of subscriptions that have been assigned
to you.

Within Subscription Manager, select the notification to which you would like to subscribe from a list of available
notifications and then define your subscription using these three sections:

• Configuration. Define general information and delivery instructions for your subscription.

• Inputs. View and override the notification inputs for the subscription. This section is only editable if the
notification has been designed to allow inputs from the subscriber.

• Policy. Specify more detailed instructions for when you want to receive a notification message. For example, if
the notification is Watchlist-based, do you want to be notified only when the Watchlist level changes to critical
or each time it remains critical?

Prerequisites  
A system administrator must complete the following prerequisites in order for you to subscribe to notifications.

• Turn on the notifications feature.

• Enable view security for existing notifications.

• If using email delivery, whether external or via the Work Center, set up mail preferences.

For more information, see "Setting Up JD Edwards EnterpriseOne Electronic Mail Components" in the JD
Edwards EnterpriseOne Tools Workflow Tools Guide.
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• To allow a user to select email as a delivery option, the system administrator must enable the setting in the
Notifications section in Server Manager: the Allowed External Delivery Methods setting must contain the
value "email." This is the default value for this setting. (Release 9.2.2.1)

• Perform all other prerequisites related to notifications.
For more information, see "Getting Started" in the JD Edwards EnterpriseOne Tools Notifications Guide.

A business analyst or notification designer must create and publish notifications so that you can subscribe to them.

Working with Subscription Manager  
Use the Subscription Manager to view, add, update, and delete your subscriptions to notifications.

With Release 9.2.2.4, you can also see the subscriptions to which you've been assigned. However, whether you can
update or opt out of those subscriptions depends on how the subscription was defined when it was created. You cannot
delete an assigned subscription; you can only opt out if you've been given that option by the subscription creator.

Use the Help icon in the upper-right corner of Subscription Manager to directly link to this documentation.

Use the About Subscription icon in the upper-right corner of Subscription Manager to see details about the subscription
and associated notification.

Adding a New Subscription  
To add a new subscription:

1. Log in to JD Edwards EnterpriseOne.
2. In the upper-right corner of the screen, click your login name.
3. Under the Personalization category, select My Subscriptions.

With Release 9.2.3, My Subscriptions is located under the Manage Notifications menu.
4. In Subscription Manager, click Add Subscription.

All of the available notifications to which you can subscribe are shown in alphabetical order and categorized by
whether they are personal, reserved, or shared notifications.
With Release 9.2.3.3, you can search for a particular notification name or notification description by typing it in
the Search field.

Note:  All of your personal notifications appear in the list, but for shared notifications, you only see the
notifications listed that you have view permissions for.

5. Select the notification to which you want to subscribe. You can hover over the notification to see the
notification description before you select it.

6. In the Configuration section, enter a subscription name. The default value is the notification name. Since you
can create multiple subscriptions over the same notification (for example, with different override values), you
may want to differentiate the subscription name from the notification.

7. With Release 9.2.3, you can enter a message heading to differentiate between notification messages when they
are received. The message heading appears in the Notification List tab of the Message Center, the Notification
Bell drop-down list, Work Center messages, and in emails. It is also a sort option in the Notification List tab in
the Message Center.

8. Select the delivery methods for your notification. You must select at least one of the following:
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◦ Select Notification List to receive your notifications in the Notification List (bell icon) on the JD Edwards
EnterpriseOne menu bar.

With Release 9.2.3, when you select Notification List, the Category field appears. You can enter anything
within the 30-character limit here to categorize your notification messages.

With Release 9.2.3.3, there is a drop-down list of available categories if any exist. You can choose from
these or enter a new value in the Category field.

Category is useful because the value you enter here will appear in both the Notification List tab in
Message Center and in the Notification Bell drop-down list. You can sort by the category value in the
Message Center.

With Release 9.2.3.3, click the Share button if you want to save your category for reuse by others.

Note:  The Share button is only available if an administrator has given you access to and the ability
to add values in the Category Manager application (P980058). For more information on Category
Manager, see Working with Notification Categories in the JD Edwards EnterpriseOne Tools Notifications
Guide.

◦ Select Work Center to receive a message in the Work Center application or receive an email through
EnterpriseOne Work Center. You must have Work Center set up properly to use this option.

◦ Select Email and enter the email address to have the notification delivered via email. You can enter
multiple email addresses separated by a semicolon. If external email has not been allowed by your
system administrator, this option does not appear. See Prerequisites.

You can also use the SMS format for your mobile carrier to have the notification email sent to your mobile
device via text message.

Note:  If using SMS to receive text messages, keep in mind that your mobile service provider may
charge text messaging fees.

9. In the Inputs section, you see the notification's inputs and default values.

Note:  Depending on how the notification was defined, this section may be viewable and not changeable.

If the notification designer has allowed overrides to the notification inputs, you can enter the override values
for your subscription. In some cases, the value is required and you must either enter an override value or accept

175

olink:EOTNF629


JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 16
Subscribing to Notifications (Release 9.2.2)

the default value. Before entering the override value, you see a hint in the Override Value field that describes
the type of information you need to enter. The override value types you might enter are:

◦ Text

◦ Number

◦ Time in Milliseconds

◦ Date in MM/dd/yyyy Format

◦ Date in dd/MM/yyyy Format

◦ Date in MM/dd/yy Format

◦ Date in dd/MM/yy Format

◦ Date in yyyy/MM/dd Format

◦ Date in yy/MM/dd Format

◦ Date/Time in yyyy-MM-dd'T'HH:mm:ss:SSSZ Format

The format will be validated when you click Save.
10. The information in the Policy section is dependent on whether the notification output type is a string, number,

Watchlist level, or Boolean (true/false). You can find this information by clicking the About Subscription icon in
the upper-right corner of Subscription Manager.

For every output value type, you can select to be notified only once or always. If you select "Only Once" for the
Notify Me field, your subscription is deleted after you have been notified once. If you select "Always," you are
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notified each time the notification runs and meets the criteria (for example, your overrides or other logic that
the notification designer included). For the string and number output types, these are the only two options.

If the output value type is Boolean, you can also select to be notified only if the rules that you define are met.
For Boolean, you can define one or more rules that specify to notify you if the boolean value:

◦ Changes

◦ Changes to True

◦ Changes to False

◦ Equals True

◦ Equals False

If the output value type is a Watchlist Level, you can also select to be notified only if the rules that you define
are met. For Watchlists, you can define one or more rules that specify to notify you if the Watchlist level:

◦ Changes

◦ Changes to Critical

◦ Changes to Warning

◦ Changes to Normal

◦ Equals Critical

◦ Equals Warning

◦ Equals Normal

Use the plus and minus icons to add and delete rules. "Or" logic is used when you add multiple rules, which
means you will receive a notification message as long as one of the rules is true.

11. When you are finished defining your subscription, click the Save icon in the upper-right corner. If you have any
errors or warnings, an exclamation point icon appears next to the Save icon and the errors or warnings appear
next to the related fields. Correct or review the errors or warnings, and then click Save again. For warning
messages about the email format, you can choose to ignore the warning by clicking Save for the second time.

Your newly created subscription appears in the left column in alphabetical order.

Updating a Subscription  
Once you have created a subscription, you may want to update the subscription to, for example, change the delivery
method or how often you are notified.

With Release 9.2.2.4, you may also want to update a subscription that was assigned to you. If the assigned subscription
has been designed to disallow particular updates, you will see a lock icon next to the opt out option, delivery methods,
inputs, or policy accordingly.
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To update an existing subscription:

1. In Subscription Manager, a list of your subscriptions appears on the left side of the form.
With Release 9.2.2.4, both your subscriptions and assigned subscriptions appear in the list and can be easily
differentiated by the icon to the left of the subscription name. By hovering over an assigned subscription name,
you can see the role for which the subscription was created.
With Release 9.2.3.3, the icon to the left of an assigned subscription name is gray if you have opted out.

2. With Release 9.2.3.3, use the Show and Search fields to filter the subscription list.
a. Select one of the following values from the Show drop-down menu to display all or a subset of the

subscriptions:
All. Show all subscriptions.
Personal. Show only personal subscriptions.
Assigned. Show only subscriptions to which you've been assigned.
Assigned - Opt In. Show only subscriptions to which you've been assigned and opted in.
Assigned - Opt Out. Show only subscriptions to which you've been assigned and opted out.

b. Use the Search field to limit the subscription list to subscriptions with a notification name, notification
description, subscription name, or role matching your text.

3. Select your subscription and make the appropriate updates.
For more information on specific fields and options, see Adding a New Subscription.

4. With Release 9.2.2.4, you see an Opt Out option for assigned subscriptions. If the subscription was designed to
allow it, you can use this option to stop receiving notifications for the assigned subscription.

5. For assigned subscriptions, click the Reset button if you want to revert to the original subscription as it was
assigned to you and discard any of your changes.

6. Click the Save icon in the upper-right corner. If you have any errors or warnings, an exclamation point icon
appears next to the Save icon and the errors or warnings appear next to the related fields. Correct or review
them and click Save again. For warning messages about the email format, you can choose to ignore the
warning by clicking Save for the second time.

Deleting a Subscription  
You may want to delete a subscription for any of the following reasons:

• You are no longer interested in being alerted to a particular notification.

• The notification upon which your subscription is based has been deleted so your subscription is no longer valid.

• Your view security has changed, blocking the notification and making your subscription invalid.

To delete a subscription:

1. In Subscription Manager, select the subscription to delete from the list of subscriptions on the left.
2. Click the Delete icon in the upper-right corner.
3. On the "Are you sure you want to delete this subscription?" verification window, click OK.

Note:  You cannot delete an assigned subscription in Subscription Manager. For more information on assigned
subscriptions, see Assigning Subscriptions in the JD Edwards EnterpriseOne Tools Notifications Guide. (Release 9.2.2.4)
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Working with Received Notifications  
Once you have defined your subscriptions, you begin to receive the notifications that interest you. When the
Notifications feature is enabled, a Notification List bell-shaped icon appears in the JD Edwards EnterpriseOne menu
bar. If you have selected Notification List as a delivery method for your subscription, the number located in the circle on
the Notification List icon is updated each time you receive a new notification message.

If you have elected to allow browser pop-ups and you have a running JD Edwards EnterpriseOne session, you also
receive a pop-up notification message each time a new notification message is received. You see the browser pop-up
even if EnterpriseOne is minimized or on a different browser tab.

Note:  Pop-up messages are not supported in all browser types. Interaction with the pop-up notification takes you
back to JD Edwards EnterpriseOne, where you can access the Notification List.

With 9.2.3, you can also use the Message Center (P980051X) to view your notifications. Message Center can be accessed
from the Manage Notifications menu that appears when you click on your user name in the upper right corner of the
EnterpriseOne tool bar. For more information on Message Center, see Message Center (Release 9.2.3).

Viewing Notifications in the Notification List  
If you are using the Notification List delivery method for your subscriptions, the number of unread notification
messages is updated each time you receive a notification message. You can find this number in a circle on the
Notification List icon in the JD Edwards EnterpriseOne menu bar.

To view your notifications:

1. Select the Notification List icon to view a list of notifications that you have received. You can also see the date
and time that each notification was received.

With Release 9.2.2.4, only the newest 20 notifications are displayed in the list. To view older notifications, use
the arrows at the bottom of the list.

Starting with release 9.2.3.1, the icons for each notification only appear when you hover over or select the
message from the list.

2. If a notification is new or unread, the title will be in bold. You can mark the notification as read or unread by
clicking on the circle to the left of the notification subject.

3. To view the notification message details, click on the subject of the notification.
4. To delete the notification, click the Delete icon.
5. If the notification designer attached an application shortcut to the notification, you can access the related

application by clicking the application icon to the right of the notification subject.

Starting with Release 9.2.3.2, a message may contain multiple shortcuts. If a message has more than one
shortcut, you see an Actions drop-down list instead of an application icon. If a message has one shortcut, you
see a text link for that shortcut.

With Release 9.2.3.3, the Actions drop-down list may contain, not only links to applications, but also links to
notifications, orchestrations, URLs, EnterpriseOne reports, or BI Publisher reports, if the notification designer
has included them in the message. Links to reports will take you to that report in the Work with Submitted Jobs
application.
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Working with Notification List Messages  
When you access the notification message, you can view the details of the notification and access a related application
if a shortcut has been provided. If you open the message from the Notification List on the JD Edwards EnterpriseOne
menu bar, you can also delete the notification message and access Subscription Manager where you can manage your
subscription.

To access the related application:, click on the application shortcut in the message. There will only be a shortcut if the
notification designer has included one.

With Release 9.2.3.2, the notification designer can include multiple shortcuts in a message.

With Release 9.2.3.3, the notification designer can include links to applications, orchestrations, notifications, URLs,
EnterpriseOne reports, or BI Publisher reports. Links to reports will take you to that report in the Work with Submitted
Jobs application.

Starting with Release 9.2.3.0, to access the Message Center application, click the Message Center icon at the bottom left
of the Notification List.

To access the Subscription Manager, click the Manage Subscriptions icon in the upper-right corner of the detailed
message.

To delete the notification message, click the Delete icon in the upper-right corner of the detailed message.

With Release 9.2.2.4, to see the subscription name and other information about the notification, click the Additional
Information icon in the upper-right corner of the detailed message.

Troubleshooting  
In some instances, you might receive an error message rather than the expected notification message or you might feel
that you are receiving too many notifications. This section describes some of the errors you might encounter and their
possible causes. It also provides some suggestions if you are receiving too many notifications.

Notification Not Found in Subscription Manager  
If "Notification Not Found" appears below your subscription's name in the left pane in Subscription Manager, this
means that the notification upon which your subscription is based as been deleted or you no longer have access to it
due to a change in UDO security. Contact the notification designer or your system administrator.

Required Fields Missing  
If you receive a "981B - Required Fields Missing" error in your notification message, this means that your notification
has required inputs that were either not sent in, defaulted in, or set as overrides.

In Subscription Manager, review the inputs you have selected or defined as overrides for your subscription. They can be
found in the Inputs section of the form.

Notification Access Error  
If you receive a "981C - Notification Access Error" in your notification message, this means that a component of the
notification (for example, an orchestration, Watchlist or rule) is not visible to you.
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This may be a UDO security issue. Contact your system administrator or notification designer.

Error Processing Notification  
If you receive a "981D - Error Processing Notification" in your notification message, it means that something failed while
processing the notification.

Contact your system administrator or notification designer.

Receiving Too Many Notifications  
If you find that you are receiving too many notification messages, there are a few things that you can do:

• Delete the subscription if the information is not valuable to you.

• Review the inputs you've defined for the subscription in Subscription Manager and update as appropriate.

• Review the policy that you have defined for the subscription in Subscription Manager and update as
appropriate.

• With Release 9.2.2.4, if the subscription is an assigned subscription, either opt out or speak to your manager or
the assigner of the subscription about changing the delivery policy or opting out.

• Speak with the notification designer about adding a rule or modifying the existing rule on the notification to
allow filtering of the notification.

See the  JD Edwards EnterpriseOne Tools Notifications Guide.

Discrepancy Between Number of Records in Notification vs. Application (Release
9.2.2.4)  
In some cases, you may see a different number of records mentioned in a notification message than what you see in the
application or Watchlist. This occurs when the notification designer has elected to run the notification as a proxy user
rather than as the subscriber (Run As Subscriber option is off), and the data security settings differ between the two
users.

Cannot Save a Subscription in Subscription Manager  
If you are unable to save your subscription in Subscription Manager and are running Oracle JDBC driver 12.1.0.2 on the
HTML Server, you may need to down-grade to version 12.1.0.1.
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17  Message Center (Release 9.2.3)

Message Center (Release 9.2.3)  
This chapter contains the following topics:

• Message Center Overview

• Prerequisites

• Using the Message Center

• Working with Notification Messages

• Working with Work Center Messages

• My Worklist

Message Center Overview  
The Message Center application (P980051X) provides access to both notifications and Work Center messages. The
straightforward user interface allows you to view all of your messages in a list and perform various tasks, such as
sorting messages, reading messages in the reading pane, deleting, and marking as unread.

For notification messages, you can also use any links included in the message and you can access the Subscription
Manager application from the Message Center by using the Manage Subscriptions icon in the upper-right corner of
the reading pane.

For Work Center messages, you can also view attachments, such as text attachments and JDE shortcuts, and launch the
Work Center application.

For more information on notifications, see:

• Subscribing to Notifications (Release 9.2.2)

• JD Edwards EnterpriseOne Tools Notifications Guide

For more information on Work Center messages, see Messages and Queues

Prerequisites  
In order to see notifications in the Message Center, the notifications feature must be turned on and you must have
subscribed to notifications.

In order to see the Work Center tab in the Message Center, you must have access to the Work Center application
(P012503) and appropriate media object security.

For more information, see:

• JD Edwards EnterpriseOne Tools Notifications Guide

• Managing Media Object Security in the JD Edwards EnterpriseOne Tools Security Administration Guide
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Using the Message Center  
To access the Message Center:

1. Log in to JD Edwards EnterpriseOne.
2. In the upper-right corner of the screen, click your login name.
3. Under the Personalization category, open the Manage Notifications menu.
4. Select Message Center.

Working with Notification Messages  
Use the Message Center to view notification messages that you've received.

To work with notification messages:

1. Select the Notification List tab.

The tab displays the number of unread messages in a red circle.
2. Select All to view all notification messages or Unread to view only unread messages.
3. Use the Search field to look for specific messages. The search runs over values in the Heading, Subject,

Subscription Name, Category, Message, and Notification Date fields.
4. Use the Sorted By: drop-down menu to sort by category, heading, notification date, role, subject, or

subscription.
5. Use the 

icon to switch between ascending and descending sort order.
6. Select the Show in Groups check box to group the messages by the sort criteria.
7. When messages are shown in groups, you can expand and collapse the groups using the 

icon.

The group header shows how many messages are in each group and has a delete icon that enables you to
delete all of the messages in the group at once.

8. Use the 

icon to collapse all of the groups that are open.
9. The bar at the bottom of the messages shows you a total count of notification messages, as well as how many

messages are displayed if that number is different.
10. Use the Refresh icon on the left side of the bottom bar to retrieve any new notifications you may have received

while in the Message Center.
11. To view message details, click on the message and the details appear in the reading pane on the right side of

the screen. There is no reading pane when the application is embedded in an EnterpriseOne page.

Notice that the message also changes from unread to read and the number of unread messages in both the
Notifications List tab and Notifications List on the EnterpriseOne toolbar decrease.

12. You can use application links or delete individual notification messages by using the icons that appear when
you hover over or select a message in the list.
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Starting with Release 9.2.3.2, a message can have multiple actions (such as application links) associated with
it. If the notification message has more than one action, an Actions drop-down list is available when you hover
over or select that message in the list. You can then select the action from the drop-down list. If there is just one
action for the message, you will see a text link for that one action instead of the Actions drop-down list.
With Release 9.2.3.3, the Actions drop-down list may contain, not only links to applications, but also links to
notifications, orchestrations, URLs, EnterpriseOne reports, or BI Publisher reports, if the notification designer
has included them in the message. Links to reports will take you to that report in the Work with Submitted Jobs
application.

13. Use the Additional Information icon, in the upper right corner, to view the following details about a
notification message:

◦ Message Information
- Subject
- Heading
- Category
- Received. Specifies the date and time a message was received.
- Received (GMT). Specifies the date and time in GMT format.

◦ Subscription Information
- Subscription Name
- Subscription Source. Specifies where the subscription was created. Values are "Assigned

Subscriptions" or "My Subscriptions."
- Subscription ID
- Notification ID
- Run As Subscriber. Specifies whether the notification was created with the Run As Subscriber

option on or off. Values are "True" or "False."

Working with Work Center Messages  
Use the Message Center to view any Work Center messages that you've received.

To work with Work Center messages:

1. Select the Work Center tab.
The tab displays the number of unread messages in a red circle.
When you first view your Work Center messages, by default, they are sorted in ascending order by queue (02/
MB UDC code) and shown in groups.

2. Select All to view all Work Center messages or Unread to view only unread messages.
3. Use the Search field to look for specific messages. The search runs over the date, queue, and subject fields only.
4. Use the Sorted By: drop-down menu to sort by default (02/MB UDC code), message date, subject, or queue

name.
If sorting by date or subject, messages in the Deleted queue are hidden.

5. Use the 

icon to switch between ascending and descending sort order.
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6. Select the Show in Groups check box to group the messages by the sort criteria.
7. When messages are shown in groups, you can expand and collapse the groups using the 

icon.
The group header shows how many messages are in each group and has a delete icon that enables you to
delete all of the messages in the group at once.

8. Note that delete functions as it does in the Work Center. Deleting messages from any queue other than the
Deleted queue, moves those messages to the Deleted queue. Deleting from the Deleted queue, permanently
deletes the messages.

Note:  If you do not see the delete icon, you may not have permission to delete media objects. Contact
your administrator. You cannot delete Work Center messages that have open tasks. You will receive an error
message if one or more messages could not be deleted.

9. Use the 

icon to collapse all of the groups that are open.
10. The bar at the bottom of the messages shows you a total count of messages, as well as how many messages

are displayed if that number is different.
11. Use the Refresh icon on the left side of the bottom bar to retrieve any new messages you may have received

while in the Message Center.
12. To view message details, click on the message and the details appear in the reading pane on the right side of

the screen. There is no reading pane when the application is embedded in an EnterpriseOne page.
Notice that the message also changes from unread to read and the number of unread messages on the Work
Center tab decreases.

13. You can launch the Work Center, access attachments (text or JDE shortcuts), or delete individual Work Center
messages by using the icons that appear when you hover over or select a message in the list.
Starting with Release 9.2.3.2, a message can have multiple actions attached to it. An action might be an
application shortcut. If the message has more than one action, an Actions drop-down list is available when you
hover over or select that message in the list. You can then select the action from the drop-down list. If there is
just one action for the message, you will see a text link for that one action instead of the Actions drop-down list.
With Release 9.2.3.3, the Actions drop-down list may contain, not only links to applications, but also links to
notifications, orchestrations, URLs, EnterpriseOne reports, or BI Publisher reports, if the notification designer
has included them in the message

Note:  (Release 9.2.3.2) The Actions drop-down list for a Work Center message contains a subset of the
attachment objects for that message. Only JDE shortcut attachments are included in the Actions drop-down
list.

14. You can also mark an individual message as read/unread, launch the Work Center, and delete the message
using the icons in the upper-right corner of the reading pane.
If you do not see the Mark as Read/Unread icon, the message is locked and read only. In this case, you must
use Work Center to interact with the status of the message. This happens when:

◦ The message is in a Sent, Deleted, or Archived queue.

◦ The message requires a read receipt.

◦ The message has workflow attached to it.
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My Worklist  
My Worklist is a composed page that includes the Message Center. In addition to Message Center, this composed page
(CMP_1807020001JDE) also includes a Watchlist pane for watchlists to which the user has access, and the Orchestrator
Health pane.

The Message Center in My Worklist functions the same way as described in this chapter. The only difference is that
message details appear in a pop-up window instead of in the reading pane.

The Orchestrator Health pane in My Worklist provides a way to monitor the health of your orchestrations and
notifications without having to access the Orchestrator Monitor. You can download My Worklist from the Update Center
or by using Change Assistant. Search for the following bug numbers to do so:

• 28129990 for Release 9.2

• 28389398 for Release 9.1

For more information, see:

• "Using Change Assistant" in the JD Edwards EnterpriseOne Tools Software Updates Guide.

• "Understanding Orchestrator Health Data" in the JD Edwards Tools Orchestrator Guide.
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18  Understanding External Forms (Release
9.2.1)

External Forms Overview  
An external form is the window through which users interact with an external application like an ADF application, a JET
page, a Composed EnterpriseOne Page, or a Soft Coding Reference.

The principle value of an external form is that it provides a direct link to an external application and allows it to be
displayed within an EnterpriseOne web client. This means it can be a task, within a Composed EnterpriseOne Page, on a
menu, linked to from an EnterpriseOne page, or accessed through FastPath.

External forms can also be secured just like any other application. You can pass values into the external application
using the data structure of the external form. You can also use static text controls on the external form, so when the
external form is called using the AIS form service, those static text fields will be returned as translated labels.

Before creating your external form, you must have your external content first, whether that is an ADF application,
EnterpriseOne Page/JavaScript, or Composed EnterpriseOne Page. You should also know what kind of input is
expected, so you can provide the correct data structure members in the external form. Then you can create the external
form in FDA for that content.

See External Forms Overview in the   JD Edwards EnterpriseOne Tools Form Design Aid Guide   .

External Application Property  
This section discusses how to find the objects that are referenced by the External Application field in the Form Design
Aid.

JavaScript  
You can find the JET (JavaScript) object name by following these steps:

1. On the EnterpriseOne screen, click the user personal information located on the right side of the banner bar at
the top.

2. Under the Personalization category, click the Manage Content link, then click Classic Pages.
3. Select the name of the Classic Page that represents your JET object and click the information icon.

The About form displays the EnterpriseOne Page information including the Object Name. You can copy the
Object Name from here.

You can also look up the object name in P98220W.
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Composed EnterpriseOne Page  
You can find the Composed EnterpriseOne Page object name by following these steps:

1. On the EnterpriseOne screen, click the user personal information located on the right side of the banner bar at
the top.

2. Under the Personalization category, click the Manage Content link, then click Composed Pages.
3. Select the name of the Composed EnterpriseOne Page that you are looking for and click the information icon.

The About form displays the Composed EnterpriseOne Page information including the Object Name. You can
copy the Object Name from here.

You can also look up the object name in P98220W.

Soft Coding Reference (Release 9.2.5.3)  
For Soft Coding Reference applications, additional information such as language could be passed to the external
application to localize the web applications to match the EnterpriseOne preferences.

The value in the External Application Type field points to a record in the soft coding table.

You use the Add Soft Coding Record form to add a new soft coding record to define the external application. The Soft
Coding Records application is P954000.

Access the Soft Coding Record form (P954000) and enter the appropriate information in the following fields:

See Working with Softcoding.

User/Role

Enter your JD Edwards EnterpriseOne user ID and role (such as *Public).

Environment Name

Enter the name of the JD Edwards EnterpriseOne environment in which you are working.

Template Name

Leave this blank.

Record Type

Select the record type as External Form.

SoftCoding Key

Enter a unique key specific to the project. Make sure that this Soft Coding Key matches the value in the External
Application Name field in the Form Design Aid (FDA). This record is defined for a specific user and an environment.

The user in the soft coding table follows the user|role hierarchy, where the user level data is retrieved, then roles is
retrieved if user data is not found, and at last *PUBLIC is retrieved.

The softcoding key is a way to tie together user and environment for a given external application.
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SoftCoding Description

Enter a valid description of the record.

SoftCoding Value

Define the parameters that you want to pass to the external application. The values can be EnterpriseOne properties,
variables, and hard-coded values. These values are fetched during runtime and the system builds the URL with these
values when you launch the external application.

Refer to the example template at the end of this section and enter the following values in the tags:

EndPoint: Enter the full path to the external application in the <endpoint> tag. This is a required value.

Type: Enter the type. The value for the <type> tag can be VBCS or URL. This is a required value.

Custom Parameters: Define custom parameters in the <customParams> tag. There are 4 elements in each <customParam>
tag: <isE1>, <e1Property>, <paramValue> and <paramVariable>.

EnterpriseOne Property: The supported types for the <e1Property> tag are: FI, PO (Release 9.2.5.4), PROFILE, AIS, and
JAS. Here, FI, PO (Release 9.2.5.4), and PROFILE are generated as JSON objects. In order to pass E1 Property, set <isE1>
to true.

The system passes AIS and JAS to VBCS type application by default.

EnterpriseOne Variable: When <isE1> is set to false, FI<ID in the form data structure>, PO<ID in the PO data structure>
(Release 9.2.5.4), AIS, JAS, userName, userId, userLongId, addressNumber, userLang, environment, role, userLocale,
dateFormat, dateSeparator, and decimalFormat can be defined in the <paramVariable> tag.

Note:  The <paramName> tag should be defined in all the <customParam> tags. The value in the <paramName> tag should
match the value that the external application retrieves from the http request. For example, if an external application
reads “userLanguage” from the request, then “userLanguage” must be set in <paramName>.

Hard-coded Values: You can also use the hard-coded parameter values in the template.

Example Template:

 
<external> 
<endpoint>full path to the external application</endpoint>
<type>VBCS</type>
<customParams>
 <customParam>
 <isE1>true</isE1>
 <e1Property>PROFILE</e1Property>
<paramName>userProfile</paramName>
 </customParam>
 <customParam>
 <isE1>false</isE1>
<paramName>orderNumber</paramName>
<paramValue></paramValue>
<paramVariable>FI4</paramVariable>
</customParam>
<customParam>
<isE1>false</isE1>
<paramName>docNumber</paramName>
 <paramValue></paramValue>
<paramVariable>PO4</paramVariable>
</customParam>
<customParam>
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<isE1>false</isE1>
<paramName>language</paramName>
 <paramValue></paramValue>
<paramVariable>userLang</paramVariable>
</customParam>
<customParam>
<isE1>false</isE1>
<paramName>extraParam</paramName>
<paramValue>embededMode</paramValue>
<paramVariable></paramVariable>
</customParam>
 </customParams>
</external>
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19  Integrating Oracle Guided Learning (OGL)
with JD Edwards EnterpriseOne (Release
9.2.7.3)

Overview  
Oracle Guided Learning (OGL) is an Enterprise cloud platform that supports the creation of personalized, guided, and
contextual user onboarding visualizations.

Integrating OGL with JD Edwards enables users to quickly master the processes and it also helps to accelerate the
adoption of JD Edwards applications by providing step-by-step guidance to complete a task in the flow of work.
Additionally, the information can be accessed through a widget.

For more information on working with OGL editor and creating the OGL content, see the   Oracle® Guided Learning
User Guide.

Note:    Click here to view a recording of this feature.

Note:    Click here to view the FAQ document of this feature.

Creating an OGL Connection  
Use the Soft Coding Records (P954000) application to create a connection to OGL. You can type P954000 in the Fast
Path or use this path to navigate to the Soft Coding Records application:

Navigator > EnterpriseOne Menus > EnterpriseOne Life Cycle Tools > System Administration Tools > Soft Coding
Administration > Soft Coding Records

To create an OGL connection:

1. Access the P954000 application.
2. Click Add.
3. In the User/Role field, enter the EnterpriseOne user, role, or *PUBLIC.
4. In the Environment Name field, enter the EnterpriseOne environment for which you are creating an OGL

connection.
5. In the Template Name field, enter OGL_CONNECTION.

Note:  You can use the Visual Assist (Search) icon to search for and select the OGL_CONNECTION template.

6. In the Soft Coding Key field, enter OGL_CONNECTION.
7. Click the Populate Soft Coding Value button to populate the Soft Coding Description and Soft Coding Value

fields with the information from the OGL_CONNECTION template.
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Note:  The Record Type field is left blank by default.

8. In the Soft Coding Value field, replace the Application ID in the Soft Coding Value for your connection. Also,
ensure that the endpoint is valid. Contact your system administrator and change the endpoint if required.

Note:  Application ID is unique for an account. Your Application ID can be found in your OGL provisioning
document and in the Setup tab of the OGL Console. For more information, contact your system administrator.

9.  <webservice>
 <endpoint>guidedlearning.oracle.com/player/latest/static/js/iridizeLoader.min.js</endpoint>
 <properties>
 <property><name>oglappid</name><value>Application ID</value></property>
 <property><name>route</name><value>E1Pages</value></property>
 <property><name>env</name><value>prod</value></property>
 </properties>
 </webservice>

10. Click OK to save the record.

Note:  You must log out and log back in to the JD Edwards EnterpriseOne application to view the OGL widget
on the EnterpriseOne pages.

Accessing the OGL Library  
To acess the OGL library:

1. Log in to the JD Edwards EnterpriseOne application.
2. Click the Help Center widget.

The system displays the Oracle Guided Learning window.
3. Note:  The content displayed in the Oracle Guided Learning window depends on the Application ID entered in

the Soft Coding Value field while creating the OGL_CONNECTION using the Soft Coding Records (P954000)
application.

4. Use the Search field or the tab in the left side of the window to search for the required information.

Note:  You can click the Language icon to change the language settings.
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20  Appendix A - JD Edwards EnterpriseOne
Software Systems

JD Edwards EnterpriseOne Software Systems  
This appendix provides a list of the JD Edwards EnterpriseOne systems.

The following table identifies the JD Edwards EnterpriseOne systems:

Number System

00
 

Foundation Environment
 

00S
 

Foundation Self Service
 

01
 

Address Book
 

02
 

Electronic Mail
 

03
 

Accounts Receivable
 

0301
 

Credit Management
 

03B
 

Enhanced Accounts Receivable
 

03C
 

Issue Management System
 

04
 

Accounts Payable
 

05
 

Time Accounting and HRM Base
 

05A
 

PeopleSoft HR & PR Foundation
 

05C
 

E1 HR & PR Foundation Canadian
 

05T
 

Time Entry
 

05U
 

E1 HR & PR Foundation US
 

06
 

Payroll (old)
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Number System

07
 

Payroll
 

07S
 

Payroll SUI
 

07Y
 

U.S. Payroll Year End
 

08
 

Human Resources
 

08A
 

eRecruit
 

08AD
 

ADP Integration
 

08B
 

Benefits Administration
 

08C
 

PeopleSoft HR Canadian
 

08H
 

Health and Safety
 

08LM
 

HCM Learning Management Integration
 

08P
 

Position Control
 

08R
 

Recruitment Management
 

08U
 

PeopleSoft HR US
 

08W
 

Wage and Salary
 

08Y
 

Affordable Care Act
 

09
 

General Accounting
 

09E
 

Expense Reimbursement
 

09J
 

Joint Venture Management
 

10
 

Financial Reporting
 

10C
 

Multisite Consolidations
 

11
 

Multicurrency
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Number System

11C
 

Cash Basis
 

12
 

Fixed Assets
 

13
 

Plant/Equipment Management
 

13C
 

Condition-Base Maintenance
 

13E
 

Equipment Cost Analysis
 

13R
 

Resource Assignments
 

14
 

Modeling, Planning & Budgeting
 

15
 

Real Estate Management
 

15L
 

Adv Real Estate Forecasting
 

15LX
 

Exa AREF
 

16
 

Profit Management (EPS)
 

17
 

Customer Service Management
 

17C
 

Call Management
 

18
 

Resource Scheduling
 

19
 

Utility CIS
 

30
 

Product Data Management
 

3010
 

Process Data Management
 

31
 

Shop Floor Control
 

3110
 

Process Control
 

31A
 

Manufacturing Accounting
 

31B
 

Blend Management
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Number System

31F
 

Apparel for Manufacturing
 

31P
 

Engineer To Order
 

32
 

Configuration Management
 

32C
 

Custom Works
 

33
 

Capacity Planning
 

34
 

Requirements Planning
 

34A
 

Advanced Planning & Scheduling
 

34X
 

In-Memory Planning Advisor
 

35
 

Enterprise Facility Planning
 

36
 

Forecasting
 

37
 

Quality Management
 

38
 

Agreement Management
 

39
 

Advanced Stock Valuation
 

40
 

Inventory/OP Base
 

4010
 

Advanced Price Adjustments
 

40G
 

Grower Management
 

40P
 

Promotions Management
 

40R
 

Demand Scheduling
 

40S
 

Supply Chain Self Service
 

41
 

Inventory Management
 

41B
 

Bulk Stock Management
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41F
 

Apparel Management
 

41V
 

Product Variants
 

42
 

Sales Management
 

42A
 

Sales Force Automation
 

42B
 

Sales Order Entry
 

42E
 

ECS Sales Management
 

42I
 

Outbound Inventory Management
 

42S
 

Customer Self Service
 

42W
 

Fulfillment Management
 

42X
 

In-Memory Sales Advisor
 

43
 

Procurement
 

43A
 

Purchase Order Receipt/Routing
 

43B
 

Voucher Match and Landed Cost
 

43BW
 

Buyer Workspace
 

43C
 

Contracts
 

43E
 

Requisition Self Service
 

43Q
 

Strategic Sourcing
 

43S
 

JSSS/Supplier Self Service
 

44
 

Subcontract Management
 

4401
 

Homebuilder Management
 

44H
 

Homebuilder Management
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45
 

Advanced Pricing
 

46
 

Warehouse Management
 

46L
 

License Plating
 

46R
 

RFID Outbound
 

47
 

Electronic Commerce
 

48
 

Work Order Processing
 

48S
 

Service Billing
 

49
 

Transportation Management
 

50
 

Job Cost Base
 

51
 

Job Costing
 

51F
 

Advanced Job Forecasting
 

51X
 

In-Memory Project Management
 

52
 

Contract Billing
 

52G
 

Proj & Gov Contract Accounting
 

53
 

Change Management
 

54HS
 

Health & Safety Incident Mgt
 

54R
 

Rental Management
 

55 - 59
 

Reserved for Clients
 

60 - 69
 

Reserved for JDE Custom
 

70
 

Multinational Products
 

71
 

Client Server Applications
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72
 

World Vision
 

73
 

M & D Complementary Products
 

74
 

EMEA Localization
 

74A
 

Austria
 

74B
 

Begium Localization
 

74C
 

Switzerland
 

74D
 

Germany
 

74F
 

France
 

74G
 

Greece
 

74H
 

Hungary
 

74I
 

Ireland
 

74L
 

Portugal
 

74M
 

Denmark
 

74N
 

Netherlands
 

74O
 

Norway
 

74P
 

Poland
 

74R
 

Russia
 

74S
 

Spain
 

74T
 

Turkey
 

74U
 

United Kingdom Localizations
 

74V
 

Finland
 

201



JD Edwards EnterpriseOne Tools
Foundation Guide

Chapter 20
Appendix A - JD Edwards EnterpriseOne Software Systems

Number System

74W
 

Sweden
 

74X
 

South Africa
 

74Y
 

Italy
 

74Z
 

Czech Republic
 

75
 

ASEAN Localization
 

75A
 

Australia
 

75C
 

China
 

75H
 

Thailand
 

75I
 

India
 

75J
 

Japan
 

75K
 

Korea
 

75O
 

Hong Kong
 

75S
 

Singapore
 

75T
 

Taiwan
 

75Z
 

New Zealand
 

76
 

Latin American Localization
 

76A
 

Argentina
 

76B
 

Brazil Localization
 

76C
 

Colombia
 

76E
 

Ecuador
 

76H
 

Chile
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76M
 

Mexico
 

76P
 

Peru
 

76V
 

Venezuela
 

77
 

Payroll (Canadian)
 

77Y
 

Canada Payroll Year End
 

79
 

Translation Tools
 

80
 

Business Intelligence
 

80D
 

Plant Manager Dashboard
 

81
 

DREAM Writer
 

81A
 

DREAMWriter Conversion Tool
 

82
 

World Writer
 

82A
 

World Writer Conversion Tool
 

83
 

Management Reporting - FASTR
 

83A
 

FASTR Conversion Tool
 

84
 

Distributive Data Processing
 

85
 

Custom Programming
 

86
 

Electronic Doc. Interchange
 

87
 

JDE Internal
 

88
 

Cautious Purge System
 

89
 

Conversion Programs
 

90CA
 

CRM Foundation
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90CB
 

CRM Sales Force Automation
 

90CC
 

CRM Marketing Automation
 

90CD
 

CRM Service Management
 

90CE
 

CRM Solution Advisor
 

90CF
 

CRM Call Scripting
 

90CG
 

CRM Case Management
 

90CM
 

Mobile Sales
 

91
 

Documentation
 

92
 

Computer Assisted Design
 

93
 

Computer Assisted Programming
 

94
 

Security Officer
 

95
 

Sleeper-now in system 96
 

96
 

Computer Operations
 

97
 

Software Installation
 

98
 

Technical Tools
 

98E
 

Electronic Burst and Bind
 

98FT
 

Form Type
 

98SA
 

Sample Application
 

99
 

Technical Tools - Internal
 

99D
 

Technical Tools - DASD Sizer
 

99M
 

Technical Tools-Masters/Update
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B
 

LANGUAGE TRANSLATIONS
 

B1A
 

Chinese - Simple
 

B1B
 

Chinese - Complex
 

B1E
 

English
 

B1F
 

French
 

B1G
 

German
 

B1I
 

Italian
 

B1J
 

Japanese
 

B1P
 

Portuguese
 

B1S
 

Spanish
 

B2A
 

Dutch
 

B2D
 

Danish
 

B2F
 

Finnish
 

B2N
 

Norwegian
 

B2S
 

Swedish
 

B3C
 

Czech
 

B3H
 

Hebrew
 

B3R
 

Russian
 

BC1
 

Chinese - Simple
 

BC2
 

Chinese - Complex
 

BCR
 

Czech
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BDN
 

Danish
 

BDU
 

Dutch
 

BFI
 

Finnish
 

BFR
 

French
 

BGR
 

German
 

BHE
 

Hebrew
 

BIT
 

Italian
 

BJP
 

Japanese
 

BNO
 

Norwegian
 

BPO
 

Portuguese
 

BRU
 

Russian
 

BSP
 

Spanish
 

BSW
 

Swedish
 

D3N
 

dcLINK (data collection)
 

H01
 

Address Book (inc. ALL Mail)
 

H03
 

Accounts Receivable
 

H03B
 

New Accounts Receivable
 

H04
 

Accounts Payable
 

H05
 

Standalone Time Accounting
 

H07
 

Payroll
 

H08
 

Human Resources
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H09
 

General Accounting
 

H12
 

Fixed Assets
 

H13
 

Equipment/Plant Management
 

H15
 

Commercial Property Management
 

H30
 

Product Data Management
 

H301
 

Process Data Management
 

H31
 

Shop Floor Control
 

H311
 

Process Control
 

H32
 

Configuration Management
 

H33
 

Capacity Requirements Planning
 

H34
 

DRP/MRP/MPS
 

H35
 

Enterprise Facility Planning
 

H36
 

Advanced Forecasting
 

H40
 

Inventory/OP Base
 

H41
 

Inventory Management
 

H415
 

Bulk Inventory Management
 

H42
 

Sales Order Processing
 

H43
 

Purchase Order Processing
 

H44
 

Contract Management
 

H44H
 

Homebuilder Management
 

H45
 

Sales Analysis
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H46
 

Warehouse Management
 

H50
 

Job Cost Base
 

H72
 

Client/Server Base
 

H73
 

CS - A/P Voucher Entry
 

H74
 

CS - Pay Time Entry
 

H75
 

CS - Sales Order Entry
 

H76
 

CS - Training & Development
 

H78
 

CS - Travel Expense Management
 

H79
 

Translation Tools
 

H90
 

JD Edwards EnterpriseOne TOOLS
 

H91
 

Design Tools
 

H92
 

Interactive Engine/OL
 

H93
 

Data Base and Communications
 

H94
 

Batch Engine
 

H95
 

Tech Resources/Applications
 

H96
 

Deployment
 

H97
 

Benchmarking/Performance
 

H98
 

internet
 

H99
 

Product Version Control
 

H99P
 

Technical Tools-OWPVC Internal
 

JE42
 

Sales Order/Pricing
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JE44
 

Distribution Contracts
 

JE48
 

Automated Gantry Inter.
 

KZ1
 

PC Budget Upload (A3 to A5)
 

KZ2
 

PC Data Entry for AP
 

KZ3
 

PC Data Entry for Payroll
 

SY
 

SYSTEM
 

UX
 

EnterpriseOne UX
 

Z101
 

MTI Electrical Distribution
 

Z102
 

CRES
 

Z91
 

System/ Product Codes
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21  Glossary

fast path  
A command prompt that enables the user to move quickly among menus and applications by using specific commands.

in-your-face error  
In JD Edwards EnterpriseOne, a form-level property which, when enabled, causes the text of application errors to appear
on the form.

MailMerge Workbench  
An application that merges Microsoft Word 6.0 (or higher) word-processing documents with JD Edwards EnterpriseOne
records to automatically print business documents. You can use MailMerge Workbench to print documents, such as
form letters about verification of employment.

media storage object  
Files that use one of the following naming conventions that are not organized into table format: Gxxx, xxxGT, or GTxxx.

message center  
A central location for sending and receiving all JD Edwards EnterpriseOne messages (system and user generated),
regardless of the originating application or user.

processing option  
A data structure that enables users to supply parameters that regulate the running of a batch program or report. For
example, you can use processing options to specify default values for certain fields, to determine how information
appears or is printed, to specify date ranges, to supply runtime values that regulate program execution, and so on.
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QBE  
An abbreviation for query by example. In JD Edwards EnterpriseOne, the QBE line is the top line on a detail area that is
used for filtering data.

selection  
Found on JD Edwards EnterpriseOne menus, a selection represents functions that you can access from a menu. To
make a selection, type the associated number in the Selection field and press Enter.

visual assist  
Forms that can be invoked from a control via a trigger to assist the user in determining what data belongs in the control.
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